
Starter Guide

Limited Edition 2005

http://www.mandrakesoft.com



Starter Guide: Limited Edition 2005
Published April 2005
Copyright © 2005 Mandrakesoft SA
by NeoDoc (http://www.neodoc.biz)Camille Bégnis, Christian Roy, Fabian Mandelbaum, Roberto Rosselli
del Turco, Marco De Vitis, Alice Lafox, John Rye, Wolfgang Bornath, Funda Wang, Patricia Pichardo Bégnis,
Debora Rejnharc Mandelbaum, Mickael Scherer, Jean-Michel Dault, Lunas Moon, Céline Harrand, Fred
Lepied, Pascal Rigaux, Thierry Vignaud, Giuseppe Ghibò, Stew Benedict, Francine Suzon, Indrek Madedog
Triipus, Nicolas Berdugo, Thorsten Kamp, Fabrice Facorat, Xiao Ming, Snature , Guylhem Aznar, Pavel
Maryanov, and Annie Tétrault

Legal Notice

This manual is protected under Mandrakesoft intellectual property rights. By reproducing, duplicating or distributing this manual in
whole or in part, you explicitly agree to conform to the terms and conditions of this license agreement.
This manual may be freely reproduced, duplicated and distributed either as such or as part of a bundled package in electronic and/or
printed format, provided however that the following conditions are fulfilled:

• That this copyright notice appears clearly and distinctively on all reproduced, duplicated and distributed
copies.

• That the “front cover texts” below, About Mandrakelinux, page 1, and the section stating the names of
authors and contributors are attached to the reproduced, duplicated or distributed version and remain
unchanged.

• That this manual, specifically for the printed format, is reproduced and/or distributed for noncommercial
use only.

The express authorization of Mandrakesoft SA must be obtained prior to any other use of any manual or part thereof.
“Mandrake”, “Mandrakesoft”, “DrakX” and “Linux-Mandrake” are registered trademarks in the US and/or other countries. The related
“Star logo” is also registered. All rights reserved. All other copyrights embodied in this document remain the property of their respective
owners.

Front-cover texts

Mandrakesoft April 2005
http://www.mandrakesoft.com/
Copyright © 1999-2005 by Mandrakesoft S.A. and Mandrakesoft Inc.

Tools Used in the Making of this Manual

This manual was written in DocBook XML. The set of files involved were managed using the Borges Collaborative Content Creation
System (C3S) (http://sourceforge.net/projects/borges-dms). The XML source files were processed by xsltproc, and jadetex using
a customized version of Norman Walsh’s stylesheets. Screen shots were taken using xwd or GIMP and converted with convert (from
the ImageMagick package). All these programs are free software and most of them are available in your Mandrakelinux distribution.

http://www.neodoc.biz
http://sourceforge.net/projects/borges-dms


Table of Contents

Preface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1. About Mandrakelinux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1.1. Contacting the Mandrakelinux Community . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.2. Join the Club . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
1.3. Subscribe to Mandrakeonline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1
1.4. Purchasing Mandrakesoft Products . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
1.5. Contribute to Mandrakelinux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2. About this User Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
3. Note from the Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
4. Conventions Used in this Book . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

4.1. Typing Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .3
4.2. General Conventions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

I. Installing Mandrakelinux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
1. Installation Warning. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .7
2. Before Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.1. Configuring your BIOS. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.2. Creating a Floppy Boot Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
2.3. Supported Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

3. Installation with DrakX . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3.1. The Mandrakelinux Installer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13
3.2. Choosing your Language . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
3.3. License Terms of the Distribution . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.4. Installation Class . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
3.5. Configuring the Keyboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
3.6. Security Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
3.7. Partitioning your Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
3.8. Choose Packages to Install . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
3.9. Multiple CD-ROM Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
3.10. Root Password. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22
3.11. Adding a User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
3.12. Installing a Bootloader . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
3.13. Checking Miscellaneous Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
3.14. Installing Updates from the Internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .29
3.15. It’s Done! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
3.16. How to Uninstall Linux . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

II. Discover . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
4. Migrating to Linux from Windows® and Mac OS® X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

4.1. Where’s my...? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
4.2. A Brave New World! . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

5. Linux for Beginners . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
5.1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
5.2. The Bootloader Menu . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
5.3. Getting Ready for your Session. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .35
5.4. Beginning your Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
5.5. Using your Graphical Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
5.6. Logging Out of your Session . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

6. Accessing Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
6.1. Mandrakelinux-Specific Documentation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
6.2. GNU/Linux Useful Resources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

7. Using KDE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
7.1. Discovering the K Desktop Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
7.2. Personalizing your Desktop . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47
7.3. KDE Sessions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

III. Using the Internet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
8. Writing E-mails with KMail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

8.1. Configuring KMail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
8.2. KMail’s Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

iii



8.3. Composing a Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
8.4. Cryptography . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58

9. Surfing the Web with Firefox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
9.1. A First Glance at Firefox . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
9.2. Surfing the Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
9.3. Using the Sidebar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
9.4. Managing Bookmarks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
9.5. Tabbed Browsing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64
9.6. Extensions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65
9.7. Themes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66
9.8. Installing Plugins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

IV. Use . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
10. Office Work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

10.1. Word Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
10.2. Spreadsheet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74
10.3. Konqueror File Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77
10.4. Printing and Faxing from Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

11. Audio, Movie and Video Applications. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .87
11.1. Audio Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87
11.2. Movie Applications . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91
11.3. CD Burning. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .93

V. Advanced Uses . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
12. Introduction to the Mandrakelinux Control Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

12.1. MCC’s Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103
12.2. Managing Configuration Profiles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105
12.3. The Drakbug Reporting Tool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106

13. Package Management through Rpmdrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
13.1. Install Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 107
13.2. Remove Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
13.3. Mandrakelinux Update . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110
13.4. The Software Media Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 111
13.5. Package Management through the Command Line . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

14. Hardware Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
14.1. Configuring your Hardware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117
14.2. Controlling the Graphical Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119
14.3. Changing your Keyboard Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 121
14.4. Changing your Mouse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 122
14.5. Configuring Printers with PrinterDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 123
14.6. Installing and Using Scanners . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 134
14.7. Setting up your UPS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

15. Setting up your Network and Accessing the Web . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
15.1. Network and Internet Connection Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
15.2. Internet Connection Sharing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 149

16. Personalizing your System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
16.1. Customizing your Menus with MenuDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 151
16.2. Configuring Start-Up Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154
16.3. Managing Available Fonts on your System with DrakFont. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .155
16.4. Setting your Machine’s Date and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 156
16.5. Monitoring System Activity and Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 157
16.6. Managing Users and Groups. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .159
16.7. Backing Up and Restoring your Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 161

17. Parameterizing your Mount Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
17.1. Managing your Hard Drive Partitions with DiskDrake . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
17.2. Managing Removable Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172
17.3. Importing Remote SMB Directories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 173
17.4. Importing Remote NFS Directories . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
17.5. Allowing Users to Share Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 175
17.6. Setting up WebDAV Mount Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

18. Securing your Linux Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 179
18.1. Securing your Machine through DrakSec . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .179

iv



18.2. Controlling File Permissions with DrakPerm . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 181
18.3. Securing your Internet Access via DrakFirewall . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 182

19. Boot Device Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
19.1. Configuring the Login Mode . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 185
19.2. Changing your Boot-Up Configuration. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .185
19.3. Customizing your Boot Theme. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 187

20. Mandrakeonline Services . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
20.1. Initial Configuration . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189
20.2. The Web Management Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
20.3. Mandrakeonline Applet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 193

21. Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
21.1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
21.2. A Boot Disk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 195
21.3. Backup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 196
21.4. Restore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
21.5. Problems Arising at Boot Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 198
21.6. Bootloader Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 200
21.7. File System Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 201
21.8. Recovering from a System Freeze . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 202
21.9. Killing Misbehaving Apps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
21.10. Miscellaneous . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 203
21.11. Mandrakelinux’s Specific Troubleshooting Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 204
21.12. General Guidelines for Solving a Problem under Mandrakelinux . . . . . . . . . . . . . . . . . . . . . . . . 204
21.13. Final Thoughts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 205

A. The GNU General Public License . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
A.1. Preamble . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207
A.2. Terms and conditions for copying, distribution and modification . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 207

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211

v



vi



List of Tables

8-1. KMail’s Toolbar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
8-2. Message-Composition Toolbar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 57
9-1. Firefox’s Web Browser Toolbar Buttons. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62
10-1. Suggested Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72
10-2. Konqueror Sidebar Icons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78
10-3. Jobs Queue Control Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86
11-1. K3b’s Toolbar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
12-1. Overview of Graphical Tools . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 103

vii



viii



Preface

1. About Mandrakelinux

Mandrakelinux is a GNU/Linux distribution supported by Mandrakesoft S.A. which was born on the Internet in
1998. Its main goal was and still is to provide an easy-to-use and friendly GNU/Linux system. Mandrakesoft’s
two pillars are open source and collaborative work.

1.1. Contacting the Mandrakelinux Community

The following are various Internet links pointing you to various Mandrakelinux-related sources. If you wish
to know more about the Mandrakesoft company, connect to our web site (http://www.mandrakesoft.com/).
You can also check out the Mandrakelinux distribution web site (http://www.mandrakelinux.com/) and all its
derivatives.

Mandrakeexpert (http://www.mandrakeexpert.com/) is Mandrakesoft’s support platform. It offers a new ex-
perience based on trust and the pleasure of rewarding others for their contributions.

We also invite you to subscribe to the various mailing lists (http://www.mandrakelinux.com/en/flists.
php3) where the Mandrakelinux community demonstrates its vivacity and keenness.

Please also remember to connect to our security page (http://www.mandrakesoft.com/security). It gathers
all security-related material about Mandrakelinux distributions. You will find security and bug advisories, as
well as kernel update procedures, the different security-oriented mailing lists which you can join, and Man-
drakeonline (see “Mandrakeonline Services”, page 189). A must for any server administrator or user concerned
about security.

1.2. Join the Club

Mandrakesoft offers a wide range of advantages through its Mandrakeclub (http://www.mandrakeclub.com):

• download commercial software normally only available in retail packs, such as special hardware drivers,
commercial applications, freeware, and demo versions;

• vote for and propose new software through a volunteer-run RPM voting system;

• access more than 50,000 RPM packages for all Mandrakelinux distributions;

• obtain discounts for products and services on Mandrakestore (http://store.mandrakesoft.com);

• access a better mirror list, exclusive to Club members;

• read multilingual forums and articles.

• access Mandrakesoft’s Knowledge Base (https://kb.mandrakeclub.com), a wiki-based site which holds do-
cumentation on many subjects such as administration, connectivity, troubleshooting, and more;

• chat with the Mandrakelinux developers on the Club Chat (https://www.mandrakeclub.com/user.php?op=
clubchat);

• enhance your GNU/Linux knowledge through Mandrakesoft’s e-training lessons (http://campus.mandrakesoft.
com).

By financing Mandrakesoft through the Mandrakeclub you will directly enhance the Mandrakelinux distribution
and help us provide the best possible GNU/Linux desktop to our users.

1.3. Subscribe to Mandrakeonline

Mandrakesoft offers a very convenient way to keep your system automatically up-to-date, keeping away bugs
and security holes. Consult “Mandrakeonline Services”, page 189 Visit the Mandrakeonline Web site (https:
//www.mandrakeonline.net/) to learn more about this service.
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1.4. Purchasing Mandrakesoft Products

Mandrakelinux users may purchase products on-line through the Mandrakestore (http://store.mandrakesoft.
com/). You will not only find Mandrakelinux software, operating systems and “live” boot CDs (such as Move),
but also special subscription offers, support, third-party software and licenses, documentation, GNU/Linux-
related books, as well as other Mandrakesoft goodies.

1.5. Contribute to Mandrakelinux

The skills of the many talented folks who use Mandrakelinux can be very useful in the making of the Mandrake-
linux system:

• Packaging. A GNU/Linux system is mainly made of programs picked up on the Internet. They have to be
packaged in order to work together.

• Programming. There are many, many projects directly supported by Mandrakesoft: find the one which most
appeals to you and offer your help to the main developer(s).

• Internationalization. You can help us in the translation of web pages, programs and their respective docu-
mentation.

Consult the development projects (http://www.mandrakesoft.com/labs/) page to learn more about how you
can contribute to the evolution of Mandrakelinux.

2. About this User Guide

Welcome and thank you for choosing Mandrakelinux! This manual was written in order to give you a better
understanding of the Mandrakelinux system. In it we will focus on graphical applications which will allow you
to perform your daily tasks, such as writing documents and e-mails, surfing the web and listening to music.
We will also show you how to configure your desktop to your liking, install software, and finally, we will give
you some tips and tricks to help you fix common — and not so common — problems.

This book is divided into 5 parts. We start off with Installing Mandrakelinux, where you will learn what you
need to know before you actually install Mandrakelinux onto your system (see “Installation Warning”, page 7,
and “Before Installation”, page 9). Then we will show you how to correctly install and configure your Mandra-
kelinux distribution (“Installation with DrakX”, page 13) by describing the preparation, installation and post-
installation procedures.

The next part (Discover) is an introduction to Linux basics. We discuss the Linux paradigm by comparing it
to other OSes in “Migrating to Linux from Windows® and Mac OS® X”, page 31. In order to help new users,
we wrote “Linux for Beginners”, page 35. In it we describe the first steps a new user must master and we
explain concepts such as “logging in and out”, security tips, and more. The following chapter (“Accessing
Documentation”, page 41) will guide you through a fairly exhaustive list of documentation sources which
you can consult in order to attain a better understanding of Linux. A Mandrakelinux-specific section points to
numerous in-house resources which you can find on the Net. We close this part by speaking about the popular
KDE graphical environment (see “Using KDE”, page 45).

We then tackle Internet applications (Using the Internet). We explain how to send e-mails using the KMail
component of the Kontact suite (“Writing E-mails with KMail”, page 53) and how to browse the web using
Firefox (“Surfing the Web with Firefox”, page 61).

Everyday applications is the topic of the next part (Use). We discuss the OpenOffice.org suite (see Word Processor,
page 71, and Spreadsheet, page 73), file managers (see Konqueror File Manager, page 77) and printers (see Printing
and Faxing from Applications, page 80). We then explore the world of multimedia by reviewing audio and movie
applications (see Audio Applications, page 87, and Movie Applications, page 91), as well as CD burning (see CD
Burning, page 93).

Finally we go through more technical aspects of the Mandrakelinux system (Advanced Uses):
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• Mandrakelinux Control Center. This is your main graphical configuration tool (see MCC’s Components, page
103). With it you can configure your software sources (“Package Management through Rpmdrake”, page 107),
your hardware (“Hardware Setup”, page 117), and your network (“Setting up your Network and Accessing the
Web”, page 145). You can also set up your general system settings (“Personalizing your System”, page 151)
such as customizing your menus (see Customizing your Menus with MenuDrake, page 151) and your start-
up services (see Configuring Start-Up Services, page 154). More complex issues like configuring your mount
points (“Parameterizing your Mount Points”, page 169) and general system security (“Securing your Linux
Box”, page 179) are also addressed. Finally, you can tune up your boot options (“Boot Device Configuration”,
page 185).

• Package Management. Mandrakelinux offers different ways to update your system with normal software up-
dates and security fixes. This can be done through the Rpmdrake Software Manager (“Package Management
through Rpmdrake”, page 107) which allows you to install and remove software packages, set up Mandra-
keupdate sources as well as other media such as Cooker. The urpmi program (combined with its counterpart
urpme) allows the same functionality but through the command line.

• Troubleshooting. For most users, switching to GNU/Linux is a challenging experience. And this manual
wouldn’t have been complete without a chapter dedicated to helping you solve what might go wrong du-
ring your GNU/Linux experience (“Troubleshooting”, page 195). It will give you tips and tricks if “all hell
breaks loose”: needless to say, this chapter cannot be exhaustive.

3. Note from the Editor

In the open-source philosophy, contributors are always welcomed! Updating the Mandrakelinux documenta-
tion pool is quite a task. You could provide help in many different ways. In fact, the documentation team is
constantly looking for talented volunteers to help us out accomplish the following tasks:

• writing or updating;

• translating;

• copy editing;

• XML/XSLT programming.

If you have a lot of time, you can write or update a whole chapter; if you speak a foreign language, you can
help us translate our manuals; if you have ideas on how to improve the content, let us know; if you have
programming skills and would like to help us enhance the Borges Collaborative Content Creation System
(C3S) (http://sourceforge.net/projects/borges-dms), join in. And don’t hesitate to contact us if you find
any mistakes so we can correct them!

For any information about the Mandrakelinux documentation project, please contact the documentation ad-
ministrator (mailto:documentation@mandrakesoft.com) or visit the Mandrakelinux Documentation Project
Pages (http://www.mandrakelinux.com/en/doc/project/).

Please note that since June 2004 the Mandrakelinux documentation
and the development of Borges is handled by NeoDoc (http://
www.neodoc.biz).

4. Conventions Used in this Book

4.1. Typing Conventions

In order to clearly differentiate special words from the text flow, we use different renderings. The following
table shows examples of each special word or group of words with its actual rendering, as well as its signifi-
cation.

Formatted Example Meaning

inode Used to emphasize a technical term.
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Formatted Example Meaning

ls -lta Used for commands and their arguments. Also used for options and file names (see
Commands Synopsis, page 4).

ls(1) Reference to a man page. To read the page, simply type man 1 ls, in a command
line.

$ ls *.pid Formatting used for text snapshots of what you may see on your screen including
computer interactions, program listings, etc.

localhost Literal data which does not generally fit in any of the previously defined categories.
For example, a key word taken from a configuration file.

OpenOffice.org Defines application names. Depending on context, the application and command
name may be the same but formatted differently. For example, most commands are
written in lowercase, while applications names usually begin with an uppercase
character

Files Indicates menu entries or graphical interface labels. The underlined letter, if present,
informs you of a keyboard shortcut, accessible by pressing the Alt key plus the letter
in question.

SCSI-Bus Denotes a computer part or a computer itself.

Le petit chaperon
rouge

Identifies foreign language words.

Warning! Reserved for special warnings in order to emphasize the importance of words. Read
out loud.

Highlights a note. Generally, it gives additional information about
a specific context.

Represents a tip. It can be general advice on how to perform a
particular action, or hints at nice features which could make your
life easier, such as shortcuts.

Be very careful when you see this icon. It always means that very
important information about a specific subject will be dealt with.

4.2. General Conventions

4.2.1. Commands Synopsis

The example below shows the symbols you will see when the writer describes the arguments of a command:

command <non literal argument> [--option={arg1,arg2,arg3}] [optional arg ...]

These conventions are standard and you may find them elsewhere such as in the man pages.

The “<” (lesser than) and “>” (greater than) symbols denote a mandatory argument not to be copied as is,
which should be replaced according to your needs. For example, <filename> refers to the actual name of a
file. If this name is foo.txt you should type foo.txt, not <foo.txt> or <filename>.

The square brackets (“[ ]”) denote optional arguments, which you may or may not include in the command.

The ellipsis (“...”) means an arbitrary number of arguments can be included.

The curly brackets (“{ }”) contain the arguments authorized at this specific place. One of them is to be placed
here.
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4.2.2. Special Notations

From time to time, you will be asked to press, for example, the keys Ctrl-R, which means you need to press
and hold the Ctrl key and tap the R character right after as well. The same applies for the Alt and Shift keys.

Regarding menus, going to menu item File→Reload user config (Ctrl-R) means: click on the File text displayed
on the menu (generally located in the upper-left of the window). Then in the pull-down menu, click on the Re-
load user config item. Furthermore you are informed that you can use the Ctrl-R key combination (as described
above) to get the same result.

4.2.3. System-Generic Users

Whenever possible, we use two generic users in our examples:

Queen Pingusa queen This is our default user, used through most examples
in this book.

Peter Pingus peter This user can be created afterward by the system
administrator and is sometimes used to vary the text.
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Chapter 1. Installation Warning

This guide only covers the most common steps of the installation process. If you plan on using Windows® as
well as GNU/Linux by dual-booting (meaning being able to access either OS on the same computer), please
note that it is easier to install Windows® before GNU/Linux. If Windows® is already set up on your system,
and you have never installed GNU/Linux before, DrakX — Mandrakelinux’s installation program — will have to
resize your Windows® partition. This operation can be harmful to your data. Therefore, you must perform the
following steps before proceeding:

• Run scandisk on your Windows® computer. The resizing program can detect some obvious errors, but
scandisk is better suited for this task;

Before using scandisk (or defrag) make sure your screen saver
and any other program that might write to the hard disk is turned
off. To obtain even better results, you should run scandisk or
defrag from Windows®’s “Safe Mode”.

• For maximum data security, also run defrag on your partition. This further reduces the risk of data loss. This
isn’t mandatory, but it’s highly recommended. Doing so will make the resizing process much faster and
easier.

• The ultimate insurance against problems is to always back up your data! Of course, you should back up
your data on another computer, upload your back-ups on the web, on a friend’s computer, etc. Do not back
it up onto the computer on which you want to install GNU/Linux.

If neither scandisk nor defrag are installed within Windows®, please refer to the Windows® documentation for
instructions on installing them.

NTFS Partitions. Windows® 2000, NT and XP users should
remain careful: even though DiskDrake (through the ntfsresi-
ze application) is able to resize NTFS partitions, it’s highly
recommended that you back up your data before starting
the installation. Please see the Linux-NTFS site (http://
linux-ntfs.sourceforge.net/info/ntfs.html#2.6) as well as
the NTFS Resize FAQ (http://mlf.linux.rulez.org/mlf/
ezaz/ntfsresize.html) for more information on the subject.

Windows® users can also use Norton Partition MagicTM (http:
//www.symantec.com/partitionmagic/) to resize their NTFS
partitions under Windows®.
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Chapter 2. Before Installation

This chapter covers issues which should be addressed before you start your new Mandrakelinux installation.
Make sure you read it completely since it will save you a lot of time. Also back up your data (on a different
disk to the one you will install the system into) and plug in and turn on all your external devices (keyboard,
mouse, printer, scanner, etc.).

2.1. Configuring your BIOS

The BIOS (Basic Input/Output System) is used to find the device on which the operating system is located and
starts it up. It’s also used for the initial hardware configuration and low-level hardware access.

The appearance of plug’n’play devices and their widespread use means that all modern BIOSes can initialize
these devices. In order for Linux to recognize plug’n’play devices, your BIOS must be configured to initialize
them.

Changing your BIOS’ settings is usually performed by holding down the Del key (some BIOSes use the F1,
F2, F10 or Esc keys instead) right after the computer is switched on. Unfortunately, there are many types of
BIOSes. Therefore you will have to look for the appropriate option yourself. It’s often called PNP OS installed
(or Plug’n’Play OS installed). Set this option to No and the BIOS will then initialize any plug’n’play devices,
which helps Linux to recognize them.

All recent systems can boot from a CD-ROM. Look for Boot sequence or First boot device in the BIOS’ features
setup, and set the CD-ROM as the first one. If your system can’t boot from a CD-ROM you will need to use a
floppy boot disk.

If you want to use a parallel printer connected locally to your machi-
ne, make sure the parallel port mode is set to ECP+EPP (or at least
to one of ECP or EPP) and not to SPP, unless you have a really
old printer. If the parallel port is not set this way you might still be
able to print, but your printer will not be detected automatically
and you will have to configure it by hand. Also make sure the printer
is properly connected to your machine and powered on beforehand.

2.2. Creating a Floppy Boot Disk

If your system cannot boot from the CD-ROM you will need to create a floppy boot disk. The CD-ROM
contains all of the image files and utility programs needed to do so.

The floppy boot disk images are in the CD-ROM’s install/images/ directory.

The following is a list of different images and their respective installation methods:

cdrom.img

To install from a local IDE or SCSI CD-ROM drive.

network.img and network_drivers.img

To install from an NFS, FTP, HTTP repository on your local LAN or from one across the world, via the
Internet. The network configuration of the machine on which you wish to install may be manual or auto-
matic. Please make sure that you make both floppies.

pcmcia.img

Use this image if the installation medium is reached through a PCMCIA card (network, CD-ROM, etc.).

Some PCMCIA devices use common network drivers. If the PCM-
CIA device does not work, try again with network.img and
network_drivers.img.

9
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hd_grub.img

Use this image if you want to perform the installation from a hard disk. You need to copy the contents
of the CD onto the hard drive (either on a FAT, ext2FS, ext3FS or ReiserFS partition). At the hd_grub
customization site (http://qa.mandrakesoft.com/hd_grub.cgi) there is a little tool which may prove
helpful for customizing your boot floppy.

2.2.1. Creating a Boot Disk With Windows

In order to do so, you need to use the rawwrite program. You will find it in the CD-ROM’s dosutils/ direc-
tory.

You may have noticed that there is a DOS version of the same program called rawrite. In fact, this is the
original version of the program. rawwrite is a graphical front-end to it.

Start the program, as shown in figure 2-1.

Figure 2-1. The Rawwrite Program

Select the boot image to be copied and the target device. In almost every case, the target device is the A: drive
(that is, the first floppy disk drive).

Then if you have not already done so, insert an empty disk into your chosen floppy drive and click on the Write
button. When completed click on the Exit button: you now have a floppy boot disk to install your Mandrakelinux
distribution.

2.2.2. Creating a Floppy Boot Disk From GNU/Linux

If you already have GNU/Linux installed (another version, or on another machine, etc.), then carry out the
following steps:

1. Mount the CD-ROM, if needed. Let us suppose that the mount point is /mnt/cdrom.

2. Log in as root (to do so, open a terminal window, run the su command and enter root’s password).

3. Insert an empty diskette into the floppy drive and type:
$ dd if=/mnt/cdrom/install/images/cdrom.img of=/dev/fd0 bs=512

When this operation is completed, your floppy boot disk will be ready for use.
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Replace /dev/fd0 with /dev/fd1 if you are using the second floppy
drive and, of course, the name of the image with the one you want.

2.3. Supported Hardware

Mandrakelinux can handle a large number of hardware devices, and the list is far too long to be quoted in its
entirety. Nevertheless some of the steps we describe will help you to find out if your hardware is compatible.
It will also guide you in configuring some problematic devices.

You may also consult an up-to-date list of supported hardware on the Mandrakelinux Hardware Database
(http://www.mandrakelinux.com/en/hardware.php3) web site.

Legal Disclaimer: The Mandrakelinux Hardware Database contains
information about hardware devices which have been tested and/or
have been reported to function properly with Mandrakelinux. Due
to the wide variety of system configurations, Mandrakesoft cannot
guarantee that a specific device will work properly on your system.

USB devices: support for USB 1.x and USB 2.0 is now extensive. Most peripherals are fully supported. You
can obtain the list of supported hardware on the Linux-USB device overview (http://www.qbik.ch/usb/
devices/) site.

2.3.1. Notes About Winmodems

winmodems are also called controller-less modems or software modems. Support for these peripherals is im-
proving. Drivers do exist, but most of them are in binary form and available only for newer kernel versions.

If you have a PCI modem, look at the output of cat /proc/pci run as the root user. This will tell you the
I/O port and the IRQ of the device. Then use the setserial command (for our example, the I/O address is
0xb400, the IRQ is 10 and the modem will be the 4th serial device) as follows:

setserial /dev/ttyS3 port 0xb400 irq 10 UART 16550A

Then try to query your modem using minicom or kppp. If it does not work, you may have a software modem.
If it does work, create the /etc/rc.d/rc.setserial file and place the appropriate setserial command line
in it.

If you happen to have a software modem in your machine, and you have a Mandrakeclub account, you
might find an RPM package that supports your modem. You can also take a look at the linmodems (http:
//linmodems.org/) and the Winmodems are not modems (http://start.at/modem) web sites.
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Chapter 3. Installation with DrakX

3.1. The Mandrakelinux Installer

With the DrakX installation program, it doesn’t matter whether you’re a newbie or a GNU/Linux guru. The job
of DrakX is to provide you with a smooth installation and an easy transition to Mandrakelinux’s latest version.

DrakX will work best if all of your hardware is connected to your
computer and powered on during the installation. Printers, modems,
scanners and joysticks are just a few examples of peripherals which
DrakX can automatically detect and configure as Mandrakelinux is
being installed.

Figure 3-1. Very First Installation Welcome Screen

The first screen you see offers to run the installation with special options if the standard mode was not suited
for your hardware. So to begin with, let the installation start automatically with no options. If something goes
wrong, see Installation Options, page 13.

3.1.1. The Installation Process

When the installer starts, you will see a nice graphical interface (see figure 3-3). On the left will be the various
installation steps. The installation will occur in two phases: installation, then configuration. The list on the left
displays all the steps. The current step is marked by a highlighted bullet.

Each step may present various screens. Surfing between those screens is made possible through the Next and
Previous buttons. Additionally an Advanced button may be available to show more advanced configuration
options. Note that most of the latter should only be used by expert users. But there’s no harm in looking at
them!

The Help button will display explanations concerning the current
installation step.
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3.1.2. Installation Options

If something goes wrong during the first installation attempt, pressing F1 at the welcome screen (see figure
3-1) will open a help window (see figure 3-2). Here are some useful options to choose from:

Figure 3-2. Available Installation Options

• vgalo: if you tried a default installation and didn’t see the graphical interface (see figure 3-3), you can
try to run the installation in low resolution mode. This happens with certain types of video cards. With
Mandrakelinux you are given a number of options to work around problems related to older hardware. To
try the installation in low resolution mode, type vgalo at the prompt.

• text: if your video card is very old and the graphical installation doesn’t work at all, you can always choose
to install in text mode. Since all video cards can display text, this is the “last resort” kind of installation.
However don’t worry: it’s unlikely that you will need this option.

• noauto: in some rare cases, your PC may appear to freeze or lock up during the hardware detection pha-
se. If that happens, adding the word noauto as a parameter will tell the installation program to bypass
hardware detection. With that option DrakX won’t scan for hardware. Therefore you will need to manually
specify hardware parameters later in the installation process. The noauto parameter can be added to the
previous modes, so depending on your hardware you may have to specify vgalo noauto to perform a
low-resolution graphical installation without DrakX performing a hardware scan.

• kernel options: most machines don’t require specific kernel options. Due to bugs in the design or in the
BIOS, there have been a few cases of motherboards incorrectly reporting the amount of memory installed.
If you need to manually specify the amount of RAM installed in your PC, use the mem=xxxM parameter.
For example, to start the installation in normal mode with a computer containing 256 MB of memory, your
command line would look like linux mem=256M

3.2. Choosing your Language

The first step is to choose your preferred language.
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Figure 3-3. Choosing the Default Language

First open the tree relative to the continent you are located in, and then choose the language you speak. Your
language choice will affect the installer, the documentation, and the system in general.

Use the list at the bottom of the tree to select other languages to be installed on your workstation, thereby ins-
talling the language-specific files for system documentation and applications. For example, if Spanish friends
are to use your machine, select English as the default language in the tree view and Español in the list view.

About UTF-8 (unicode) support: Unicode is a character encoding
intended to cover all existing languages. However full support for
it in GNU/Linux is still under development. For that reason, Man-
drakelinux’s use of UTF-8 will depend on the user’s choices:

1. If you choose a language with a strong legacy encoding
(latin1 languages, Russian, Japanese, Chinese, Korean,
Thäı, Greek, Turkish, and most iso-8859-2 languages),
the legacy encoding will be used by default.

2. Other languages will use Unicode by default.

3. If two or more languages are to be installed, and those
languages are not using the same encoding, then Unicode
will be used for the whole system.

4. Finally, Unicode can also be forced for use throughout the
system at a user’s request by selecting the Use Unicode
by default option independently of which languages have
been chosen.

Note that you’re not limited to choosing a single additional language. You may choose several, or even install
them all by selecting the All languages box. Selecting support for a language means translations, fonts, spell
checkers, etc. will also be installed for that language. Make sure you select all languages which are likely to be
useful on the machine now, it may be difficult to configure support for languages not chosen at install time at
a later time.

To switch between the various languages installed on your system,
you can launch the localedrake command as root to change
the language used by the entire system. Running the command
as a regular user will only change the language settings for that
particular user.
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3.3. License Terms of the Distribution

Before continuing, you should carefully read the terms of the license. It covers the entire Mandrakelinux distri-
bution. If you agree with all the terms it contains, select Accept and click on Next. If not, clicking on Quit will
reboot your computer.

If you are curious about any technical changes which have occurred
in the distribution since the last release, you can click on the Release
Notes button to display them.

3.4. Installation Class

This step is shown only if an existing GNU/Linux partition is found on your machine.

DrakX now needs to know if you want to install from scratch or upgrade your existing Mandrakelinux system:
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• Install. For the most part, this completely wipes out the old system. However, depending on your parti-
tioning scheme, you can prevent some of your existing data (particularly /home directories) from being
overwritten. If you wish to change how your hard drives are partitioned, or to change the file system, you
should use this option.

• Upgrade.This installation class allows you to update the packages currently installed on your Mandrakelinux
system. Your current partitioning scheme and user data won’t be altered. Most of the other configuration
steps remain available and are similar to a standard installation.

Using the“Upgrade”option should work fine on Mandrakelinux sys-
tems running version 9.2 or later. Performing an upgrade on prior
versions is not recommended.

3.5. Configuring the Keyboard

This step only shows if your language settings do not match one
single keyboard. Otherwise, your keyboard map is automatically
selected.

Depending on the language you choose (see Choosing your Language, page 14), DrakX automatically selects
a particular type of keyboard configuration. Verify that the selection suits you or choose another keyboard
layout.

Also, you may not have a keyboard which corresponds exactly to your language: for example, if you are an
English-speaking Swiss native, you may have a Swiss keyboard. Or if you speak English and are located in
Québec, you may find yourself in the same situation where your native language and country-set keyboard
don’t match. In either case, this installation step will allow you to select an appropriate keyboard.

Click on the More button and a list list of supported keyboards will be displayed.

If you choose a keyboard layout based on a non-Latin alphabet, the next dialog will allow you to choose the
key binding which will switch the keyboard between the Latin and non-Latin layouts.
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3.6. Security Level

At this point, DrakX allows you to choose your machine’s security level. As a rule of thumb, the security level
should be set higher if the machine is to contain crucial data, or if it’s to be directly exposed to the Internet.
The trade-off is that a higher security level is generally obtained at the expense of ease of use.

If you don’t know what to choose, keep the default option. You’ll be able to change it later with the draksec
tool (see Securing your Machine through DrakSec, page 179).

Fill the Security Administrator field with the e-mail address of the person responsible for security. Security-
related messages will be sent to that address.

3.7. Partitioning your Disk

You now need to decide where you want to install Mandrakelinux on your hard drive. If your hard drive is
empty or if an existing operating system is using all the available space you will have to re-partition the drive.
Basically, partitioning a hard drive means to logically divide it in order to create the space required for your
new Mandrakelinux system.
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Because the process of partitioning a hard drive is usually irreversible and can lead to data loss, partitioning
can be intimidating and stressful for the inexperienced user. Fortunately, DrakX includes a wizard which sim-
plifies this process. Before continuing with this step, read through the rest of this section and above all, take
your time.

Depending on the configuration of your hard drive, several options are available:

• Use free space. This option will perform an automatic partitioning of your blank drive(s). If you use this
option there will be no further prompts.

• Use existing partitions. The wizard has detected one or more existing Linux partitions on your hard drive.
If you want to use them, choose this option. You will then be asked to choose the mount points associated
with each of the partitions. The legacy mount points are selected by default, and for the most part it’s a good
idea to keep them. You will also be asked to choose the partitions to be formatted or preserved.

• Use the free space on the Windows partition. If Windows® is installed on your hard drive, you might have to
create free space for GNU/Linux. To do so, you can delete your Windows® partition and data (see the “Erase
entire disk” solution below) or resize your FAT or NTFS partition. Resizing can be performed without the
loss of any data, provided you’ve previously defragmented the Windows® partition. Backing up your
data is strongly recommended. Using this option is recommended if you want to use both Mandrakelinux
and Windows® on the same computer.

Before choosing this option, please understand that after this procedure, the size of your Windows® partition
will be smaller than when you started, which means you will have less free space to store your data or to
install new software.

• Erase entire disk. If you want to delete all data and all partitions present on your hard drive and replace them
with Mandrakelinux, choose this option. Be warned that you won’t be able to undo this operation after you
confirm.

If you choose this option, all data on your disk will be deleted.

• Remove Windows(TM). This option appears when the hard drive is entirely taken by Windows®. Choosing
this option will simply erase everything on the drive, partitioning everything from scratch.

If you choose this option, all data on your disk will be lost.

• Custom disk partitioning. Choose this option if you want to manually partition your hard drive. Be careful:
it is a powerful but dangerous choice and you can very easily lose all your data. That’s why this option is
only recommended if you have performed custom disk partitioning before, and have enough GNU/Linux
experience. For more instructions on how to use the DiskDrake utility, refer to Managing your Hard Drive
Partitions with DiskDrake, page 169.

3.8. Choose Packages to Install

Depending on the installation media you are currently using, you may be first asked to select the CDs you
actually have at hand.
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3.8.1. Choose Package Groups to Install

It’s now time to specify which programs you wish to install on your system. There are thousands of packages
available for Mandrakelinux, and to make it simpler to manage, they have been placed into groups of similar
applications.

Mandrakelinux sorts package groups into categories. You can mix and match applications from the various
categories, so a Workstation installation can still have applications from the Server category installed.

1. Workstation: if you plan to use your machine as a workstation, select one or more of the groups in this
category. The special LSB group will configure your system so that it complies as much as possible with
the Linux Standard Base Project (http://www.linuxbase.org/) specifications.

2. Server: if your machine is intended to be a server, select which of the more common services you wish to
install on your machine.

3. Graphical Environment: this is where you will choose your preferred graphical environment. At least one
must be selected if you want to have a graphical interface available.

Moving the mouse cursor over a group name will display a short
explanatory text about that group.

You can check the Individual package selection box, which is useful if you’re familiar with the packages being
offered or if you want to have total control over what will be installed.

If you start the installation in Upgrade mode, you can deselect all groups and prevent the installation of any
new packages. This is useful for repairing or updating an existing system.

Minimal Installation

If you deselect all groups when performing a regular installation (as opposed to an upgrade), a new dialog
shows after pressing the Next button, suggesting different options for a minimal installation:

• With X: install the minimum number of packages possible to have a working graphical desktop.

• With basic documentation: installs the base system plus basic utilities and their documentation. This installa-
tion is suitable for setting up a server.

• Truly minimal install: installs the absolute minimum number of packages necessary to get a working Linux
system. With this installation you will only have a command-line interface.
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3.8.2. Choosing Individual Packages to Install

If you choose to install packages individually, the installer will present a tree structure containing all packages
classified by groups and subgroups. While browsing the tree, you can select entire groups, subgroups, or
individual packages.

Whenever you select a package on the tree, a description will appear on the right to let you know the purpose
of that package.

If a server package has been selected, either because you specifically
chose the individual package or because it was part of a group
of packages, you will be asked to confirm that you really want
those server packages to be installed. By default Mandrakelinux will
automatically start any installed services (servers) at boot time.
Even if they are safe and have no known issues at the time the
distribution was shipped, it is entirely possible that security holes
were discovered after this version of Mandrakelinux was finalized. If
you don’t know what a particular service is supposed to do or why
it’s being installed, then click No.

The Show automatically selected packages option is used to disable the warning dialog. Those appear whenever
the installer automatically selects a package to resolve a dependency issue. Some packages depend on others
and the installation of one particular package may require the installation of another one. The installer can
determine which packages are required to satisfy a dependency and to successfully complete the installation.

The little floppy disk icon at the bottom of the list allows you to load or save the packages list. This is useful if
you have a number of machines that you wish to configure identically. Click on this icon and select whether
you wish to Load or Save the packages list, then select the medium in the following screen and click on the Ok
button.

3.9. Multiple CD-ROM Installation

The Mandrakelinux installation is distributed on several CD-ROMs. If a selected package is located on another
CD, DrakX will eject the current CD and ask you to insert the required one. If you do not have the requested
CD-ROM at hand, just click on Cancel, and the corresponding packages will not be installed.
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3.10. Root Password

This is the most crucial decision point for the security of your GNU/Linux system: you must enter the root
password. Root is the system administrator and is the only user authorized to make updates, add users,
change the overall system configuration, and so on. In short, root can do everything! That’s why you must
choose a password which is difficult to guess: DrakX will tell you if the password you chose is too simple.
You’re not forced to enter a password, but we strongly encourage you to do so. GNU/Linux is just as prone
to operator error as any other operating system. Since root can overcome all limitations and unintentionally
erase all data on partitions by carelessly accessing the partitions themselves, it is important that it be difficult
to become root.

The password should be a mixture of alphanumeric characters and at least 8 characters long. Never write
down root’s password — it makes it far too easy to compromise your system.

One caveat: don’t make the password too long or too complicated because you must be able to remember it!

The password won’t be displayed on screen as you type it. To reduce the chance of a blind typing error you
will need to enter the password twice. If you do happen to make the same typing error twice, you will have to
use this “incorrect” password when you try to connect as root, at least for the first time.

You can change the way users are authenticated on your computer by clicking on the Authentication method
button. The following authentication methods are available:

• Local file. Use a local file for all authentication and user information. This is the default method.

• LDAP. Use an LDAP server for some or all authentication needs. An LDAP directory consolidates certain
types of information within your organization.

• NIS. Authenticates users against a NIS domain. This allows you to run a group of computers in the same
NIS domain using a common password and group file.

• Windows Domain. Uses a Windows® domain controller to provide authentication services through Active
Directory, Microsoft’s implementation of LDAP.

If you select a method other than Local file, you will be asked to provide some parameters, which vary from
one method to the other. If you don’t know those parameters, you should ask your network administrator.

If you happen to have problems remembering passwords, or if your
computer will never be connected to the Internet and you absolutely
trust everybody who uses your computer, you can choose to have
No password. Please bear in mind that this is an insecure option,
and it is not recommended.

22



Chapter 3. Installation with DrakX

3.11. Adding a User

GNU/Linux is a multi-user system which means each user can have his or her own preferences, own files and
so on. But unlike root, who is the system administrator, the users you add at this point won’t be authorized to
change anything except their own files and their own configurations, protecting the system from unintentional
or malicious changes which could have a serious impact on it.

You will have to create at least one regular user for yourself — this is the account which you should use for
routine, day-to-day usage. Although it’s very easy to log in as root to do anything and everything, it may
also be very dangerous! A very simple mistake could mean that your system won’t work any more. If you
make a serious mistake as a regular user, the worst that can happen is that you’ll lose some information, but
you won’t affect the entire system.

The first field asks you for a real name. DrakX will use the first word you type in this field and copy it, all
in lowercase, to the Login name field, which is the name this user will enter to log on to the system. You can
override it and change the Login Name. The next step is to enter a password. From a security point of view,
a non-privileged (regular) user’s password is not as crucial as the root password, but that’s no reason to
neglect it by making it blank or too simple: after all, your files could be the ones at risk.

Once you click on Accept user you can add other users. Add a user for each one of your friends, your father,
your sister, etc. Click Next when you’re finished adding users.

Clicking the Advanced button allows you to change the default
shell for that user (bash by default).

23



Chapter 3. Installation with DrakX

When you’re finished adding users, you’ll be asked to choose a user who will be automatically logged into the
system when the computer boots up. If you’re interested in that feature (and don’t care much about security),
choose the desired user (if more than one regular user is defined) and select a window manager, then click on
Next. If you’re not interested in this feature, uncheck the Do you want to use this feature? box.

3.12. Installing a Bootloader

A bootloader is a small program which is started by the computer at boot time. It’s responsible for starting up
the whole system. Normally, the bootloader installation is totally automated. DrakX will analyze the disk boot
sector and act according to what it finds there:

• If a Windows® boot sector is found, it will replace it with a GRUB/LILO boot sector. This way you will be
able to load either GNU/Linux or any other OS installed on your machine.

• In any other case it will ask you where it should place the boot loader. Generally, the First sector of the drive
(MBR) is the safest place.

Choosing Skip won’t install a bootloader. Use this option only if you know what you’re doing.
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3.13. Checking Miscellaneous Parameters

3.13.1. Summary

As a review, DrakX will present a summary of information it has gathered about your system. Depending on
the hardware installed on your machine, you may have some or all of the following entries. Each entry is made
up of the hardware item to be configured, followed by a quick summary of the current configuration. Click on
the corresponding Configure button to make any changes.

• Keyboard: check the current keyboard map configuration and change it if necessary.

• Country / Region: check the current country selection. If you’re not in the country selected by DrakX, click on
the Configure button and choose another. If your country isn’t in the list shown, click on the Other Countries
button to get a complete country list.

• Timezone: by default, DrakX deduces your time zone based on the country you have chosen. You can click
on the Configure button here if this is not correct.

• Mouse: verify the current mouse configuration and click on the button to change it if necessary.

• Printer: clicking on the Configure button will open the printer configuration wizard. Consult Configuring
Printers with PrinterDrake, page 123 for more information on how to set up a new printer. The interface
presented in our manual is similar to the one used during installation.

• Sound card: if a sound card is detected on your system, it will be displayed here. If you notice the sound card
isn’t the one actually present on your system, you can click on the button and choose a different driver.

• TV card: if you have a TV card, this is where information about its configuration will be displayed. If you
want to try a different driver for your TV card, or its detection wasn’t accurate you can click on Configure to
try to configure it manually.

• Graphical Interface: by default, DrakX configures your graphical interface with a resolution that best matches
your video card and monitor combination. If that doesn’t suit you, or DrakX could not automatically confi-
gure it (not configured is displayed), click on Configure to reconfigure your graphical interface. You can click
on Help from within the configuration wizard to benefit from full in-line help.

• Network: if you wish to configure your Internet or local network access, you can do so from here. Refer to the
printed documentation or use the Mandrakelinux Control Center after the installation has finished to benefit
from full in-line help.

• Proxies: allows you to configure HTTP and FTP proxy addresses if the machine you’re installing on is to be
located behind a proxy server.

• Security Level: this entry allows you to redefine the security level as set in a previous step (see Security Level,
page 17).
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• Firewall: if you plan to connect your machine to the Internet, it’s a good idea to protect yourself from in-
trusions by setting up a firewall. Consult Securing your Internet Access via DrakFirewall, page 182 for details
about firewall settings.

• Bootloader: if you wish to change your bootloader configuration, click this button. This should be reserved
to advanced users. Refer to the printed documentation or the in-line help about bootloader configuration in
the Mandrakelinux Control Center.

• Services: with this entry you can fine tune which services will be run on your machine. If you plan to use
this machine as a server it’s a good idea to review this setup.

3.13.2. Time Zone Options

This dialog appears after selecting a new time zone in the time zones list. After you’ve chosen the location
nearest to your time zone, two more options are shown.

GNU/Linux manages time in GMT (Greenwich Mean Time) and translates it to local time according to the time
zone you selected. If the clock on your motherboard is set to local time, you may deactivate this by deselecting
Hardware clock set to GMT, which will let GNU/Linux know that the system clock and the hardware clock are
in the same time zone. This is useful when the machine also hosts another operating system.

The Automatic time synchronization option will automatically regulate the system clock by connecting to a
remote time server on the Internet. For this feature to work, you must have a working Internet connection. We
recommend that you choose a time server located near you or the generic World Wide entry which will select
the best server for you. This option actually installs a time server which can be used by other machines on
your local network as well.
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3.13.3. Configuring X, the Graphical Server

X (for X Window System) is the heart of the GNU/Linux graphical interface on which all the graphical environ-
ments (KDE, GNOME, AfterStep, WindowMaker, etc.) bundled with Mandrakelinux rely on.

You will see a list of different parameters which you can change in order to optimize your graphical display.

Graphic Card

If everything works fine, the installer should detect and configure the video card installed on your machi-
ne. If the detection or configuration is incorrect, you can choose the card installed on your system from a
list.

Monitor

If the installer fails to detect or configure your monitor properly, you can choose from this list the monitor
which is connected to your computer.

Resolution

Here you can choose the resolutions and color depths available for your graphics hardware. Choose the
one which best suits your needs (you will be able to make changes after the installation). A sample of the
chosen configuration will be shown in the monitor picture.

Test

Depending on your hardware, this entry might not appear.

The system will try to open a graphical screen at the desired resolution. If you see the test message during
the test and answer Yes, then DrakX will proceed to the next step. If you don’t see it, it means that some part
of the auto-detected configuration was incorrect and the test will automatically end after a few seconds
and return you to the menu. Change settings until you get a correct graphical display.

Options

This step allows you to choose whether you want your machine to automatically switch to a graphical
interface at boot. Obviously, you may want to select the No option if your machine is to act as a server, or
if you were not successful in getting the display configured.

27



Chapter 3. Installation with DrakX

3.13.4. Selecting Available Services at Boot Time

This dialog is used to select which services you wish to start at boot time.

DrakX will list all services available on the current installation. Review each of them carefully and uncheck
those which aren’t needed at boot time.

A short explanatory text will be displayed about a service when it
is selected. However, if you’re not sure whether a service is useful
or not, it is safer to leave the default behavior.

At this stage, be very careful if you intend to use your machine as
a server: you probably don’t want to start any services which you
don’t need. Please remember that some services can be dangerous
if they’re enabled on a server. In general, select only those services
you really need.
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3.14. Installing Updates from the Internet

By the time you install Mandrakelinux, it’s likely some packages will have been updated since the initial release.
Bugs may have been fixed, security issues resolved, etc. To allow you to benefit from these updates, you’re
now able to download them from the Internet. Select Yes if you have a working Internet connection and you
want to install any updated packages now, or No if you prefer to install updated packages later.

Choosing Yes will display a list of web locations from which updates can be retrieved. You should choose one
near to you. A tree containing package selections will appear: review the selection, and press Install to retrieve
and install the selected package(s), or Cancel to abort.

3.15. It’s Done!

There you are. The installation is now complete and your GNU/Linux system is ready to be used. Just click
on Reboot to restart the system. Don’t forget to remove the installation media (CD-ROM or floppy). The first
thing you should see after your computer has finished doing its hardware tests is the bootloader menu, which
allows you to choose between the OSes your system can boot.
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3.15.1. Advanced Options

The Advanced button shows more buttons to:

1. Generate auto-install floppy: enables you to create an installation floppy disk which will automatically per-
form a whole installation, similar to the one just finished, without the help of an operator.

Note that two different options are available after clicking on that button:

• Replay. This is a partially automated installation. The partitioning step is the only interactive procedure.

• Automated. Fully automated installation: the hard disk is completely rewritten, all data is lost.

This feature is very handy when installing on a number of similar machines. See the Auto install (http:
//www.mandrakelinux.com/drakx/auto_inst.html) section on our web site for more information.

2. Save package selection1: saves a list of the packages selected in this installation. The following screen shows
you the possible media to use to save the package list onto: you might need to fill some parameters when
you click on the Next button.

To use this selection of packages with another installation, perform the installation as usual up to the
point of the package selection, and choose to select individual packages, without worrying about the
current package selection. Use the floppy icon and select the Load option. Then choose the medium which
contains the package list. Finally click OK: the list of packages you loaded will be selected and be installed.

3.16. How to Uninstall Linux

If for any reason you want to uninstall Mandrakelinux, you can do so. The process of uninstalling Mandrakelinux
is done in two steps:

Removing partitions on your hard drive will inevitably result in the
loss of all data stored on those partitions. Please make sure you’ve
backed up all of the data you want to keep before proceeding.

1. Delete all partitions related to Mandrakelinux on your hard drive (usually partitions hosting ext3 file sys-
tems and the Swap partition) and — optionally — replace them with a single partition using DiskDrake (see
Managing your Hard Drive Partitions with DiskDrake, page 169).

2. Remove the bootloader, LILO in this example, from the Master Boot Record (MBR). To do so, execute lilo
-U in a console, as root. Doing this will not only uninstall LILO but will also restore the previous master
boot record, if any.

If you have a different boot loader, please refer to its documentation to determine how to regenerate the
master boot record.

1. If you chose to save on a floppy, you will need a FAT-formatted floppy. To create one under GNU/Linux, type mformat
a: or, as root, fdformat /dev/fd0 followed by mkfs.vfat /dev/fd0.
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Chapter 4. Migrating to Linux from Windows® and Mac OS® X

This chapter is aimed at users migrating from Windows® or Mac OS® X. Instead of presenting the various
applications in depth, it tries to answer the most common questions and/or issues former Windows® or Mac
OS® X users might ask.

4.1. Where’s my...?

Experienced Windows® and Mac OS® X users are normally accustomed to certain functions and/or concepts
which are often treated differently in GNU/Linux.

4.1.1. Start Menu

In Windows®, most applications and system tools are accessed through the so-called Start Menu; this concept
remains more or less the same, except it’s now called the Main Menu: in KDE you open it by clicking on the
yellow star at the bottom left of your screen.

For users coming from Mac OS® X, Mandrakelinux’s Main Menu can be considered as a replacement for func-
tions from both the Apple Menu, located at the far left of the menu bar, and the Applications folder available in
the Finder.

4.1.2. Applications

The wide variety of applications is a large differentiator between GNU/Linux and Windows®. Mandrakelinux
installs many more applications onto your system, and clicking on the main menu will give you a wide range
of choices depending on what you would like to do. There are many fully-fledged applications available to
accomplish many common tasks such as office work (word processing, spreadsheets, presentations), e-mail
handling, web browsing, software development, multimedia file handling, etc.

Mac OS® X users may find similarities between Mac OS® X and GNU/Linux applications, because Mac OS®

X is based on BSD®, a UNIX®-like system on which GNU/Linux is also based. Moreover, other applications
designed for the desktop have been ported to, or are available under, the X11 implementation available for
Mac OS® X.

You may also install a large number of applications through the RpmDrake utility (please refer to the “Package
Management through Rpmdrake”, page 107).

4.1.3. Control Panel/System Preferences

The Control Panel in Windows® and the System Preferences utility in Mac OS® X are replaced by the Mandrake-
linux Control Center under Mandrakelinux. It can be accessed by choosing System+Configuration→Configure your
computer in the main menu. With this interface, you have the ability to modify most of your system’s settings
with graphical tools.

4.1.4. DOS Shell

GNU/Linux is still very fond of shell environments. Unlike Windows® the popularity of the shell is not fading
away as is evident by the availability of the shell in Mac OS® X. By default, Mandrakelinux installs bash, a truly
powerful shell environment. You can access it by opening the main menu and choosing System+Terminals→
Konsole.

Few of your DOS commands or functions will work in a Linux shell.
Take a look at the Introduction to the Command Line chapter in
the Reference Manual to discover their equivalents and much, much
more. Have fun, you now have a real shell at hand!
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4.1.5. Network Neighborhood

GNU/Linux uses TCP/IP by default, not SMB (the Windows® network protocol), so there’s nothing like a net-
work neighborhood icon to give you a view of the network you’re in. However, you may use the LinNeigh-
borhood application to give you similar functionality.

Konqueror can also accomplish the same tasks. Just type smb:/ in the location bar, and all of the shared Win-
dows® resources on the network will appear. Please remember that for this to work, the samba-client package
must be installed.

See File Sharing, page 79 for more information.

4.1.6. C: Drive

The “lettered drive” is a concept exclusive to Windows®. On UNIX® systems, the drive notion (C:, D:, ..., Z:)
is replaced by “mount points”. From a user perspective, you’re always accessing directories. Your system will
use configuration files to instruct the file system how to “load” all relevant disks, disk partitions and remote
systems, and then assign them to a specified directory, generally under the /mnt directory. While this concept
is similar to that found in Mac OS® X, it is slightly different. What is mounted under /mnt with GNU/Linux is
mounted under /Volumes in Mac OS® X but is made available as a “root file system” in the Finder.

4.1.7. CD-ROM Drives

The same concept as for C: applies here. CD-ROMs are mounted in /mnt/cdrom. To access the CD-ROM, just
click on the desktop icon and the CD-ROM’s contents will appear in a new window.

Things are a bit different for audio and data CDs: upon inserting
an audio CD in the drive, the CD player is automatically loaded.
Please see Audio Applications, page 87.

4.1.8. Floppy Disk Drives

Like CD-ROMs and disk partitions, floppy disks are mounted and will appear on /mnt/floppy. This feature
directly supports reading Windows® diskettes.

Icons are displayed on your desktop to access all your removable
media devices: floppy, CD-ROM, ZIP, USB keys, and others.

4.1.9. My Documents

Under Mandrakelinux every user has a directory called the user’s home directory: that is the place to store
the user’s documents. For example, Peter should store documents in /home/peter. A MyDocuments directory
could be created inside the user’s home to “mimic” Windows® behaviour.

The home directory concept is analogous to the C:\Winnt\Profiles\user_name\ or C:\Documents and
Settings\user_name\ directories in Windows NT®, Windows® 2000 and Windows® XP and is explained in
“Using KDE”, page 45.

Under Mac OS® X this is very similar. The home directory’s equivalent is /Users/user_name which contains
a directory called Documents.
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4.1.10. The Applications Needed to Open Some Kinds of Document

GNU/Linux can open most standard file formats: PNG pictures, Rich Text Format texts, PostScript printouts,
etc. These file formats should always be preferred as they facilitate exchange of data between applications,
and they ensure your freedom to change to another application and do not lock you into a given operating
system.

You may also have many files in proprietary formats such as Microsoft® Excel or Microsoft® Word documents.
OpenOffice.org is just one application which can handle most popular formats for office applications (see Word
Processor, page 71 and Spreadsheet, page 73).

We specifically mention office documents because they are widely
used. Due to space constraints we cannot cover every single Win-
dows® application and its GNU/Linux equivalent. However, there
is a high probability that you will find GNU/Linux equivalents for
all the programs you used under Windows® or Mac OS® X. To
get an idea of GNU/Linux equivalents of Windows® applications,
you can consult this table of equivalents (http://linuxshop.ru/
linuxbegin/win-lin-soft-en/table.shtml).

4.2. A Brave New World!

Now that you have found your way around GNU/Linux, here is a brief presentation of the features which make
excellent reasons to migrate to GNU/Linux.

4.2.1. A Multi-User Environment

GNU/Linux, like Mac OS® X, is based on UNIX®. This basically implies a shift in the structure of your envi-
ronment, from a single workstation to a multi-user architecture and implies very thorough user management.
Each file, service and application is exclusively allocated to a user or a group of users, according to its na-
ture. For example, every user has his or her own personal directory, containing personal data and personal
configuration files, which can be made inaccessible (even invisible) to other users.

4.2.2. Multiple Tasking

GNU/Linux has always been a very strong operating system for multi-tasking (running many applications
concurrently). Although other operating systems have made great progress, GNU/Linux remains a leader in
this domain.

4.2.3. Multiple Desktops

With GNU/Linux, KDE and GNOME give you as many desktops as necessary to work with, instead of just a
single desktop. Users who like to have numerous applications running at the same time will greatly appreciate
this feature since it makes for a much cleaner working environment.

4.2.4. Full Desktop Customization

Regarding aesthetics, GNU/Linux truly rocks! Not only can you choose between KDE or GNOME and many
other window managers, but you can also highly customize their appearance with themes. Themes go beyond
just the initial look and feel: actually, everything you see can be modified, from the background image to the
behavior of applications when they are closed, which is truly unique.

See the themes page on Freshmeat (http://themes.freshmeat.net/) for available designs.
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4.2.5. Thousands of Free Applications

The GNU/Linux community is by far the most generous one. Given a specific problem, you will most likely find
a script or an application to answer your needs, for free! Also, Mandrakelinux includes hundreds of applications
not documented in this book, so don’t be shy, try them out. You’ll most probably be surprised by the extent of
the possibilities GNU/Linux offers.

GNU/Linux also offers advanced server functionality, such as the ability to host mail or web page servers “out
of the box”.

4.2.6. No More Reboots!

Windows® and Mac OS® (although this has largely been addressed in Mac OS® X) users know the level
of frustration generated by crashing systems. Even though GNU/Linux is not perfect, its stability is one of its
strongest points. Sometimes, applications crash, but rarely do they take the operating system down with them.

We hope this rapid tour will help you truly appreciate GNU/Linux’s strengths. Do not be afraid to explore
further!

34



Chapter 5. Linux for Beginners

5.1. Introduction

This chapter was written for inexperienced GNU/Linux users. If you know how to log in and out, use KDE
and know where your applications reside on your Mandrakelinux system, skip ahead to the next chapter. If not,
read on! After reading this chapter, all subsequent chapters will make much more sense to you.

If you are an experienced Windows® or Mac OS® user, refer to
“Migrating to Linux from Windows® and Mac OS® X”, page 31,
which will ease the transition between those operating systems and
GNU/Linux.

5.2. The Bootloader Menu

When you reboot your computer after completing your Mandrakelinux installation, you will first see a menu
containing a few items called the bootloader menu. This allows you to boot your GNU/Linux system, or any
other operating systems you may have already installed, as well as some special options.

The number of items and their names will vary depending on your particular configuration. The one we are
interested in at the moment is obviously the one labeled linux, which will start your Mandrakelinux system. It
is the default item unless you manually configure it differently. All you need to do is to wait a few seconds —
you will see a countdown at the bottom of the screen — or press Enter, and Mandrakelinux will start loading.
You can select a different item by using the arrow keys on your keyboard and pressing the Enter key.

5.3. Getting Ready for your Session

GNU/Linux is a multiuser system. This means that more than one user can access the same machine, each with
the ability to keep his or her own data and configuration files private and protected from other users. To be
able to do this, different user accounts must be created by the administrator. The administrator is called root,
whose password has been set during installation, and who has no restrictions at all on the system.

It’s also important to understand the terms “to log in” and “to log out”. To log in means to identify yourself
to the computer. Think of it as a security officer verifying who you are before letting you in. After logging in,
the system takes a number of actions in order to give you access to the system’s resources. By logging in, you
start a so-called “session”.

When you log out you are telling the system you no longer need to use its resources. Your personal session is
closed, you exit the graphical interface and the login screen appears once more.

Although these definitions are valid within the scope of this chapter,
they are oversimplified. As you read the following chapters, you will
better understand these concepts, their advantages and options.

5.4. Beginning your Session

We assume that you are sitting in front of a running Mandrakelinux computer which, when turned on, auto-
matically displays the graphical login screen. If this is not the case and you are facing a black screen with
something like:

Mandrakelinux release 10.2 (Limited Edition) for i586
Kernel 2.6.10-3mdk on an i686 / tty1
machine_name login:

with a flashing cursor, type your user name (as defined during installation or by your system administrator),
then your password. You should now be logged in. Now type startx and the graphical interface will be
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launched (KDE by default, see “Using KDE”, page 45). If this doesn’t work, please refer to X Doesn’t Start,
page 199. In order to automatically start your system in graphical mode, refer to Controlling the Graphical
Configuration, page 119.

5.4.1. Identifying Yourself

You are currently in front of the following display (see figure 5-1). To log into the system, you need to supply
your password.

If there is more than one user defined on your system, you will just
have to supply first your login name, selecting it from the list, and
then your password.

Figure 5-1. The Login Window

The login procedure takes place in a few simple steps:

1. Click on the icon corresponding to your login name, if needed.

2. Type your secret password1

3. Choose your favorite graphical environment from the Session type pull-down menu2. The session you last
chose is selected by default, but if this is the first time that you have logged in, the default environment is
KDE.

4. Finally click on the Login button to begin your session. Be patient! It may take a few seconds before your
desktop is ready to be used.

If you are the only user of your new Mandrakelinux system, and you are annoyed by having to type your login
name and password every time you start a new session, there is a way to avoid this step: by booting directly
into your favorite desktop environment. This feature is known as auto-login (see Configuring the Login Mode,
page 185).

Be careful with this option as no password will be asked for, there-
fore anybody can access your system.

1. The actual password will not be displayed and will be replaced by little stars (*). Remember: passwords under
GNU/Linux are case sensitive, which means that if your password is Very_Secret and you type Very_secret, access
will be denied!
2. This step is optional and allows you to choose a specific graphical environment. While we encourage you to try the
various available choices so you can find the one you prefer, we strongly suggest you start with either KDE.
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5.5. Using your Graphical Environment

5.5.1. The Mandrakelinux Desktop

All modern graphical environments share a common set of features: a main menu, a desktop area with some
icons, a panel, etc. In the following paragraphs we will describe the elements which compose the desktop
environment.

Figure 5-2. The KDE Desktop

1. Icons are located on the left of the screen and in the bar at the bottom of the screen. These are enhanced
by a short description (the icon’s title or name). Clicking on an icon either launches a program or opens a
folder. In both cases a window will appear on the desktop.

2. The panel is located in the lower part of the screen. It provides quick access to useful tools such as a
Terminal, a web browser, a text editor, etc. Each icon symbolizes an application (or program). Just move
your mouse cursor over one of the icons and leave it there for a few seconds. A yellow help balloon will
appear to describe the icon’s function.

3. The icons and the panel do not float on the screen: they are “stuck” on something called the desktop, also
called the background. In a sense, the desktop is where everything you see or use lives. Move your mouse
cursor to a free area on the desktop (i.e. where there is nothing) and right-click: a menu will appear which
will give you access to several more functions.

5.5.2. Accessing Applications

To access all of the software you installed during the installation process, click on the main menu. The
applications are organized by tasks, so finding the program you are looking for is pretty easy.

5.5.3. Opening a Window on the Desktop

If you click on the icon on the desktop labeled as Home this window will appear:
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Figure 5-3. KDE File Manager

You just launched a file manager called Konqueror. The window which pops up displays the content of your
Home directory. This is where all of your personal documents and files are stored: only you can access them.

A window is composed of several parts. On top is the title bar. It shows the name or title of the application
you launched and, possibly, the name of the document you are working on. It can be in two different states:

• Active. (full-colored title bar) This means you are currently using it.

• Inactive. (shaded title bar) The program is running, but you are not interacting with it at the moment.

Just under the title bar is the menu bar. In our example, it contains menus named Edit, View, and so on. Click
on Edit. A list of items will appear in a drop-down menu, each one giving you access to one of the program’s
functions.

Below the menu bar is the application’s tool bar. It consists of one or more rows of icons, each one equivalent
to an item in one of the application’s drop-down menus: you can consider them as a shortcuts to frequently-
accessed program features, which can be found elsewhere in the menu bar.

The status bar usually sits at the bottom of the window. In it you will find information about the program’s
activity. Not all programs offer this feature, but if the one you are using does, remember to check it from time
to time.

5.5.4. Managing Desktops

We introduced the desktop to point out the area of the screen where all objects are placed. Now look at the
panel at the bottom of the screen. You can see a group of desktop buttons:

Figure 5-4. KDE’s Virtual Desktop Buttons

These buttons give you access to virtual desktops, which are identical copies of the desktop you see after you
have logged in. You will find more information about the handling and usage of virtual desktops in Virtual
Desktops, page 46.

Click on the button labeled 2: as you can see, the window you opened before disappears. You didn’t close it,
you simply switched desktops. Click on the button labeled 1. The previous desktop will be displayed.

This feature called virtual desktops is very handy. It allows you to open several windows and to organize
them as you wish.
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You can also change which virtual desktop a window is currently in. This may be handy to logically organi-
ze your work by desktop, for instance moving all network related windows into desktop 2, all multimedia
applications into another desktop, and so on.

So with KDE, right-click on the window’s title bar and a pull-down menu will appear containing an item
named To Desktop. Just point to this item and a list of your virtual desktops will appear. Simply choose the
virtual desktop that you want to move it to.

5.6. Logging Out of your Session

When you are finally done using your computer, don’t forget to tell the system you are leaving, that is remem-
ber to log out in a proper manner.

Logging out can be carried out in many ways: from the main menu, or from the menu that appears when you
right-click on the desktop.

Whichever method you use, the screen will shade and a little box will pop up with options. If you click on OK
you will quit the current session and, after all of your windows and the desktop itself have closed, you will be
returned to the login screen.

However there are two other options available in the confirmation window: you can choose to shutdown the
system (power off the computer), as well as reboot your system. Again, just click on the OK button after you’ve
selected the desired option.

This is the correct and safe way to shut down or reboot your system. You should never do it by pushing your
computer’s power button because this can lead to serious problems such as file-system corruption or the loss
of data.
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Chapter 6. Accessing Documentation

Apart from the manuals included with Mandrakelinux, documentation is available from many sources. The
next few pages contain suggestions which you might find useful.

6.1. Mandrakelinux-Specific Documentation

6.1.1. Mandrakesoft’s Own Documentation

Some of those manuals may be available in your Mandrakelinux pack, in the mandrake-doc-en package. Once
this is installed, a new menu entry will be available: More Applications+Documentation→Mandrakelinux docu-
mentation in English.

This section lists all the documentation which Mandrakesoft produced for the current release:

Starter Guide

This manual is intended to get you going with Mandrakelinux. It includes basic topics which should be of
interest to new GNU/Linux users, as well as configuration procedures for the most important elements of
Mandrakelinux.

Reference Manual

Available on-line and in the Mandrakelinux –– PowerPack Edition, this document covers advanced
GNU/Linux operations and system administration.

6.1.2. Internet Resources

Internet information sources are widespread and many web sites are devoted to GNU/Linux and its use or
configuration. However, some sources of information are better than others.

Your preferred source of information should be the Mandrakelinux official web site (http://www.mandrakelinux.
com/). In particular, check out the support section (http://mandrakeexpert.com).

On the other hand, many unofficial sources will also be of value. For one there is the Mandrake Community
Twiki (http://mandrake.vmlinuz.ca/bin/view/Main/WebHome). It offers a lot of resources and gives infor-
mation and documentation which can certainly interest Mandrakelinux users.

6.1.2.1. Mandrakeclub

If you’re familiar with Mandrakelinux’s web sites, you probably know about Mandrakeclub (http://
mandrakeclub.com/). It’s the meeting point for all Mandrakelinux users. On it you will find questions along
with their answers, suggestions and news related to Mandrakelinux and GNU/Linux. You will be able to express
your opinions and influence future development of Mandrakelinux. If you’re not a member yet, we encourage
you to join in.

One specific area of the Club is of particular interest: the Mandrakeclub Knowledge Base (http://kb.
mandrakeclub.com/) is the Mandrakelinux user’s database. It is probably the largest collection of Mandrakelinux-
related documentation on the web.

It collects submissions by Mandrakelinux users. It also features a discussion forum and a community newsletter.
These articles are meant to be practical and target beginner and intermediate users.

Topics range from administrative issues, such as the handling of the shell, to the tweaking of X, GNU/Linux’s
graphical subsystem.

6.1.2.2. Mandrakesecure

The Mandrakesoft Security Advisories web site (http://www.mandrakesoft.com/security/) (formerly
known as Mandrakesecure) is Mandrakesoft’s very own security site which covers package vulnerabilities.
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6.1.2.3. Mandrakesoft E-training

The Mandrakesoft E-Training web site allows you to buy quality GNU/Linux training in order to improve your
Open Source knowledge. You can access this web site (http://campus.mandrakesoft.com) by using your
Mandrakeclub account. A free demo on Samba is available.

6.2. GNU/Linux Useful Resources

In this section we present resources useful for any GNU/Linux distribution. Most are not written specifically
for Mandrakelinux, but may nevertheless prove useful.

6.2.1. The /usr/share/doc Directory

Most packages include their own documentation in one of /usr/share/doc’s sub-directories, which will be
named after the specific package. Mandrakelinux’s own documentation, when installed, is available in the /usr/
share/doc/mandrake/ directory.

6.2.2. The Man Pages

The Manual Pages (also known as “man pages”) are a set of exhaustive documents which help you acquire
better knowledge of GNU/Linux commands. The latter are usually issued through a “command line” and allow
great control over your system (see the Introduction to the Command Line chapter of the Reference Manual).
Although these man pages might seem discouraging at first, they offer great detail and we encourage you to
browse through them when a problem occurs.

This should be your primary source of information for shell commands. Almost all commands have a manual
page. Other items, such as certain configuration files, library functions for programmers and others system
aspects also have their own man pages.

Man page contents are arranged in different sections. References to these are made in the following manner:
for example, open(2), fstab(5) will respectively refer to the open page in section 2 and the fstab page in
section 5.

You can also display man pages in Konqueror by using the man:/
prefix in your URL.

The easiest way to view a man page is through a browser. Using Konqueror, type man:/man in the Location bar
and the man page for the man command will be displayed. For example, to display the man page for fstab(5),
type in the Location field: man:/fstab(5).

To display a man page in a terminal (or shell), type man. The syntax to obtain a man page is:

man [options] [section] <manual page>

man also has documentation, which can be obtained by typing man man. Manual pages are formatted and
then displayed using the less pager.

The names of the manual pages and their relevant sections appear at the top of each page. At the bottom of
the page you will find references to other pages with related subjects (usually in the SEE ALSO section).

You can start by consulting the pages related to the different commands covered in the Reference Manual: ls(1),
chmod(1), etc.

If you cannot find the right manual page — for example, you want to use the mknod function in one of your
programs but you end up on the mknod command page — make sure you spell out the section explicitly. In
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our example: man 2 mknod. If you forgot the exact section, man -a mknod will read through all the sections
looking for pages named mknod.
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Chapter 7. Using KDE

7.1. Discovering the K Desktop Environment

This chapter will introduce the K Desktop Environment (KDE) and its panel. It will also talk about the concept
of virtual desktops, how to navigate through and manage them and session support.

7.1.1. The Desktop

Figure 7-1. The KDE Desktop

KDE follows the modern desktop paradigm. In the above figure you see the desktop itself with some icons
on it, while the panel sits at the bottom. This figure also introduces something new if you come from the
Windows® world: virtual desktops (see Virtual Desktops, page 46).

Virtual desktops are not an exclusive KDE concept. Other
GNU/Linux desktop environments and window managers also make
use of them.

The icons on the desktop represent files, directories, applications, devices, web pages (actually, the page’s
URL), etc. Almost “everything” can be placed on it. Different actions are associated to each icon. For example:
clicking on a text file opens it into a text editor, clicking on a web page opens the URL inside Konqueror (see
Browsing Web Pages, page 79), and so on.

Here are some of your desktop’s default icons, along with a brief explanation for each of them.

Home. Gives access to all your personal files. Under UNIX®-like operating systems (Mandrakelinux is
one of them), every user has a personal directory usually named /home/user_name where user_name is the
user’s login name.

Trash. Gives access to all deleted files (the equivalent of Windows®’ Recycle Bin). Please bear in mind
that files can also be deleted without being thrown into the trash can (“direct” file deletion) so some deleted
files might not be accessible through the trash can.
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Dynamic Icons for Removable Media. There will be icons for removable devices on your
system (CD-ROM drive, floppy disk drive, ZIP/JAZ drives, etc.). Clicking on a device icon opens the medium
inside that device. An error message may be shown if there is no medium present or if the medium can not be
read for some reason.

7.1.2. The Panel

Figure 7-2. The KDE Panel

The panel is the bar which sits at the bottom of your desktop1 and contains the following main components:

The Main Menu. Allows you to access the software installed on your system. It is the equivalent of
Windows®’ Start menu. Programs are arranged into convenient categories, so you can quickly and easily find
the application you want to run.

Show Desktop. Use this to minimize all currently opened windows. Pressing it again will restore the
windows to the state they were previously in. Handy when you your desktop is so full of opened windows
and you want to access, for example, a folder on your desktop.

Desktop Switching Applet. Makes switching between virtual desktops as easy as one, two, three.
See Virtual Desktops, page 46 for more information.

Screen Resolution Applet. Allows you to change the screen resolution. With higher resolutions you
will have more space to run applications on your desktop. See Changing Screen Resolution, page 49, for more
information.

7.1.3. Virtual Desktops

Virtual desktops give you more room to place your windows; they also allow you to better organize your
windows by task.

Think of virtual desktops as having several screens available but with only one monitor. By default, there are
two virtual desktops. To add or remove virtual desktops right-click on the desktop switching applet and select
Configure Virtual Desktops from the pop-up menu. Using the slider at the top of the configuration dialog will
allow you to select up to 20 virtual desktops. Press OK once you are satisfied with your settings.

By default, virtual desktops are named Desktop N, where N is the desktop number. To give more meaning-
ful names to your virtual desktops (such as Work, Play, Internet...), right-click on the desktop switching
bar and select Configure Virtual Desktops from the pop-up menu. Click in the input field of the desktop for
which you wish to change the name and type in the new one. Pressing Apply will make the changes effective
immediately. Press OK once you are satisfied with your settings.

When you log in into KDE the last virtual desktop you were in when you closed your last session is opened.
To switch between virtual desktops just click on the desktop number in the desktop switching applet et voilà !

1. By default the panel is at the bottom, but it may be placed on any border of the desktop.
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7.2. Personalizing your Desktop

7.2.1. Changing your Desktop’s Appearance

Figure 7-3. Changing KDE’s Color Scheme

To change the desktop color scheme choose System+Configuration+KDE+ LookNFeel →Colors from the main
menu. In the Color Scheme list are predefined color schemes. Select the one you like and click on Apply.

You can also define your custom color scheme by clicking on the element you want to change (for example,
Active Window to change the active window colors) or selecting it in the Widget Color pull-down list. Once the
element (widget) is selected, click on the color bar to open KDE’s color selection dialog, choose the color you
like and click on OK to apply it.

Clicking on Save Scheme will allow you save the color scheme for later use; you will be prompted for the
scheme name, fill it and click on OK. Clicking on Remove Scheme will remove the currently selected customized
color scheme, predefined color schemes cannot be removed.

You are not asked for confirmation before removing a color scheme.
Therefore use the Remove Scheme button carefully.

47



Chapter 7. Using KDE

Figure 7-4. Changing KDE’s Background Wallpaper

To change the desktop background, choose System+Configuration+KDE+ LookNFeel →Background from the
main menu. Select the background picture option in the Background section and background scaling, colors
and blending in the Options section.

Click on the Advanced Options button to adjust settings such as an external program to draw the background,
the cache size for images, etc.

All desktop background settings can be applied on a per-desktop
basis using the Setting for desktop pull-down list. Please note that
doing so consumes more memory.

7.2.2. Managing Desktop Icons

Adding Icons. To add an icon on the desktop simply right-click on the desktop’s background. A pull-down
menu will appear in which you must choose Create New. Another menu will appear in which you must select
the type of object to create on your desktop:

• Folder creates a new folder on your desktop where you can store files.

• File→Link to Application creates an application launcher. When you click on it, the application will run as if
you called it from a menu or the command line. Use it to have quick access to the applications you use most.

• File→Link to Location (URL) creates an icon giving you direct access to an URL (typically a web page or a
web site). Use it to add icons for the sites you visit the most on your desktop.

The above list is not extensive. The choices you have in the menu
will depend on the software you have installed on your system.

Please bear in mind that the forms you will have to fill out to complete the icon adding operation are different
for each kind of object being created. However, their options are fairly simple.

Modifying Icons. Right-click on the icon you want to modify and select Properties from the menu. You will
then be able to change the title (the string displayed under the icon), the icon picture itself, and other properties
of that type of object (folder, application, URL, etc.). Once you are satisfied with your settings, click on the OK
button.
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Removing Icons. To remove an icon, right-click on it and select Delete from the menu that pops up to delete
it permanently, or Move to Trash (from where you can restore it later on). In either case, you will be asked to
confirm before proceeding.

7.2.3. Changing Screen Resolution

Figure 7-5. Available Screen Resolutions List

Clicking on the screen resolution changer applet will show you the list of all available sizes and refresh rates for
your video card and monitor combination (see figure 7-5). The active screen size and refresh rate are marked
with a tilde.

To change any parameter, simply select it from the list and a window will pop up asking you if you are satisfied
with the settings (see figure 7-6). If you click on the Accept Configuration button, the settings will be applied
immediately, otherwise the previous settings are retained.

Figure 7-6. Accept New Resolution Settings?

The higher the refresh rate, the steadier the image. Select the
highest refresh rate possible for your video card and monitor com-
bination to put the least strain on your eyes.

To make the settings persist between sessions, choose Configure display from the menu and make sure that both
Apply settings on KDE startup and Allow tray application to change startup settings are checked, otherwise your
screen resolution settings will be lost when you quit your session.

49



Chapter 7. Using KDE

7.3. KDE Sessions

KDE and its applications support sessions. This feature allows the system to save the state of all applications
that are in use when the user logs out of the desktop environment, and to restore them when the user logs
back in.

Please bear in mind that non-KDE applications, and even some
KDE ones, may have limited session support. The degree of session
recovery is up to the application, ranging from just opening the
application again, to opening it along with all the files that were
open inside that application.

By default, KDE automatically saves sessions whenever you log out of the desktop environment. To change
the default behavior, open the Session Manager (System+Configuration + KDE+Components→Session Manager
from the main menu.), make your choices and click on the OK button once you are satisfied with your settings.
They will be effective the next time you log into KDE.

50



Browsing and Surfing

Using the Internet with Mandrakelinux is very easy. And since it includes many mail clients and web browsers,
you can choose the one which you prefer.

The default e-mail client in Mandrakelinux is part of the Kontact suite of applications and is called KMail. With
it you will be able to read and write e-mails, filter spam, sign and encrypt your messages, and more (see
“Writing E-mails with KMail”, page 53). To browse the web we provide you with documentation about the ex-
tremely popular Mozilla-based Firefox (see “Surfing the Web with Firefox”, page 61 which is seriously threatening
Internet Explorer’s monopoly especially since it’s also available on Windows®. You will soon enjoy tabbed brow-
sing, watch RSS feeds as well as the other standard web browser features such as managing (and importing)
bookmarks.
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There are many graphical mail clients under GNU/Linux: KMail, Mozilla Thunderbird, Mozilla Messenger, etc.
KMail is a graphical mail client under GNU/Linux. It’s integrated into a groupware client named Kontact. This
chapter will describe how to configure and use KMail to compose, read and organize your e-mail messages.

You can launch KMail by selecting Internet→Mail→KMail from the main menu. As we proceed, please
note that only the minimum configuration steps will be explained in this section.

8.1. Configuring KMail

The first time you run KMail, you are faced with the Kontact main window, the mail section being selected.
Access the Settings→Configure KMail sub-menu to bring up the configuration window. It is organized as a list
of categories (on the left) and the configuration options for each of those categories (on the right). First, an
identity1 must be defined under the Identities category. KMail offers you a template for the default identity
based on your system’s account data (login, name, etc.). Click on the Modify button and, in the General tab, fill
Your name, Organization and Email address with your data (see figure 8-1).

Figure 8-1. Setting General User Parameters

Use the Cryptography, Advanced and Signature tabs to set up other parameters such as different “Reply-To”
addresses, a GPG key for secure message transmission, and so on. Once you are satisfied with your settings,
click on OK and then on Apply: your default identity will be defined.

To configure the mail servers, select the Network category. In the Sending tab click on the Add button, select
SMTP as the transport type and click on OK. In the General tab, fill the Name field with a meaningful name for
this server and the Host field with the SMTP server’s name or IP address (see figure 8-2). The remaining fields
can be left with their default values.

1. If you have more than one e-mail address, for example one for your work and a private one, it is useful to create a
different identity for each of them.
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Figure 8-2. Setting the Outgoing Mail Server

For security reasons, the outgoing mail server you use may need
authentication. If this is the case, check the Server requires authen-
tication box and complete the login and password provided by your
ISP or network administrator.

To receive mail, you need to create at least one account. In the Receiving tab click on the Add button, select POP3
as the account type2 and click on OK. In the General tab, complete the Name field with a meaningful one for
this account and the Host field with the name or IP address of the POP3 server. Your ISP should have provided
you with an e-mail user name and password which have to be entered in the Login and Password fields. Put
a check mark in the Store POP Password in configuration file to avoid having to type the password each time
messages are retrieved (see figure 8-3)3. If you use many computers to access your e-mail with a POP3 account,
you should check the Leave fetched messages on the server option. That way you can access messages which
you already downloaded from another computer. Click on OK to add the account.

2. Since almost all ISPs provide POP3 accounts to retrieve mail, we used it in our example. If you have another account
type, such as an IMAP (Internet Mail Access Protocol) one, the configuration will differ slightly.
3. However please understand that this means anyone can actually access your e-mails if they are using your user
account.
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Figure 8-3. Configuring a POP3 Mail Account

If you have a permanent network connection (such as DSL or cable-
modem) checking the Enable interval mail checking box and selec-
ting a period (in minutes) using Check interval will tell KMail to
fetch messages periodically.

If you want KMail to handle more than one mail account just repeat the above procedure for each extra account.
Once you are satisfied with your settings, click on OK. KMail is now ready to read and send mail on the
Internet.

8.2. KMail’s Interface

Figure 8-4. KMail Client Interface
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If the kontact package is not installed, the Kontact buttons on the
left won’t show.

Toolbar. This is where the main action buttons lie. See table 8-1.

Messages List. Where information (subject, date, sender, etc.) about messages stored in the currently selected
folder is displayed.

Message View Pane. Where the currently selected message’s contents are displayed.

Folders List. Where all folders are listed. The default folders are inbox (incoming messages), outbox (unsent
templates), sent-mail (already sent messages), trash (deleted messages) and drafts (draft messages).

Kontact Buttons. KMail is now a component of Kontact. On the left of the interface you have buttons to access
Kontact’s components.

The following table shows the most important buttons available in KMail’s toolbar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-N Compose a New Message. You will need to complete the To and Subject
fields in the message-compose window.

Ctrl-L
Get new messages for all defined e-mail accounts. Keep this button
pressed to display a list of all defined accounts; select the one you want
to get mail from in order to retrieve messages only for that account.

R Reply to the author of the selected message. A message-compose
window will pop up with some fields already set.

F Forward (send to a third party) the selected message. You will need to
fill in the To field in the message-compose window.

D
Delete the selected messages. Deleted messages are moved to the
Trash folder. You can recover messages moved into the trash folder,
but deletion from the Trash folder cannot be undone: be careful!

Table 8-1. KMail’s Toolbar Buttons

Most of those buttons have a little black arrow on their bottom right
corner. That means that a menu with additional related actions can
be displayed by pressing the mouse button a little longer.
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8.3. Composing a Message

Figure 8-5. The Message-Compose Window

Toolbar. This is where the main composition buttons reside. See table 8-2

Message Body. The area where you will type the contents of your message.

Message Recipients. The list of all recipients of this message. By default, the following options are shown:

• To: the “principal” intended recipient of this message.

• Cc (Carbon Copy): not-hidden “secondary” intended recipient(s) of this message. All recipients will have
access to the mail addresses to which this message is sent.

Select View→BCC from the menu to show the BCC (Blind Carbon
Copy) field. These recipients are also “secondary” but are hidden
from the other recipients of this message. No recipients of the mes-
sage will have access to the other mail addresses to which this
message was sent.

The following table shows the buttons which are mostly used in the message-composition window, their
equivalent keyboard shortcuts and a brief explanation of the functions they provide.

Button Keyboard
Shortcut

Function

Ctrl-Enter Sends the message immediately (your network connection must be
active). A copy of the message will be kept in the sent-mail folder.

Queue the message. The message will be saved in the outbox folder
and will be sent the next time you request mail to be sent (File→
Send Queued Messages).

Attach a file to the message. This function is also accessible through the
Attach→
Attach File menu. A standard file dialog will pop up. Select the file you
want to attach and click on OK. Repeat for multiple files.

Table 8-2. Message-Composition Toolbar Buttons
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8.4. Cryptography

8.4.1. Using a PGP Key

KMail allows you to use cryptography in order to encrypt and sign your e-mails, ensuring that your e-
communications are not tampered with. With the growing need for privacy over the Internet, you might want
to try out this feature.

Figure 8-6. Using OpenPGP within KMail

The easiest way to use encryption with KMail is if you already have a PGP key. If you don’t here’s how to
proceed:

1. Open a terminal window (System+Terminals→Konsole)(Administer your system→Use a terminal emu-
lator).

2. Type gpg --gen-key.

3. You will be asked for what type of key you want: choose DSA and ElGamal.

4. Choose a key size: 2048 bits is the default, and is enough for today’s needs; 4096 bits is probably extreme.

5. You can select an expiration date: 0 is for no expiration date.

6. Enter your user identification which contains your Real Name, then E-mail Address and finally an
optional Comment.

7. Enter a passphrase which should be composed of upper- and lowercase letters, numbers and symbols:
you need to enter it twice.

8. GPG will now generate your key. Move your mouse around, surf the web, play music since it needs a lot
of random data.

9. Finally to make sure everything works, type gpg --list-keys. You should get something similar to
this as a result:
[peter@community peter]$ gpg --list-keys
pub 1024D/95DBB95A 2005-03-15 Your Name (Comment) <your@email.com>
sub 1024g/47FBB9BA 2005-03-15

For more information about generating a GPG key, please refer to the gpg man page or to this excellent tutorial
(http://linsec.ca/bin/view/Main/GnuPG).

To set it up go back to the Manage Identities window (Settings→Configure KMail) and click on the Cryptography
tab: simply click on the Change buttons for the OpenPGP signing key and OpenPGP encryption key fields and
select your key (see figure 8-6), then OK.
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Now when you will open a new composition window, you will see two new icons:

• This icon allows you to electronically sign your e-mail, which proves without a doubt that the e-mail
comes from you.

• This icon permits to encrypt a message so that only the recipient you have chosen will be able to read
the contents of your e-mail. Note however that the recipient must have shared his public key with you.

Once you have finished writing your e-mail, click on the icon which you need (sign, encrypt or both) then

click on or Ctrl-Enter. A dialog box will appear and you will be asked to confirm your key and the
recipient’s:

Figure 8-7. Encryption Key Approval Dialog

Finally you will be asked to enter your GPG passphrase.

Figure 8-8. Passphrase Dialog

When you receive encrypted mail, you will be prompted for your passphrase: simply type it in the dialog box
which pops up.
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Chapter 9. Surfing the Web with Firefox

Surfing the web means displaying documents published in electronic format by other organizations or indivi-
duals. Each of these documents is accessed through its address which also known as it’s URL.

This chapter will deal with the speedy Firefox browser which is gaining more and more popularity each day,
and also challenging other very widespread browsers on different operating systems due to its cross-platform
availability. One of Firefox’s fortes is that you can personalize it endlessly through extensions (Extensions, page
64) and themes (Themes, page 65).

9.1. A First Glance at Firefox

You can launch the Firefox by selecting Internet+Web Browsers→Mozilla Firefox from the main menu.

Figure 9-1. Firefox Interface

If Firefox’s interface does not show in the expected language, you
can easily change that: go to the Edit→Preferences menu entry,
and select the General Language option. You will be able to select
and add available languages for your interface. Put your preferred
language on top of the list and the changes will be applied after
you refresh your browser.

Firefox’s interface is shown in figure 9-1. It is composed of the following:

• Page Display Area. Where the contents of the web pages you browse are displayed.

• Bookmarks Bar. Contains buttons which give you quick access to your bookmarked (favorite) sites (see
Managing Bookmarks, page 64), as well as Live Bookmarks.

• Navigation Buttons & Location Bar. Navigation buttons are explained in Surfing the Web, page 61. The lo-
cation bar is where you enter a web site’s URL (or a local file using file:// as the protocol part of the
URL).

• Search Engine Field. Simply type in a keyword and choose your preferred search engine (such as Googletm,
Yahoo!, Dictionnary.com, etc. The results will be available in the Page Display Area.
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9.2. Surfing the Web

The following table summarizes the most commonly used navigation buttons every web browser possesses.

Button Keyboard Shortcut Function

Alt-left_arrow

Go back. Returns to the page visited before the current one. By
clicking on it more than once, you can go back more than one page,
but some pages use automatic redirection so this may not always
work. Keeping this button pressed (or clicking on the little black
triangle at its right) will show you a list of all the pages you can
access through this feature.

Alt-right_arrow Go forward. Returns to the page visited after the current one. The
comments for the “Go back” button apply.

Ctrl-R

Reload. Refreshes the current page. By default, the browser will
first look for the page in its cache (on-disk temporary storage
space) and use the local copy, if relevant. Press the Shift key while
clicking on the reload button to force the browser to fetch the page
from the network.

Esc

Stop. Stops transferring the currently requested object and will
therefore cancel the page currently being loaded. Notice that we
use the word “object” instead of “page” since web pages might be
not only HTML code, but images and other media too.

Home page. Returnsyou to the default Firefox home page which
you can set through the Edit+Preferences→
General sub-menu.

Engines. Filling this field with a keyword (such as Linux) will send
for a request in one of the predefined search engines, such as
Googletm, Yahoo! and Creative Commons. By clicking on the
Googletm logo, you can even customize your engines by clicking on
Add Engines.

Table 9-1. Firefox’s Web Browser Toolbar Buttons

9.3. Using the Sidebar

The sidebar gives you a quick access to the history of the sites you have visited recently, as well as to your
bookmarks. To enable the sidebar, access the View+Sidebar sub-menu and then choose between Bookmarks
(Ctrl-B) or History (Ctrl-H).
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Figure 9-2. Bookmarks and History in the Sidebar

Search. Enter the keyword you wish to find results for (i.e. Mandrakelinux) in the Search field and press Enter.
All the items containing your keyword will be displayed under the Search field. This applies for both the
Bookmarks and History sidebars.

Figure 9-3. Search Fields Using the Bookmarks Sidebar

Bookmarks. In order to conveniently access your bookmarks, it is handy to display them in the sidebar. Clic-
king on one of your bookmarks will automatically launch a request for that page and it will be shown in the
display area. To search for specific bookmarks based on keywords, simply type that keyword in the Search
field (figure 9-3).

History. Firefox keeps track of the URLs you have visited in the past N days, where N is a number which can
be configured (the default is set to 9 days). If you want to return to a site you visited a three days ago, access
the 3 days ago folder in the History sidebar and click on the +. All the site’s URLs you visited that day will be
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displayed. Clicking on one of them will open the site in the Page Display Area. To look for a specific web site
enter either it’s URL or name in the Search field.

To change the number of history days to keep, choose
Edit+Preferences→Privacy from the menu and open the History
sub-section.

9.4. Managing Bookmarks

Bookmarks store the URLs of your favorite web sites so you do not have to type their address again when you
want to access them. You can classify them by subject, category, etc. Your Mandrakelinux system already has
some predefined bookmark categories which you can use as a guide to set up yours. Selecting Bookmarks→
Manage Bookmarks from the browser’s menu will open the bookmarks manager shown in figure 9-4.

Figure 9-4. Bookmarks Manager Dialog

Bookmarks are classified in a tree structure, with all operations taking place on the currently selected tree node.
Click on the New Folder button to create a new folder. Use folders to group bookmarks by subject, category,
etc. Click on the New Separator button to add a separating line below the current node. Click on the Properties
button to change the current bookmark’s properties (name, URL, etc.). Click on the Rename button to change
the bookmark’s displayed name. Click on the Delete button to remove the current bookmark.

Bookmarks can be exported to an HTML file. Choose File→Export from the menu, enter the file name
(bookmarks.html, by default) of the exported bookmarks file and click on Save.

Bookmarks can also be imported from an HTML file. Choose File→Import from the menu, enter the file name
of the bookmarks file to import and click on Open.

9.5. Tabbed Browsing

Figure 9-5. Firefox Tabs

Firefox allows you to browse many web pages at a time using a very nice feature called “tabbed browsing”.
Instead of opening a new browser window every time you want to view another page, you can open a new
tab.

Clicking on this button (at the right end of the tab list) allows you to close the current tab. Right-clicking
on it gives you some options such as opening new tabs, reloading current and all tabs, as well as closing them.
You can also open a new tab through the File→New Tab sub-menu, or simply by using the Ctrl-T keyboard
shortcut. On the other hand, Ctrl-W closes the current tab.
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9.6. Extensions

Extensions permit you to extend Firefox’s functionalities. You can think of extensions as add-ons or plugins.
You can access them through the Tools→Extensions sub-menu. Then click on Get More Extensions and this page
will appear:

Figure 9-6. Firefox Extension Page

Once you find an extension which interests you click on it and install it. You need to close and reopen your
browser for the extension to be activated. Access the Extensions sub-menu again. The new extension will be
there and you can check out its Options.

Figure 9-7. ChatZilla Options
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9.7. Themes

A theme is what “dresses” your Firefox window. The process to acquire new themes is very similar to the
extension procedure:

• access the Tools→Themes sub-menu;

• this web page will appear:

Figure 9-8. Firefox Themes Page

• select a theme you like and install it by clicking on it;

• close and reopen Firefox.

9.8. Installing Plugins

Plugins are programs which let your browser handle content other than HTML and graphics, such as
animations, streaming audio, Javatm applets, and more. Firefox’s plugins are stored in the /usr/lib/
firefox-VERSION/plugins directory and installing plugins requires root privileges.

We will look at the procedures to install Javatm, Flash® and Real plugins. If you own a commercial version of
Mandrakelinux, installation is greatly simplified and all the needed packages are on the CDs.

If you have a Mandrakeclub user name and password, you may be
able to install even newer versions of the software mentioned here.

9.8.1. Javatm

Install the jre RPM package. See “Package Management through Rpmdrake”, page 107, for information on how
to install RPM packages.

You can obtain the Java plugin on the Java Plug-in Home Page (http://java.sun.com/products/plugin/).
Follow the links to the J2SE (Java 2, Standard Edition) and download the JRE for Linux. Choose the RPM file for
the Linux platform, make it executable once the download finished (chmod 700 j2re[VERSION].rpm.bin)
and execute it. A “real” RPM package which be created which can be installed using the Software Manager or
the urpmi command. Of course, you will have to accept the proposed license agreements.
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9.8.2. Flash®

You can retrieve the Flash plugin on the Macromedia® web site (http://www.macromedia.com). Click
on the Flash Player page (within the Products page), then choose Downloads Get Flash Player and
click on the Download Now button. Extract the tar.gz file into a temporary directory (tar zxvf
install_flash_player_7_linux.tar.gz) and follow the instructions given in the included Readme.
txt file to complete the plugin installation. Test the plugin by opening the Flash web site (http://www.flash.
com) URL in the browser.

9.8.3. Real

You can get the Real plugin on the Linux Real (http://www.real.com/linux/) web site. At the time of writing,
the latest Real player available for GNU/Linux was version 10. Click on Download RPM Package. The procedure
to install it is the same as for Java.
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Using Mandrakelinux on a Daily Basis

This chapter is an introduction to the applications available under Mandrakelinux, such as file managers and
external devices.

First, we explore the office suite domain. We discuss the basic uses of OpenOffice.org placing emphasis on its
word processing (Word Processor, page 71) and spreadsheet (Spreadsheet, page 73) components.

The next section (Konqueror File Manager, page 77) discusses Konqueror which can be used to manage or share
files. You can also browse the web with Konqueror. Then we guide you through basic printing operations
(Printing and Faxing from Applications, page 80).

Multimedia applications are a must for any OS to be considered as a personal workstation. We introduce you
to the multi-format amaroK audio player (amaroK Audio Player, page 87), as well as KMix (Using the KMix
Mixer, page 90), a simple mixer. Then we’ll show you how to use popular open-source movie applications
such as Totem (Movie Applications, page 91) and how to burn music, data and even mixed data onto CDs using
K3b (CD Burning, page 93).
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10.1. Word Processor

This section will give you a brief introduction to OpenOffice.org Writer’s word processing functions.

In order to make the text a little easier to read, we will alternate
between the popular OOo acronym and the very long, yet full and
correct OpenOffice.org name.

10.1.1. OpenOffice.org Writer

OpenOffice.org Writer is the part of the OpenOffice.org suite which provides the word processing functions. Ope-
nOffice.org Writer can read most popular Office formats, easing the transition from, and ensuring compatibility
with, other Office suites.

10.1.1.1. Starting

To launch OpenOffice.org Writer, select Office→Wordprocessors→OpenOffice.org Writer from the main menu.

You can also open it from any other OOo application screen, by selecting File→New→Text Document, which
will open a blank OOo Writer document.

When you first launch OpenOffice.org Writer, a dialog will show up asking you whether you prefer to use the
Microsoft® or OpenOffice.org format to save your files.

Your decision depends on whether you plan to exchange a lot of files with people who only use Microsoft®

tools. If this is the case, click Use the Microsoft ® Word file format, but be warned that it is not perfectly
supported. Also this is only the default format and can always be overridden by changing the File type in the
Save as dialog.

10.1.1.2. Interface

Figure 10-1. OpenOffice.org Writer’s Main Window
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10.1.2. Using the Word Processor

10.1.2.1. Styles

Word processor users often waste a lot of time formatting (changing paragraph alignment, font family, weight
and size, etc.) their documents instead of using that time to concentrate on document structure and document
content writing.

Styles provide a structure-centric approach to writing documents with a word processor, while normalizing
document formatting and layout, and easily automating the generation and maintenance of table of contents
(TOC), indexes, references, etc. In OpenOffice.org Writer, styles are handled using the Stylist.

Clicking on this icon in the tool bar will open/close it. It can also be opened/closed by choosing
Format→Stylist from the menu bar, or by pressing the F11 key.

When you have a... Then apply the ... style

Chapter Title Heading 1

Section Title Heading 2

Sub-Section Title Heading 3

Sub-Subsection Title Heading 4

Paragraph Default, Text Body, First Line Indent

List Item Standard, Text Body, Text Body Indent

Table 10-1. Suggested Styles

Use the styles listed in table 10-1, as a guide. Select the region of the document to apply the style to, and in the
Stylist window, double-click on the style you want to apply to that region.

The styles you use from the Stylist automatically become available
in the styles drop-down list (the first one in the format bar), so you
have the most used styles handy.

10.1.2.2. Margins

You can always adjust margins by hand with the ruler, but if you want to format a long document, this may
not be the best solution. This is where the Stylist comes in handy.

By clicking on this icon in the Stylist, you will access the page formatting section of the Stylist. First,
make a copy of the Default style:

1. Right-click on the Default item in the Stylist.

2. Choose New from the menu which pops up.

3. Assign a Name to your new style. The Next Style field will be updated accordingly when you select it. For
the purpose of this example, Default Copy will be used as the style name.

4. Click on OK to insert your new style into the list of available styles.

Then, right-click on your newly created style item and choose Modify from the pop-up menu. The Page Styles:
Default Copy window will appear. Open the Page tab and modify the margins to your liking.

This is the same as choosing the Format→Page menu.

While looking at the Page Styles: Default Copy window, you probably noticed that you could modify many
formatting elements such as the Background, Header, Footer, etc. For example, if 90% of your work with a word
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processor consists of writing business letters with a predefined format, you could set it up right now, thereby
saving lots of time.

If you modify an existing style, you will overwrite that style’s original
settings. If you feel that you have made a mistake, simply click on
the Reset button to return to the last saved settings.

10.1.2.3. Lists

Sometimes paragraphs contain element lists, to enumerate the properties of an object (“unordered” or “bullet”
list), or the steps to be performed in order to accomplish some task, (an “ordered” or “numbered” list, for
instance).

Clicking on this button will format the selected text into an unordered list. Selecting the list items and
choosing Format→Numbering/Bullets from the menu will allow you to change the bullet type from a
predefined set.

Clicking on this button will format the selected text into an ordered list. The same rules as for unor-
dered lists apply regarding to the numbering format.

10.1.2.4. Page Headers and Footers

By default page headers and footers are common to all pages of a document. Use them to describe certain
aspects about the document’s content, for example: page number, total number of pages, chapter, section,
document’s title, etc.

Choosing Insert→Header→Default from the menu will add a page header to your document, and choosing
Insert→Footer→Default will add a page footer to your document. Just type the header/footer text you want to
be shown or use one or more of the Insert→Fields menu items to compose the header/footer.

10.1.3. Going Further

If you wish to learn more on the usage of OpenOffice.org Writer, you should consult the tutorial
available on the Tutorials for OpenOffice (http://www.tutorialsforopenoffice.org/category_index/
wordprocessing.html) Web site.

Also don’t hesitate to refer to the OpenOffice.org Writer’s help which is accessible through the Help→Contents
menu, or by pressing the F1 key. You are bound to find the answers to your questions. Topics are accessible
through a table of contents, an index is available as well, as a contextual search tool.

OpenOffice.org Writer is able to export your documents in PDF
format (choosing File→Export as PDF from the menu). This allows
you to publish your documents in the Adobe® Reader® format.

10.1.4. Conclusion

Word processing could be considered as one of the most performed actions with a personal computer. As you
have read above, OpenOffice.org Writer is a tool which not only gives you everything you need to create simple
or complex documents, but is also compatible with existing Office file formats. Enjoy creating your documents
with OpenOffice.org Writer!
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10.2. Spreadsheet

This section will give you a brief introduction to OpenOffice.org Calc’s spreadsheet functions.

We take for granted that you know why you intend to use a spreadsheet and will not delve deeply into
application-specific (accounting, financial, simulation, etc.) considerations.

10.2.1. What’s a Spreadsheet?

Spreadsheets are electronic replacements for an accountant’s ledger book and calculator. This software
uses columns and rows to allow math operations to be performed on previously entered data. Nowadays,
spreadsheets do a lot more as they are often used as (very) simple databases or as a charts and graphs appli-
cation, even though that was not the original intention of such software.

Figure 10-2. Rows, Columns and Cells

Rows are named 1, 2, etc. Columns are named A, ..., Z, AA, AB, etc. The intersection of a row and a column
is a cell, and its name is composed of the column and row attributes, for example: C3 (shown in figure 10-2).
OpenOffice.org Calc highlights the active row and column names.

10.2.2. Using the Spreadsheet

To launch OpenOffice.org Calc, select Office+Spreadsheets→OpenOffice.org Calc from the main menu.

When you first launch OpenOffice.org Calc, a dialog will show up asking you whether you prefer to use the
Microsoft® or OpenOffice.org format to save your files.

Your decision depends on whether you plan to exchange a lot of files with people who use only Microsoft®

tools. If this is the case, click Use the Microsoft® Excel file format, but be warned that it is not perfectly sup-
ported. Also note that this is only the default format and can always be overridden by changing the File type
in the Save as dialog.

OpenOffice.org Calc is an enterprise-ready spreadsheet application and includes many features way beyond
the scope of this document. Consult Going Further, page 77, for more information on how to make full use of
OpenOffice.org Calc.

The following sections will explore basic functions such as entering data and formulas in the spreadsheet and
adding graphics to represent that data. An example of an imaginary company’s monthly expenses and sales
figures will be used.

10.2.2.1. Entering Data

To enter data into a cell (either text or numbers) use the arrow keys to navigate to that cell or click in the cell
and type the data in it, pressing the Enter key when you are finished. You can also use the Tab key or the
Shift-Tab keys to move to the cell on the right or on the left, respectively.

The auto-completion feature simplifies data entry. Auto-completion “guesses” the next cell’s data using the
current cell’s value as a base. It works not only for numeric data, but also for the days of the week, the months
of the year, and others. Generally speaking, any kind of data which can be associated to a series of consecutive
integral numbers can be entered using auto-completion.
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Figure 10-3. Simplifying Data Entry Using Auto-Completion

To use auto-completion put your mouse over the cell “handle” (the little black square located at the bottom
right of the cell border), click on it and drag the cell. The cell values will be shown in a tool-tip (see figure
10-3). Once the desired final value is shown, release the mouse button and the cells will be completed.

Cell data can also be sorted according to different criteria (by column or row, depending on how you arrange
your data). To do so, first select the cells you want to sort and then open the sort options dialog choosing Data→
Sort from the menu.

Make sure you also select columns and rows which act as“headers”
for the data (in our example, the column B which contains the
months) in order for those to“follow” the sorting of the data.

In the Sort Criteria tab select the columns/rows to sort data by, and the sort order Ascending or Descending.
The Options tab contains custom sort order settings, whether to perform a case sensitive sort or not and the
direction of the sorting (top to bottom sorts data disposed in columns and left to right sorts data disposed in
rows), among others. Click on the OK button once you are satisfied with the options and the selected cells will
be sorted.

10.2.2.2. Adding Formulas

Formulas can be used to “automate” the spreadsheet allowing you, for example, to run complex simulations.
Within cells, formulas are defined by preceding all cell data with the = sign. Anything else is treated as “static”
data.

Operations are expressed using conventional algebraic notation. For example =3*A25+4*(A20+C34/B34)
divides the value in cell C34 by the value in cell B34, adds the value in A20 to the result, multiplies that by 4
and adds to 3 times the value of cell A25. Thus, rather complex expressions can be made using simpler ones
as a base.

OpenOffice.org Calc gives you many pre-defined functions which you can use in your formulas. There are date
and time, mathematical, statistical, financial, logical and many other kinds of functions available. Explore them
by invoking the AutoPilot function by choosing the Insert→Function menu or by pressing the Ctrl-F2 keys.

Under KDE the Ctrl-F2 key combination switches to desktop num-
ber two, so you might want to redefine that in order to be able
to invoke OpenOffice.org Calc’s functions wizard using a keyboard
shortcut.
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figure 10-4 shows the AVERAGE function applied to the selected range of cells to calculate their average value.
Note the use of the : character to specify a range of contiguous cells in the function.

Figure 10-4. Using a Function in a Formula

10.2.2.3. Charts: Explaining Data in a Simpler Way

When a spreadsheet contains too much information it often becomes difficult to understand how pieces of
data relate to one another: too many numbers and too little meaning. The best way to represent this kind of
data is through a chart.

As in all data-analysis functions, you must select the region you intend to show in the chart. So, select a range
of cells and then chose Insert→Chart from the menu to bring up the chart assistant.

Figure 10-5. Choosing the Chart Type

After making your selections in the first page of the chart assistant and clicking on its Next >> button, you
will see the chart-type selection page (in figure 10-5, a 3D side-by-side bar chart is chosen). Make your choices
and click on Next >> to obtain variants on the type you have selected. Again, make your choices and click on
Next >> to choose the final chart options, such as the chart’s title, axis titles, etc. Make your choices, and click
on Create to create and insert the chart in the spreadsheet (see figure 10-6).
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Figure 10-6. A 3D Chart Inside the Spreadsheet

Charts are “dynamic” in the spreadsheet which means that when
you change data in a cell belonging to a chart, the chart will be
automatically updated.

Clicking and then right-clicking on an inserted chart brings up a me-
nu showing options to change many chart parameters. For instance,
the chart’s title can be changed by double-clicking on it.

10.2.3. Going Further

If you wish to learn more on the use of OpenOffice.org Calc, you should consult the tutorial available at the Tuto-
rials for OpenOffice (http://www.tutorialsforopenoffice.org/category_index/spreadsheet.html) Web
site.

Also, don’t hesitate to refer to OpenOffice.org Calc’s help accessible through the Help→Contents menu, or by
pressing the F1 key. There you are bound to find answers to your questions. Topics are accessible through a
table of contents. An index is also available as well as a contextual search tool.

10.2.4. Conclusion

Spreadsheets simplify many accounting and other numeric-data-related tasks. They are used all over the
world, from the corner-store manager who wants to manage schedules, to the biggest accounting firms which
use them to write extensive and consistent data reports.

OpenOffice.org Calc offers extensive features for advanced users. You can use it as a simple database, or even
program complete interfaces. You can also convert formats, define templates, etc. OpenOffice.org Calc is a very
powerful application and will surely be around for quite a while.

10.3. Konqueror File Manager

File managers have grown to become multi-tasking applications, which do not only take care of basic tasks
such as copying and moving files around. In fact, with Konqueror you are able to manage your files, browse a
LAN, play MP3s, surf on the web , and more.
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In this section, we take for granted that you have used a file manager before, and that it is not necessary to
describe elementary features. We will talk about Konqueror which is KDE’s default file manager.

10.3.1. Main Window

You access your file manager by clicking on the Home icon located on the top left of your desktop.

Figure 10-7. Konqueror

The lower part of the window displays the current folder’s contents (by default, what your home directory
contains). Each file or sub-directory is represented by an icon, although you can change that view through the
View→View Mode menu . That main view may also contain a sidebar (refer to Sidebar, page 78).

10.3.2. Sidebar

A sidebar may appear on the left side of the main view. The first time you launch Konqueror you will not see
it. To show or hide it, select Window→Show Navigation Panel (or use the F9 key.

Here are short definitions of the icons in Konqueror’s sidebar:

Icon Meaning

Show Navigation Panel. This icon lets you change the sidebar view, add new folders,
and more.

Bookmarks. Where you can store your preferred web and FTP sites.

Devices. Gives you access to the CD-ROM, Floppy, and removable devices (such as
USB keys under the Hard disk entry), and Remote Shared folders, such as NFS or SMB
shares (see Allowing Users to Share Folders, page 175).

History. A list of the folders and network (web, FTP, etc.) sites you have visited
during the current session.

Home Directory. Represents your personal folder in which you organize your
personal files.

Network. Gives you access to FTP archives as well as to Mandrakelinux- and
KDE-specific web sites (of course, you can add or delete entries too).
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Icon Meaning

Root Folder. Lets you access your whole tree structure. Usually, you do not have
sufficient rights to manipulate files outside your home directory. Only the system
administrator (root) possesses the rights to do so.

Services. Gives you access to the Audio CD Browser, Devices, Fonts, the LAN Browser
and the Print System Browser.

Table 10-2. Konqueror Sidebar Icons

10.3.3. Copying, Moving, Linking and Deleting Files

Copying Files. Let’s imagine you want to copy test.png to the Documents folder. With Konqueror, you first
need to access the Window→Split View Left/Right (or press the Ctrl-Shift-L keys) menu or the Window→Split
View Top/Bottom (or press the Ctrl-Shift-T keys) menu. Your window will be duplicated and you will be able
to drag’n’drop the test.png image file into the Documents folder. Once you let go the file on the folder, a pop
up menu will ask you whether you want to move, copy or link the file.

There are many ways to manipulate files within your file mana-
ger. Drag’n’drop, keyboard shortcut combinations, opening two file
managers, etc. Choose the method you prefer (check out the Edit
menu).

Moving Files. The same principle applies to moving files around. Instead, select Move Here from the pop-up
menu once you release the file.

Linking Files. Linking files allows you to access them without actually copying them all around your
home directory. Let’s imagine one of your files is deeply buried into the /home/queen/Music/Artists/
FavoriteArtist/ directory and you want to access it quickly. Here’s how to proceed. With Konqueror simply
drag it to the desired location, release the mouse button and select Link Here.

Deleting Files. There are “safe” and “unsafe” ways to delete files. The safe way would be to move it to the
Trash, while the unsafe one would be to delete it for good directly. To delete a file, select it and press the Del
key. To restore it, double-click on the Trash icon on your desktop and drag the file(s) back into your browser.
To delete trashed files, simply Empty Trash Bin by right-clicking on the Trash icon. To delete a file directly,
right-click on it and select Delete.

10.3.4. Browsing Web Pages

If you frequently browse through directories containing HTML files, for example your distribution’s docu-
mentation, these directories generally contain a file called index.html.

Let’s take the /usr/share/doc/mandrake/en/Drakxtools-Guide.html/ directory as an example.Click on
index.html and Konqueror will display that file’s contents, and you can browse through the documentation,
as if you were on the web.

Browsing the web with Konqueror is as easy as using a “real” web browser (please see “Surfing the Web with
Firefox”, page 61). Just type in the URL of the site you want to visit in the location bar and surf.

10.3.5. File Sharing

This feature allows you to share your documents with other people on the local network and access documents
other people share. It also enables system administrators to provide users with common repositories where
everyone can add, modify and consult files.
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10.3.5.1. Sharing Files

If file sharing is activated through the Mandrakelinux Control Center (please see Allowing Users to Share Folders,
page 175) you can right-click on folders in your Konqueror window and choose Share. It allows you to share
one or as many folders as you like through NFS1 or Samba2.

10.3.5.2. Browsing Shared Files with Konqueror

For LAN browsing to work, make sure the lisa package is installed.
If not, you will have to start the lisa service after installing it.

You can browse all available shared files on the network by opening the LAN Browser section in the Services
sidebar. All machines offering shared files will appear as folders under this section. Inside the host name folder
appears one folder per protocol supported by this machine. Those may be:

FISH

This protocol relies on ssh communications. So every local machine having an ssh server running on
it will allow you to connect to it (providing proper authentication) and browse all the folders you have
access to.

NFS

Under this Remote Share folder the shares provided by UNIX® machines will be displayed (see Importing
Remote NFS Directories, page 175).

SMB

Shares provided by Windows® or SMB-enabled machines (see Importing Remote SMB Directories, page 173)
will show up under this Remote Share folder.

10.4. Printing and Faxing from Applications

Once your printer is properly installed (refer to Configuring Printers with PrinterDrake, page 123 for instructions
on printer installation) it’s time to put it to use. In the past, printing was quite an issue under GNU/Linux but
as you will soon discover, this has changed a lot. KDE applications support a simple printing method based
on a program called kprinter. kprinter can even be used to build PDF files and to send faxes.

10.4.1. Accessing KPrinter

From KDE applications, clicking on the print button or selecting File→Print will invoke kprinter directly. Make
sure you select the page range, the printing quality, the number of copies, etc., and click on the Print button.

GNOME applications have to be set up to print with kprinter. In fact, every X application which supports the
definition of its printing command (for example, Mozilla) can use kprinter. All you have to do is invoke the
print options (by typing Ctrl-P, or by selecting File+Print) then look for an option named “Print command”,
“Printer”, “Printer Options” or similar, and fill it with kprinter --stdin. This way, kprinter will be invoked
every time you ask that application to print. Then click on the Print button and you will see kprinter’s main
window (no actual document will be printed at this point).

1. NFS (Network File System) allows you to share, export or import files to or from your computer in a networked
environment. Although the NFS setup is easier than the Samba one, it can only be used within a UNIX®-based system
(like GNU/Linux). Moreover, NFS is an insecure protocol and should be used exclusively in a secure local environment.
2. SMB is a protocol by which PCs share resources such as files and printers. Windows® and GNU/Linux (through Samba)
and OS/2 operating systems, among others, support the SMB protocol. It can be considered an alternative to Netware and
NFS.
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10.4.2. KPrinter’s Interface

kprinter allows you to set many options3 for printing your documents, such as the output device (generally a
physical, local or remote printer), the number of copies, the paper size, the printer resolution, etc.

Figure 10-8. KPrinter Window

In the Printer section you can choose the printer from a pull-down list. Depending on the printing system you
use, you can also add new printers (clicking on the magic wand icon will launch a wizard to help you to do
this) and you can further configure the printer settings by clicking on the Properties button.

At the bottom of the window are buttons which allow you to Expand kprinter’s options. The System Options
button gives you access to global printing configuration. The other buttons (Help, Print, Cancel) speak for
themselves.

10.4.2.1. The Printer Section

In this section, you set the device which will receive your print job and its properties, such as page size,
resolution, etc. All the available printers are listed in the Name pull-down list. Just select the one you want to
print to.

Usually, your local printer, the “Print to file” printers (both PDF
and Postscript) and the“Fax”printer are listed. However, if you are
in a network, all printers available on the network will be listed too,
so network printing becomes very simple.

Click on the Properties button to change the device’s options. Please note that the options available will depend
on the chosen device.

3. The actual printing options you will be able to set will depend on the output device you have selected. Not all devices
have the same capabilities.
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Figure 10-9. Printer Properties Window

Most options available are self-explanatory. One worth mentioning is Pages per sheet (set to 2 in the example).
This allows you to put up to 4 pages onto a single sheet of paper (or 8 if you can print on both sides). This is a
nice feature to save paper when printing book drafts or other lengthy material which changes often.

Figure 10-10. Changing Printer Resolution

If you want to change printer-specific options such as the resolution of the printing device, you click on the
Driver Settings tab. Here you will find the Resolution option as one of the available categories. When you click
on it, the available resolutions will be displayed in the bottom part of the window. Select the one you want
from the list.

Other settings include printing modes which use much less toner or ink (search for something like “Economy
Mode”, “Toner Density” or “Toner Saving”). However, the output is much paler. If this is not available, choo-
sing a lower resolution often has similar effects.
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You can use the Save button to save the current settings for future printing jobs. Once you are satisfied with
your settings, click on OK.

10.4.2.2. Expanded Printing Dialog

After clicking on the Expand button, kprinter’s dialog changes to the one shown in figure 10-11.

Figure 10-11. More Printing Settings

In the Copies tab you have the page range settings and the number and order of the copies. Page selection can
be set to:

All

Prints all of the document’s pages.

Current

Prints only the document’s current page. This option might not be available at all times.

Range

Allows you to specify page ranges to print. You can specify pages or groups of pages separated by com-
mas: 1,2,5 prints pages 1, 2 and 5; 1-3,7,21 prints pages 1 to 3 and pages 7 and 21, 10- prints from
page 10 to the end of the document, and -3 prints the first three pages of the document).

The Page set pull-down list lets you specify pre-defined sets of pages to print (All pages, Odd pages or Even
pages). This allows you to print double-sided documents on a printer without a duplex unit: print the odd
pages, turn the stack of printed pages over and put them back into the input tray, then print the even pages.

Under the Copies section, use the little arrows to increase or decrease the number of copies or just type the
number of copies you want to print in the Copies field.
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When you are printing multiple copies, you may check the Collate check box to print the whole document
before starting to print the second copy, instead of getting all copies of page number 1, then all copies of page
number 2, and so on.

The Reverse check box makes the printing job start at the last page and end at the first one (the document is
printed “backwards”). This option is useful if your printer leaves the paper sheets face-up in the output tray.

In the Advanced options tab you may set some options concerning printing time, priority of the print job and
so on.

Click on the Collapse button to return to the “minimal” display mode of kprinter.

10.4.3. Building PDF Files

Creating a PDF file from your document is very easy with kprinter. Simply select the Print To File (PDF) special
printer, enter the file name in the Output file field as shown in figure 10-12, and click on Print. A PDF file will
be written (print.pdf in your home directory in our example).

Figure 10-12. Generating a PDF File

10.4.4. Sending Faxes

The special Send To Fax printer allows you to send the document you are working on directly by fax. When
you click on the Print button, a dialog (figure 10-13) will appear.
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Figure 10-13. Faxing Main Window

First, you need to make sure that your fax modem is properly configured. To configure your fax modem, select
Settings→Configure KdeprintFax from the menu. Fill the information under the Personal section with your name,
company and fax number. In the System section make sure that the correct faxing system and its corresponding
parameters are set. An example is shown in figure 10-14.

Figure 10-14. Fax Settings

Fill in the Fax number field and click on the Send Fax button, or press the Enter key, to send the fax
immediately.

The View Log button (Ctrl-L) will show you a window with the fax activity log (check it to make sure
your fax has been sent correctly).

The Address Book button (Ctrl-A) will open the KDE address book to let you select fax numbers to dial.

Once your fax has been sent you can quit the fax window by selecting File→Quit from the menu or pressing
Ctrl-Q keys.
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10.4.5. Handling Print Jobs

This icon appears on the KDE panel whenever you have print jobs, printing or queued. Clicking on it
will open the print queue control window.

table 10-3 lists the most important job queue control functions. Please bear in mind that, unless you have
sufficient rights, you can only control print jobs launched by yourself. You won’t have control on print jobs
launched by other users. Also note that not all buttons might be enabled at all times.

Button Function

Clicking on this button will put the currently selected print job on hold, that is it will
pause its printing.

Clicking on this button will resume printing of the currently selected paused print job,
that is it will continue its printing.

Clicking on this button will remove the currently selected print job from the queue, and
its printing will be canceled. Please bear in mind that you will not be asked for
confirmation, the job will be removed immediately.

Clicking on the “up arrow” button will increase the priority of the print job and clicking
on the “down arrow” button will decrease it. You can use these buttons to give some jobs
preference over others.

Table 10-3. Jobs Queue Control Buttons
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11.1. Audio Applications

11.1.1. amaroK Audio Player

amaroK is “the” multimedia application to use to listen to your favorite saxophone player, techno D.J. or what
not. One of amaroK’s unique features is the Context Browser. It provides you with useful information and
guides you in learning how to use it efficiently, and even makes suggestions. You can also drag and drop
music folders onto it avoiding having to go through numerous menus to listen to your favorite R&B artist. It’s
also the sexiest music player you’ve probably ever seen!

In this section we will go through its essential features. So let’s start by launching amaroK. Access the Multi-
media+Sound→Amarok sub-menu. The First-Run Wizard will be launched.

Figure 11-1. amaroK’s First-Run Wizard

After a welcome screen you will be asked whether to use the Separate player and playlist-windows (like XMMS)
(which is another multimedia player) or Single window with player and playlist functionality combined (like JuK).
Select the one you prefer.

The next screen allows you to build your music collection. Click in the folders in which you have music files.
If you’re networked with other computers and share some folders, you might want to check folders in the
/mnt directory. Of course those machines need to be powered on and file sharing must be set properly (see
Allowing Users to Share Folders, page 175). After clicking on Next and Finish amaroK’s main window will be
displayed:
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Figure 11-2. amaroK’s Main Window

If you want to add other folders to your collection access the
Settings+Configure amaroK→Collection menu. Then access the
Tools→Rescan Collection item. You can also rerun the first-run
wizard (Tools→First-Run Wizard).

Once amaroK is launched this icon will appear on the panel.
Right click on it to access some options such as Minimize and Play.

Once this is done click on the Collection icon and all your music will be listed (see figure 11-3).

Figure 11-3. Music Collection

If you added files from removable devices (such as a USB key or
an external hard drive), make sure they are mounted at the same
location as when you originally added them to your collection or
amaroK will not be able to find the files they contain.

Click on the playlist icon to access all the playlists in your collection. If you don’t have any you can
listen to the Cool-Streams which is a collection of techno streams. To build one, simply drag tunes in to the

playlist then select Playlist→Save Playlist As and give it a name. You can also click on at the bottom of
the playlist window.
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Click on this icon if you wish to transfer songs to your iPod.

Finally this icon allows you to access you local file system. You can also access your music there. As you
can see it as an alternative to using the collection.

Now let’s take a closer look at the Context Browser.

11.1.1.1. Context Browser

Figure 11-4. Using Context Information

The Context Browser is made up of tabs which display information about the music you play most frequently,
usage statistics, and more. The Home tab displays Your Favorite Tracks (which will be empty if you haven’t
used amaroK yet), Your Newest Tracks as well as your Least Played Tracks. Now click on the Current tab (see
figure 11-4).

If the album is recognized its album cover will be displayed on the upper part. You will also notice the
“brain” icon called MusicBrainz (http://www.musicbrainz.org) which is a community-driven music databa-
se. It will give you usage statistics. Then the interactive part of amaroK kicks in: it gives you suggestions on
tracks you could play from the same artist (Suggested Songs). The most played songs by that current artist are
displayed in Favorite Tracks by [Artist], and all of the current artist’s albums will be listed in the lower part of
the Context Browser.

The last tab displays the artists Lyrics. Click on a song in your playlist and then on the Lyrics tab. It will propose
a few suggestions and by clicking on the accurate title, the lyrics will be displayed in the lyrics browser.

11.1.1.2. Playing an Audio CD

To do so insert the CD in the drive and access the Actions→Play Audio CD item. The contents of the audio CD
will be displayed in the Context Browser. Select the CDA folder and drag the .cda items to the playlist to listen
to them.

You will notice that in the audiocd folder are many folders, not just the .wav files. Since amaroK is linked to
K3b (see CD Burning, page 93) it converts the .wav files on-the-fly to MP3 and Ogg Vorbis format. Let’s see
how we can make use of that functionality.

11.1.1.3. Burning Tracks with K3B through amaroK

Simply right-click on songs or music folders and choose in which format you want to burn the songs. For
individual songs amaroK will ask you to choose between Burn to CD as data or Burn to CD as audio. The
former will create a data CD which means you will be able to listen to it on your computer and your MP3
player, for example. Choosing the latter will only permit you to listen to it through a traditional CD player
which doesn’t support MP3 or Ogg Vorbis formats. For albums (or folders) you will find a pop-up menu
stating Burn All Tracks by This Artist. Once you select that option a pop-up window will appear and will ask
you to choose between audio and data formats.
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11.1.1.4. Cover Manager

In order for the album covers to be displayed in the Context Browser, amaroK provides you with a Cover
Manager. Access the Tools→Cover Manager item to launch it.

Figure 11-5. amaroK Cover Manager

To recover missing album covers, click on Fetch Missing Covers. To find covers from a specific artist, type

his/her name in the filter input box ( ).

11.1.2. Using the KMix Mixer

KMix is a sound card mixer application under KDE. It allows you to fine-tune your sound cards through
various sliders. It’s interface is shown in figure 11-6

Figure 11-6. KMix Main Window

The Output tab controls the volume levels of the sound sources of your sound card. The most important one is
the Master which controls the general volume. By right-clicking on each slider you have extra options such as
Split Channels, Muted Hide, etc. Clicking on the green dot at the top of a column will mute/unmute that sound
source.

Clicking on this icon will pop-up a slider which lets you
control the master volume, as well as mute all sound and launch
the full mixer window.

The Input tab controls the volume levels of the recording sources of your sound card. If you use videoconfe-
rencing software or are a musician this is where you will want to adjust your microphone and your auxiliary
devices. Clicking on the green dot at the top of a column will mute/unmute that recording source, while
clicking on the red dot at the bottom of a column will enable/disable recording from that source.

The Switches tab goes deeper into your sound card’s configuration. Boosting your microphone, using an exter-
nal amplifier: these features are for advanced users who wish to really master their sound system. To activate
them, simply click on the dot at the top of each column.
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Finally the horizontal slider enables you to balance your sound between the left and right speakers. Notice
that if your sound card supports separate levels for master’s right and left, the Output’s Master controllers will
be modified following the movement of the horizontal balance slider.

11.2. Movie Applications

This section discusses movie players available with Mandrakelinux. It introduces some applications, hints about
the problems you could face while using them, and suggests resources to get the best out of them.

11.2.1. Introduction

The main problem with video players under GNU/Linux is that most popular video codecs are proprietary, and
to implement them in a free software application (mainly due to the cost of licensing), the codecs have to be
reverse-engineered. This is very complex and may not be legal in some countries, which limits the availability
of such codecs, and thus the type of video files which may be displayed under GNU/Linux.

For example, it will be virtually impossible to play some compressed digital video files or DVDs without
downloading the corresponding codecs from the Internet.

In some countries, the status of the DVD playback and reverse-
engineered codecs are still under review. That is why Mandrakesoft
does not include all the plugins to use those codecs1. The infor-
mation included here is meant to help Mandrakelinux users who
know that, in their country, using these codecs and plugins is legal.
Mandrakesoft does not encourage law violation and you should
verify the law(s) that apply in your case, before you download
and use these codecs and plugins.

11.2.2. Totem

Totem is the default media player under Mandrakelinux based on Xine libraries which can play video and audio
streams and files, but we’ll concentrate on its video capabilities here. One of its nicest features is that it can be
completely controlled using the keyboard.

Double clicking on a supported video file will launch Totem, open the file, and start playing it. You can also
launch Totem by selecting the Multimedia+Video→Totem Movie Player entry from the main menu. Totem can
also be run from a terminal: type totem --help to see all available options.
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Figure 11-7. Totem’s Interface

Totem’s interface is shown in figure 11-7. It is a very simple interface composed of the following:

• Display Area. This is the area where the movie being played will be shown. Of course, you are not restricted
to watch the movie inside this little area, press the F key to switch between full-screen and windowed
modes. When in full-screen mode, moving the mouse will show the play controls at the bottom of the
screen and a button to exit full-screen mode at the top right corner.

• Position Control. Using this slider you can “jump” to any part of the movie you want to, just drag the slider
right, or press the right arrow key, to forward; drag the slider left, or press the left arrow key, to rewind.

• Volume Control. Using this slider you can adjust the volume level of the movie being played, just drag the
slider right, or press the up arrow key, to make it louder, or drag the slider left, or press the down arrow key,
to make it softer.

• Play Controls. A reduced set of the usual VCR controls: Previous (keyboard shortcut: B), Play/Pause (key-
board shortcut: P) and Next (keyboard shortcut: N).

• Status. Located at the bottom left of Totem’s window, it shows the play status of the movie (Playing, Stopped,
Paused) and the current time out of the total movie time.

All controls can be hidden/shown pressing the H key.

To play a DVD just insert the disc in the drive, Totem will be opened and the DVD title will start playing.
When playing DVDs it is recommended that you switch to full-screen mode. To eject the disc, choose Movie→
Eject from the menu, or press the Ctrl-E keys.

Use the different entries in the View menu to adjust the video view, zoom in and out, change the aspect ratio,
etc. Feel free to investigate!
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11.2.3. Other Movie Applications for Linux

Xine

Xine is one of the most interesting video application for GNU/Linux. It supports a wide range of formats
and input sources. It is fast, flexible and extensible. It is also provided as a library on which many players
are based.

MPlayer

MPlayer is yet another interesting application and supports multiple output drivers, and even older video
cards. It also supports DVD, AVI, VideoCD, amongst others. You will probably have to download and ins-
tall winDLLs and proprietary codecs to make it work with many popular video formats. On one hand this
might seem unfortunate, but on the other it gives you access to all formats supported under Windows®.

XMovie

This application is tailored to playback high resolution movies such as MPEG1, MPEG2 and AVI files. It is
not really made to playback compressed files such as Quicktime®, but does support MPEG2 streams.

Kaffeine

Kaffeine is a KDE application based on Xine libraries. Its capabilities are very similar to those of its “pa-
rent”, but it is better integrated in the KDE environment.

Finally, there are other video applications for GNU/Linux such as vlc (http://www.videolan.org/) (an MPEG2
files/streaming video and DVD player), Ogle (http://www.dtek.chalmers.se/groups/dvd/) (a DVD player
which supports menus and navigation) and RealPlayer® (http://www.real.com/) (which is proprietary soft-
ware). We encourage you to explore them as they may answer your specific needs.

11.3. CD Burning

In this section we will discuss using K3b to burn:

• a CD from an ISO image;

• a set of files to a CD;

• an audio CD (CDDA);

as well as how to duplicate a CD and erase re-writable media.

K3b also supports DVD recording, but we will concentrate on CD recording here. You only need to install the
k3b-dvd package. DVD recording is not very different to CD recording anyway, just make sure you use the
menu entries labeled DVD instead of CD.

Copyrighted Material. Please note that data/audio/video
CD/DVD copying is often forbidden by copyright law. The exam-
ples provided here are informational only and are not intended to
make a CD/DVD pirate out of you. It is assumed that if you want
to duplicate copyrighted material, it is because you have the right
to do so.
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11.3.1. Getting Started

DrakX or HardDrake should have already configured your CD-R(W) drive properly, we will show you how to
put it to use.

Usually, you need root privileges to access the CD burner. With K3b this is not true anymore since it is
automatically configured at installation time to give non-privileged users access to the CD burner. However,
it is highly recommended that non-privileged users wanting to burn CDs be part of the cdwriter group
in order to minimize burning errors due to an overloaded system. So, go ahead and add those users to the
cdwriter group. Please refer to Managing Users and Groups, page 158, for information on users and group
management.

Choosing System+Archiving+CD burning→K3b from the main menu will start K3b. figure 11-8 shows K3b’s
interface with a new data project open.

If you get a message stating that cdrdao does not run with root
privileges or that cdrdao has problems with ATAPI writers, you
can safely ignore it. To prevent that message from appearing again
put a mark on the Don’t show again check-box and click on the
Close button.

The first time K3b is run, or if you change the CD-R(W) drive, a
dialog will pop up asking you for confirmation about the burner’s
speed. Set the speed to match the fastest speed of your burner and
click the OK button.

Figure 11-8. K3b’s Interface

Tool-Bar. Where buttons to perform common actions lie. See table 11-1.

File Manager. To choose which files will be included in the burned CD. You can use the left-side tree to
navigate your file system structure and also the browser-like buttons at the bottom. The Filter pull-down list
is handy for selecting which file types are going to be shown in the File Manager. Drag and drop the files you
want to include in the project into the Project Manager.

94



Chapter 11. Audio, Movie and Video Applications

Project Manager. Where all files which will be on the burned CD are shown and handled. Files can be removed
and their location (directory) on the CD can be changed here.

The following table shows the most important buttons available in K3b’s tool-bar, their equivalent keyboard
shortcuts and a brief explanation of the functions they provide.

Not all buttons are enabled at all times. For example, the Burn CD
button will not be enabled if there is no active project.

Button Keyboard
Shortcut

Function

Create a New Project. Once you click on this button a list of available
project types will be shown: choose New Audio CD Project to create an
audio CD (see Burning Audio CDs (CDDA), page 98); choose New Data
CD Project to create a data CD (see Burning Data CDs, page 95); choose
New Mixed Mode CD Project to create a mixed mode (data+audio) CD;
choose New Video CD Project to create a digital compressed video CD;
choose New eMovix CD Project to create an eMovix
(http://movix.sourceforge.net) CD.

Ctrl-O

Open an Existing Project. A standard file dialog will be opened from
where you can choose the project you wish to open. By default, only
K3b’s project files (*.k3b) are shown. Select the project you are
interested in and click the OK button.

Ctrl-S
Save the Current Project. A standard file dialog will be opened where

you can enter the name under which the current project will be saved.
Type the name of the project and click the Save button.

Ctrl-B
Burn the Current Project to a CD. It opens a window which asks for the
project’s burn settings. Please refer to Burning Data CDs, page 95, for
more information.

Copy a CD. To make an exact copy of a CD. It opens a window which
asks for the copy settings. Please refer to Duplicating a CD, page 99, for
more information.

Erase a CD-RW. To erase re-writable media. It opens a window which
asks for the erase operation settings. Please refer to Erasing CD-RW
media, page 100, for more information.

Table 11-1. K3b’s Toolbar Buttons

11.3.2. Burning Data CDs

11.3.2.1. Burning From an ISO Image

Let us assume you have downloaded a CD-ROM image from the Internet and you want to burn it on a CD.
Choose Tools+CD→Burn CD Image... from K3b’s menu. Click the “open file” button to browse for the CD image
file and select the file in the standard open file dialog. The CD image will be verified and information about it
will be displayed (see figure 11-9).
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Figure 11-9. Burn CD Image Options

Once the image is verified, you can insert the recordable medium and click the Start button to write it to the
disc.

If an already written re-writable medium is found in the CD burner,
a dialog will pop-up asking you whether to erase it first. Click Yes
and follow subsequent instructions if you want to erase it, or change
the medium for a non-written one and click No.

The Speed pull-down list should be set to Auto to make K3b select
the fastest possible recording speed supported by the the combi-
nation of your CD burner and the currently inserted recordable
medium. The“slowest”of them limits that maximum speed.

11.3.2.2. Burning a Set of Files or Directories

Choose File→New Project→New Data CD Project from K3b’s menu (or use the New Project button or keyboard
shortcut shown in table 11-1). Then drop, into the Project Manager, the files and/or directories to be included
on the CD (see figure 11-10).
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Figure 11-10. Selecting Files/Directories to Include on the CD

Adding directories containing lots of files, can take some time, plea-
se be patient and wait until the Adding files to Project
PROJECT_NAME... message disappears from K3b’s status bar.

The space occupied by the selected files/directories will be shown by a color-coded bar at the bottom of the
Project Manager, together with the quantity expressed in MB and the available MB of the medium’s total
capacity. The bar’s color codes are as follows:

Green

The set’s size is less than that of the selected medium’s capacity (700 MB by default). There are no capacity-
related problems.

Yellow

The set’s size is nearly equal the selected medium’s capacity. If it is a few MB below the medium’s capacity,
there will be no capacity-related problems; if it is a few MB above the medium’s capacity, the CD might
be written without problems, but there is little guarantee of success.

Red

The set’s size exceeds the medium’s capacity by lots of MB. The CD will not be recorded properly.

Right-clicking on any file/directory in the Project Manager will pop-up a contextual menu with options to
remove and rename files, create new (empty) directories, etc. Files and directories can be relocated (change the
directory under which they will appear) on the CD using drag-and-drop.

Renaming the top element of the left side tree in the Project Ma-
nager will change the CD’s volume name (K3b data project
by default for data CDs).

Clicking the Burn... button (or choosing the Project→Burn menu entry) will display a window where you can
select writing parameters (see figure 11-11). Insert a recordable medium in the CD burner and then click the
Burn button to start writing the CD.
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Figure 11-11. Setting Writing Parameters

11.3.3. Burning Audio CDs (CDDA)

CD recording is not limited to data CDs, you can also record audio CDs. By audio CDs, we mean CDs that
you can play in your car or home stereo equipment, not data CDs with OGG, MP3 or any other digital audio
format files on them.

At the time of writing, K3b supports recording audio CDs from tracks digitized in the wave (*.wav), Ogg
Vorbis (*.ogg) and MP3 (*.mp3) formats. You can mix digital audio formats, K3b will decompress the com-
pressed ones on the fly. K3b can also create digital audio tracks starting from audio CDs: this task is known as
“ripping” (see Audio CD Extraction (Ripping), page 100).

Choose File→New Project→New Audio CD Project from K3b’s menu (or use the New Project button shown in
table 11-1). Select K3b’s File Manager’s filter to Sound Files, navigate to where the digitized audio files are and
then drag the audio tracks and drop them in the Project Manager (see figure 11-12).
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Figure 11-12. Selecting Audio Tracks to Include on the CD

Use drag and drop to move the files up and down the compilation. Once you have the tracks compiled in the
order you want in the Project Manager, proceed as described in Burning a Set of Files or Directories, page 96, to
write them to CD.

11.3.4. Duplicating a CD

Figure 11-13. Setting Copy CD Options
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Choose Tools+CD→Copy CD from the menu (or use the button shown in table 11-1) and a dialog will pop up
(see figure 11-13). Select the number of copies (1 in the example), whether to remove the temporary image or
not (yes in the example), the reader and burning devices (automatically set) and click the Start button to start
duplicating the CD. The “source” CD will be read, an image of it will be made and then the “target” CD will
be written.

11.3.5. Audio CD Extraction (Ripping)

The cdparanoia package must be installed to be able to rip audio CDs. Please refer to “Package Management
through Rpmdrake”, page 107 for information on package installation. Also, make sure that enough temporary
space is available: you can check the available space in K3b’s status bar near the right.

Insert the audio CD to rip tracks from and double click on the drive in K3b’s File Manager left side tree. The
CD will be read and, by default, all tracks will be marked to be ripped. Remove the check mark from those

you do not want to rip and click on gears button to show a dialog to set ripping options (see figure
11-14).

Figure 11-14. CD Ripping Options

Remove the checkmark from the Use filename pattern for ripped files option to have tracks named TrackNN.
wav and stored in the directory specified in the Destination Base Directory field (your home directory, by default)
and click the Start Ripping button to start ripping.
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11.3.6. Erasing CD-RW media

Figure 11-15. Setting CD-RW Blanking Options

You might want to format your CD-RW media in order to write it with different data. To do so, choose
Tools+CD→Erase CD-RW... from the menu (or use the button shown in table 11-1) and a dialog will pop up (see
figure 11-15). The Erase Type can be set to Fast (the CD-RW is quickly erased in up to 3 minutes); Complete (the
CD-RW is completely erased taking up to 90 minutes); and a few options related to multi-session recording.
Insert the medium on the CD burner and click the Start button to erase the CD-RW.

11.3.7. Going Further

As you can see, CD recording with Mandrakelinux is well supported with graphical programs. This section is
a kind of mini-HOWTO of CD recording for the most common tasks you might want to do. However, CD
recording uses are not limited to things described here. Please refer to the FAQ on the K3b web site (http:
//k3b.sourceforge.net) for more information.
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12.1. MCC’s Components

Mandrakelinux Control Center (MCC) is Mandrakelinux’s main configuration tool. It enables the system adminis-
trator to configure the hardware and the services used by all users. The tools accessible through the Mandrake-
linux Control Center greatly simplify the administration of the system, particularly by avoiding the use of the
“evil” command line.

You will find this icon in your window manager panel. You can also access the Mandrakelinux Control
Center through the main menu (System+Configuration→Configure your computer).

Mandrakelinux Control Center is also available from the command
line in text mode by running drakconf.

Figure 12-1. The Control Center’s Main Window

We will detail some of the available menu entries:

• Options→Display Logs. When activated this option displays a Tools Logs window. It shows all system mo-
difications made by the configuration tools launched from within the Mandrakelinux Control Center.

• Options→Expert mode. Gives you access to some of the more advanced tools, which are marked in the
table below.

• Profiles. This menu gives you access to the configuration profiles features. We cover this topic in Managing
Configuration Profiles, page 105.

• Help→Help. This will open the help browser which will display documentation about the active configura-
tion tool.

• Help→Report Bug. A window will pop up allowing you to report a bug to the development team. See The
Drakbug Reporting Tool, page 106.

The tools are sorted into categories. The following table lists all the tools it contains as well as references to the
corresponding sections of this manual.
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Boot Configuring the Login Mode, page 185

Changing your Boot-Up Configuration, page 185

Customizing your Boot Theme, page 187

Hardware Configuring your Hardware, page 117

Controlling the Graphical Configuration, page 119

Changing your Keyboard Layout, page 121

Changing your Mouse, page 122

Configuring Printers with PrinterDrake, page 123

Setting up your UPS, page 140

Mount Points Managing your Hard Drive Partitions with DiskDrake, page 169

Managing Removable Devices, page 172

Importing Remote NFS Directories, page 175

Importing Remote SMB Directories, page 173

Setting up WebDAV Mount Points, page 176. This is an experimental
utility to mount remote WebDAV directories.

Allowing Users to Share Folders, page 175

Network & Internet Network and Internet Connection Management, page 145

DrakProxy: a simple tool which allows you to configure any proxies
your computer may need to use to access the Internet.

Internet Connection Sharing, page 148

Security Securing your Machine through DrakSec, page 179. Available only in
Mandrakelinux Control Center’s expert mode.

Controlling File Permissions with DrakPerm, page 180. Available only in
Mandrakelinux Control Center’s expert mode.

Securing your Internet Access via DrakFirewall, page 182

System Customizing your Menus with MenuDrake, page 151

Display manager chooser: DrakeDM enables you to choose the X11
Display Manager for users who graphically log onto the machine.
Basically, all display managers offer the same features, it’s just a
question of taste.

Configuring Start-Up Services, page 154

Managing Available Fonts on your System with DrakFont, page 155

Setting your Machine’s Date and Time, page 156

Monitoring System Activity and Status, page 157

Console: simply opens a terminal to directly enter commands with the
administrator account (root).

Managing Users and Groups, page 158

Backing Up and Restoring your Files, page 161

DrakAuth enables you to select the authentication mode to be used to
authenticate users on your system. Available only in Mandrakelinux
Control Center’s expert mode.

Software Management “Package Management through Rpmdrake”, page 107

Table 12-1. Overview of Graphical Tools
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Another category, Server Wizards, appears if the drakwizard
package is installed. The documentation for those wizards is
available on-disk or in the Server Administration Guide. It contains
wizards which enable you to do basic configuration of common
LAN services such as web, FTP, mail and database servers.

The same happens with the Online Administration category,
which only appears if the rfbdrake package is installed. This
tool allows you to take control of a remote host (Linux/UNIX®,
Windows®).

12.2. Managing Configuration Profiles

A profile is a specific set of configuration settings suited for a computer in a given environment. Profiles allow
you to store configuration parameters specific to certain environments and to switch between them, according
to the context.

By default Mandrakelinux Control Center profiles enable you to configure network setups for different locations.
This is especially useful for laptops which need a different configuration for home, at the office, the coffee
shop, etc. It also allows you to activate different services from one profile to another (see Configuring Start-Up
Services, page 154).

12.2.1. Profiles Handling

New profiles you wish to create will be based on the active one. All modifications are automatically recorded
in the active profile. A single menu (Profiles) lets you manage them.

Figure 12-2. The Control Center Profiles Menu

New

Creates a new profile based on the active one’s settings. A dialog pops up asking for the name of the new
profile. Don’t forget to switch to that profile after creating it.

Delete

Shows a list of profiles so you can select the one to be removed. The active profile will not be shown,
because it cannot be removed while being used.

default

The entries which follow correspond to all available profiles, the active one being checked. Click on a
profile name to switch the host configuration to that profile, and you will then be asked for confirmation.

Let’s take an example. You come back home with your brand new laptop which your system administrator
configured so you can connect to your corporate network. You now want to configure the network to access
the Internet from home.

1. Create a new profile named, for example, “Home”.

2. Switch to it.
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3. Reconfigure your network so that the modem, instead of the network card, is used to access the Internet
(see Network and Internet Connection Management, page 145).

4. Connect to the Internet.

5. When back at the office, switch back to the “default” profile.

12.3. The Drakbug Reporting Tool

If you encounter unexpected behavior in Mandrakelinux-specific tools, Drakbug allows you to report it to the
development team.

To be able to report bugs using Drakbug, you need a working In-
ternet connection as well as a Drakbug account (http://bugs.
mandrakelinux.com/newuser.php).

To run Drakbug, go to the Help→Report Bug menu entry of the faulty tool, or run it from Mandrakelinux Control
Center’s own menu. Drakbug can also be triggered automatically by a crashed Mandrakelinux tool.

Figure 12-3. Reporting a Bug

In order to correctly report a bug, it is important to identify the package it is related to. To make this task easier,
enter the application name in the Application Name (or Full Path) field and click on the Find Package button.

Click on the Report button. Your web browser will then open. If you are not logged in to the Mandrakesoft
Bugzilla web site (http://qa.mandrakesoft.com/) you will be asked to log in (or create an account if you
do not have one). Once you are logged on the site, complete the bug report as completely and accurately as
possible and click on Commit.
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Mandrakelinux uses the RPM packaging system and provides convenient tools to simplify package installation
by handling software dependencies automatically. The urpmi set of tools is command line based and discussed
briefly at the end of this chapter; here we will concentrate on Rpmdrake: Mandrakelinux’s graphical software
installation tool.

Rpmdrake consists of different tools, which you access by choosing one of the entries of System+Configuration+Packaging
in the main menu or by clicking on Software Management in the Mandrakelinux Control Center (see figure 13-1).

Figure 13-1. Software Management in the Mandrakelinux Control Center

We recommend that you access Rpmdrake via the Mandrakelinux Control Center.

13.1. Install Software

When launching this tool you will have to wait a few seconds, while Rpmdrake searches the available
packages database. Then you will be presented the Software Packages Installation interface.
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Figure 13-2. The Software Packages Installation interface

The window is divided into four parts: the upper part offers you some possibilities to manipulate the list of
packages you can install. You will find this list in the middle on the left. Next to it, on the right, you have an
area where you can find a description of the currently selected package. In the bottom of the window you will
find two buttons and information about how much space will be needed to install the selected packages and
how much space you have available on your disk.

13.1.1. Selecting Packages to Install

Let us have a closer look at the interface as shown in figure 13-2. A package named “frozen-bubble-1.0.
0-7mdk” is selected in the tree-view and in the package description area you will see the required disk space,
a short summary (Frozen Bubble arcade game) and a detailed description (Full-featured, colorful animated
penguin eye candy...).

If your software medium repository is configured to use hdlist files
(not the summary synthesis files, using the full hdlist is the de-
fault option after installing your Mandrakelinux system), you may
get more information on the package by choosing the Maximum
information radio button in the access-area. In addition you will see
a list of the files provided by the package and the change log.

The status bar shows you the disk space required by the selected packages as well as the current free space.
Please note that due to dependencies, the disk space required by the selected packages might be higher than
the size required by the chosen package by itself.

Rpmdrake will show you an alert box if you try to install more
software than the free available disk space. Nevertheless you may
proceed (you may, for example, be able to remove some no longer
required files, such as programs downloaded from Internet in the
past and which you do not use anymore, to allow the installation
to continue).

Now you can begin the installation, by simply clicking on the Install button. A new window will appear,
showing you a progress bar of how your installation is proceeding. If you prefer to leave without doing
anything, you can just click on the Quit button.
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While selecting applications to install, it may happen that you choose a package which requires dependencies
(additional libraries or another tool) to work correctly. In this case Rpmdrake displays an information window
allowing you to choose whether to accept the selected dependencies, or to Cancel the operation (figure 13-3).

Figure 13-3. Rpmdrake — dependency alert box

Another possible scenario might be: you want to install a package which requires dependencies, and various
packages are capable of providing that dependency. The list of alternatives is then presented (figure 13-4).
You may read the additional information presented by clicking the Info... button to help you choose the best
alternative.

Figure 13-4. Rpmdrake — package alternatives

We will now take a closer look at the search and sort functions provided to ease your job as a system adminis-
trator.

13.1.2. Searching Packages

Sometimes you may know about some tool you saw somewhere or you heard of at a friends place, now you
wonder how to find and install them on your system.

It is really easy: just type the name, (or part of the name), in the text area next to the Search button. Then
choose, from the pull-down list, where you want to look for it (either in the package name, in the description
provided with the package or in the names of the files stored in the packages). After clicking on the Search
button, a new list will appear (Search results), showing you the results Rpmdrake found while scanning the
packages databases.

Let us take a look on the different sort orders:

Mandrakelinux choices

This sort order will show the list of packages in the four groups you saw during the installation of Man-
drakelinux. This is the easier sort order because it focuses on a selected part of the available packages, those
which are considered to be the most useful of the distribution.

All packages, alphabetical

Instead of a tree view, you will be presented with a flat list of all available packages you can install on
your system.
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All packages, by group

Here you will be shown the list of packages grouped by their functions (e.g. Games, System, Video, etc.).

All packages, by size

Here you get a list sorted by size (the biggest package at the top, the smallest at the bottom of the list).

All packages, by selection state

If you choose this presentation, you will end up with a flat list, in which all selected packages are shown
first, the other available packages below them. To make it easier for you, those two parts are sorted alpha-
betically. This sort order is particularly useful just before the actual package installation, because it helps
you to see the selection of packages to be installed.

All packages, by medium repository

Once again you will find the packages sorted alphabetically, but this time they are shown under the name
of the data medium they belong to.

All packages, by update availability

In this mode, you might get two groups of packages: a list of packages which might be added to your
machine, and a second list of the packages of which you have an older version already installed on your
computer.

13.1.3. Updating Media

When installing your system, you have been using a certain number of media (most probably CDs), containing
the packages. You may also have added remote media (figure 13-7) for which packages available may evolve
in time (it is especially the case for your Club media (http://www.mandrakeclub.com/modules.php?name=
Mirrors-list)).

Rpmdrake does not update all media each time it is run because that would take too much time, most of all
with remote media. Media update can also be performed through The Software Media Manager, page 111.

13.2. Remove Software

As this interface works like the “Install Software” one, we will not repeat its basic functions. The
only difference to the installation interface is that you will deal with the already installed packages
list from which you’ll choose those you want to remove, instead of those packages which might be

useful to install on your computer.

13.3. Mandrakelinux Update

Mandrakesoft now provides an automatic updates service; see
“Mandrakeonline Services”, page 189.

Once again: if you have already worked with the software installation interface of Rpmdrake, then
you should feel comfortable with Mandrakeupdate. But let us look at the details.

When you launch this tool, it will first ask you to choose an Internet repository to check for updates. You
should choose one in a country near you.

A small difference to the “Install Software” interface is the ability to choose which kind of update you want to
install on your computer by grouping them in certain ways. You may select Security updates, Bugfixes updates
and Normal updates.

The other difference is a new text section (Reason for update) inside the package description area. It provides
you with information about why this update was made available. This may help you decide if you want to
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update certain packages or not. When you have a slow Internet connection or you have to pay per MB when
you are downloading, it would be wise to read it.

If you are not yet familiar with the interface, please go back to Install Software, page 107 to learn about it.

13.4. The Software Media Manager

This part of Rpmdrake is dedicated to the configuration of the package media repositories. As you can
see in figure 13-5 there are some media configured: “Installation CD”, “Contrib CD”, etc. With this
tool you can add other software media: a CD from a magazine containing RPMs, a Web repository,

etc. The check boxes in the left column allow you to temporarily disable a medium: when unchecked, the
associated packages will not be taken into account for installation or upgrades.

Figure 13-5. The “Software Media Manager”

Various buttons allow you to perform actions on the selected media.

Remove

Allows you to remove a medium which you no longer use. Simply select the medium to be removed in
the list and click this button.

Edit

Here you may change the URL or the relative path to the synthesis/hdlist (if you do not know what
we are talking about it will be wise to leave this window via Cancel instead of Save changes).

In case you need to pass through a specific proxy to access this media, you can configure it here by
clicking on the Proxy... button. Note that you can also define a global proxy for all remote media through
the Proxy... button of the main interface.

This option also allows you to change from using hdlist files to synthesis files, which are much smaller
but with less information on packages. Synthesis files only have information about package names, their
dependencies and short summary, you won’t be able to search for files inside uninstalled packages, for
example, and you won’t be able to see the full description for a package if you click on its name.

Add...

Use this button to add to your system all publicly available official package sources from Internet reposi-
tories. This is useful for example if you have a fast Internet connection or only have the first installation
CD at hand. Choose a mirror geographically near to your location.
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Figure 13-6. Rpmdrake — adding a new source

After choosing a mirror and clicking the Ok, package information for the source you chose will be down-
loaded and will be available for you to install and update your system with them.

Add custom...

This button provides access to a new dialog, in which you may reference a new software package medium.

Figure 13-7. Rpmdrake — adding a Media

Update...

You will be shown a list of already defined data media. You can choose the ones where you want to
update the list of available packages in it. This is useful for remote media to which new packages are
being added. Just start the process by clicking on Update.

Manage keys...

It is important that any new packages you install are authenticated. To do so, each package can be elec-
tronically signed with a “key”, and you can allow/disallow keys on a per-medium basis. On figure 13-8,
you can see that Mandrakelinux key is allowed for medium “Installation CD”. Click on Add a key... to allow
another key for the selected medium (beware, do this with care, as with all security-related questions),
and on Remove key to remove a key from the selected medium.

112



Chapter 13. Package Management through Rpmdrake

Figure 13-8. Rpmdrake — managing keys

Proxy...

If you are sitting behind a firewall and you still need to access remote media (notably for package upda-
tes), you can do so if you have a proxy server which leads to the Internet (at least in an area where you
can find a package server). Normally it should be enough to fill in the Proxy hostname to get it working
(figure 13-9). If you need a user / password combination to get through the proxy, you can also specify
these here. Just confirm your changes by clicking on OK and you are done.

Figure 13-9. Rpmdrake — configuring a proxy

Parallel...

If you are running a large network of computers, you may want to install a package on all the computers
in parallel; this button will open a dialog window allowing the configuration of the “Parallel” mode. As
it is rather complicated and only useful to a limited group of people, this short introduction will not give
more details about it.

Global options...

This button allows you to configure the program used to download new packages and if the source should
be checked against a given key. These choices are used on all installed sources.

Up and Down arrows

These buttons allow changing the order that sources will be used when installing a package.
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Rpmdrake processes your urpmi.cfg file from top to bottom to
obtain a list of medium repositories and the packages that each
contains.

When a later medium repository contains some packages al-
so contained in an earlier repository, the packages appear only
under the later repository. If the later repository contains all the
packages from an earlier repository, the earlier repository is not
shown at all.

Thus, if your urpmi.cfg file has five data media reposito-
ries, Rpmdrake may show you only the last one if the last one
contains all the packages contained in the previous four. Re-
arranging the order of the media in the urpmi.cfg file may result
in a very different selection of media repositories being shown by
Rpmdrake, even though the same packages are available.

Either way, you won’t miss available packages, you just won’t see
the repositories listed.

As you have seen on our short trip through Rpmdrake, it is easy to manage your own system, to add new
applications or to remove something if you need more space on disk.

13.5. Package Management through the Command Line

Rpmdrake applications are merely graphical interfaces to the powerful urpmi command line tools. For those
wishing to control their packages via the command line (useful if you are working remotely, for example) we
quickly present the most useful commands. Note that most commands require root privileges.

13.5.1. Installing and Removing Packages

This is done with two simple commands:

urpmi <package_name>

Will install package package_name if it exists or the package whose name contains the package_name
string in it. If more than one package matches, you’ll be presented a numbered list of matches: just type
the number of the one you are interested in and tap Enter.

urpme <package_name>

Will remove the package package_name.

Consult the urpmi(8) and urpme(8) man pages to learn about the many options and behaviors of these two
commands.

13.5.2. Media Management

Adding and removing media is easy on the command line but the syntax must be strictly respected.

13.5.2.1. Adding New Media

urpmi.addmedia <name> <url>

This command allows you to add a new medium either from a local drive, a removable device (CD-ROM), or
from the network through the HTTP, FTP, NFS, ssh or rsync protocols. The syntax varies for each of these
methods so you are encouraged to consult the urpmi.addmedia(8) man page before using it.
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If you are declaring a new update medium, use the --update
option on your urpmi.addmedia command line.

You don’t know where to find new media containing useful ap-
plications specially packaged for your Mandrakelinux system? You
can find some at the Easy Urpmi page (http://easyurpmi.
zarb.org/). The Mandrakeclub (http://www.mandrakeclub.
com/) also provides Urpmi media (http://www.mandrakeclub.
com/modules.php?name=Mirrors-list) for test and contribution
packages.

13.5.2.2. Removing Media

urpmi.removemedia <name>

This command will simply remove the medium name. If you cannot remember the medium’s name, issuing
urpmi.removemedia alone on the command line will list all defined media.

13.5.2.3. Updating Media

urpmi.update <name>

This command will scan the named medium and update the package list associated to it. This is useful for
update media. If you wish to rescan all defined media you can simply run urpmi.update -a.

13.5.3. Tricks and Recipes

13.5.3.1. Finding the Package which Contains a Specific File

You know you need a specific file on your system but you do not know which package provides it... The urpmf
utility will scan all media and find it for you1. Just run urpmf <filename> and any package(s) which contain
it will be displayed.

You can even provide only a partial name. For example urpmf salsa will return a list of all packages which
contain a file whose name contains the salsa name in it. Please note that this will only work for media that
does not use synthesized hdlists.

[root@test queen]# urpmf salsa
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa-1.1.2.so
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.la
kaffe:/usr/lib/kaffe/lib/i386/libtritonusalsa.so

13.5.3.2. Updating Packages

This command will automatically update all the packages that need it as Mandrakeupdate would do it:

urpmi.update -a; urpmi --update --auto-select --auto

1. This is only true if you use the full hdlist files. If you use synthesis files, urpmf can only search for files on already
installed packages
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14.1. Configuring your Hardware

14.1.1. Introduction

The HardDrake project has been developed to simplify hardware detection and configuration
under GNU/Linux by providing a user-friendly interface.

14.1.1.1. What Is HardDrake?

HardDrake is a service for hardware detection, run at system boot time, and also a full GUI-based tool which
ties together many of the tools already included in a GNU/Linux distribution. It automates and simplifies the
process of installing new hardware. For the most part, HardDrake will be able to detect most devices.

On one hand, HardDrake is used to display information, and on the other, it can launch configuration tools.
With its easy-to-use interface, you can browse all the hardware your system contains.

HardDrake uses the “ldetect” engine, so if your new hardware is not detected, you may try to upgrade the
ldetect library itself and its hardware database, located in the ldetect-lst package.

14.1.1.2. Usage

To launch HardDrake, you can start it through:

• the Mandrakelinux Control Center: click on the Hardware category, and then on the Hardware icon.

• a terminal: type harddrake2 as root. You can also pass parameters to HardDrake through the command
line (type harddrake2 -h to get a list of possible parameters).

• the desktop: go to the main menu. The HardDrake entry is in the System+Configuration+Hardware→HardDrake
sub-menu.

After all devices have been detected, the main HardDrake window will appear (see figure 14-1).

On the left, you can see the device tree showing you all of the hardware categories.
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Figure 14-1. Selected Device

By selecting a device, you will see additional information about it in the right frame. To better understand
the meaning of the information presented, you can consult the help page accessible by choosing Help→Fields
description from the menu.

Depending on the device selected, two other buttons may appear:

• Configure module. This pops up a window with all the module device parameters listed. For experts only!

• Run config tool. Launches the Mandrakelinux configuration tool (available through the Mandrakelinux Control
Center) associated with that device.

A special category called Unknown/Others might also show up, containing all the currently unknown hard-
ware in your system, as well as known hardware that does not fit into the existing categories (such as thermal
sensors, random number generators, etc.).

You can also toggle the entries in the Options menu to enable automatic detection of some hardware which
wouldn’t have been detected otherwise. You need to restart HardDrake for those changes to have effect.

If you have a Mandrakeonline account and want to help us improve hardware support under Mandrakelinux, or
want to see your hardware better supported in the future, you can choose File→Upload the hardware list from
the menu and fill the form with your account data, then click on the Ok button: your hardware list will be
uploaded. You need a working Internet connection.

14.1.2. Problems/Troubleshooting

If you think you have found a bug related to HardDrake, report it using the Mandrakelinux bug reporting tool
(see The Drakbug Reporting Tool, page 106).

HardDrake does not probe for ISA PnP devices. If you have an ISA PnP sound card, run sndconfig or
alsaconf from the command line. You may need to install the sndconfig package or the alsa-utils packa-
ge.
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14.1.3. Other Information

• If you have a hard time getting your IsaPnP tools working, please check out the IsaPnPTools home page
(http://www.roestock.demon.co.uk/isapnptools).

14.2. Controlling the Graphical Configuration

This set of tools allows you to configure your graphical display. With it you will be able to change your
video card, your resolution and your monitor. It can be useful if you happen to change one of your graphical
components after the initial installation.

If you cannot boot into graphical mode and you end up in a console
(command-line interface), log in as root and launch XFdrake.
You will get a tool similar to the one described in Controlling All
Video Parameters, page 120, but in text mode.

The graphical configuration tools are accessible through different icons in the Mandrakelinux Control Center
Hardware section.

14.2.1. Changing the Monitor

Figure 14-2. Choosing a New Monitor

This tool allows you to change the monitor type currently in use. When you click on it a win-
dow pops up, listing many monitor models (see figure 14-2). If your monitor was automatically
detected it will be listed as Plug’n Play along with its model.

If your monitor wasn’t automatically detected, you can choose it from the list. If you don’t find your monitor
or a compatible one, choose one with parameters corresponding to your own monitor from the Generic entry,
at the bottom.
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14.2.2. Changing Resolution

Figure 14-3. Changing the Resolution of your Screen

This tool enables you to change the current screen resolution (800x600, 1024x768, etc.) and the
color depth. Simply choose the one you wish to use. The monitor in the window displays what
the desktop will look like with the chosen configuration (see figure 14-3). If it looks good, click on
OK.

The changes will be activated after you quit and restart your graphical environment.

By default, the available resolution list only shows resolutions supported by your video card and monitor
combination. There is a special entry named Other which adds more possible resolutions along with their
ratio. Bear in mind that most monitors are designed with a 4:3 horizontal vs. vertical ratio.

14.2.3. Controlling All Video Parameters

Figure 14-4. XFdrake Main Window
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If you happen to change your video card after installing your system, or want to have full control over the
graphic configuration, run as root, XFdrake from a console. The tool shown in figure 14-4 will be shown.

Let’s look at the interface. The first three buttons allow you to change certain aspects of the graphical configu-
ration:

Graphic Card

The button displays the name of the graphic card currently configured. If you wish to change it, just click
on it. Depending on your card, different servers may be available, with or without 3D acceleration. You
may need to try different ones until you get the best result.

In case you cannot find the graphic card you have, but you know which driver supports it, select it from
the Xorg entry at the bottom.

Monitor

Enables you to change the monitor with the tool described in Changing the Monitor, page 119.

Resolution

Enables you to change the pixel resolution and the color depth with the tool described in Changing Reso-
lution, page 119.

If you are using KDE you can also change the screen resolution on
the fly by using the Changing Screen Resolution, page 49.

Then, there are more buttons:

• Test. Click on this button to verify that your modifications actually work. It is highly recommended you do
test it, because if it does not work, it will be harder later to recover a working graphical environment. If the
test fails simply wait until it ends. If you are not satisfied with the suggested settings, choose No during the
test, and you will be returned to XFdrake’s main menu.

Depending on your video card, video testing may not be available.
You will be warned of such a situation. If it happens that the settings
are incorrect and your display does not work, refer to“Troubleshoo-
ting”, page 195“Troubleshooting”, page 195 to use XFdrake’s text
version.

• Options. You can choose to start the graphical server when your system boots. Answer No if you prefer to
have a text login. Selecting Yes will launch the graphical login manager at boot time.

• Quit. If you modified your graphical display in some way, the current configuration will be displayed and
XFdrake will ask you whether you want to keep your changes or not. This is your last chance to go back to
the old configuration. If all seems OK, click on Yes. If you wish to restore the previous parameters, click on
No.

The changes will be activated after you quit and restart your graphical environment.

14.3. Changing your Keyboard Layout

This tool allows you to define another keyboard layout. This is commonly done when the
keyboard you want to use is different from the one chosen at installation time.
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Figure 14-5. Choosing a Different Keyboard Layout

Select your keyboard’s language and its number of keys from the lists shown in figure 14-5. Changes are
effective immediately after clicking OK.

If you choose a keyboard layout based on a non-Latin alphabet,
the next dialog will ask you to choose the key binding that will
switch the keyboard configuration between the Latin and non-Latin
layouts.

14.4. Changing your Mouse

This tool enables you to set up a different mouse, which is useful if the mouse you are currently
using is not the same as the one you chose at installation time.

Figure 14-6. Choosing a Different Mouse

Mice are sorted into a tree according to their connection type and model (see figure 14-6). Highlight the mouse
of your choice and click OK. Changes take effect immediately after the mouse test is done.
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The Any PS/2 & USB mice option works with virtually all modern
mice, while the Synaptics Touchpad option works with almost every
touch pad found on notebook computers.

14.5. Configuring Printers with PrinterDrake

This tool allows you to either:

• configure a newly installed printer on your machine;

• configure your machine to act as a server for a printer which has just been connected to your local network;

• allow your machine to access network printers served by other servers (GNU/Linux as well as Windows®

ones).

If you just installed a printer that was not available when you insta-
lled Mandrakelinux, make sure it is correctly connected and powered
on before launching the configuration tool.

14.5.1. Initial Configuration

When you first launch the PrinterDrake tool, it may be in one of three states:

14.5.1.1. There is no printer directly connected to the computer.

Figure 14-7. Activate Printing

The tool did not detect any local printers. However you can print on network printers, or manually install
printers which were not detected. Press on Yes to do so.
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Figure 14-8. Activating Network Printers

• Select the Local CUPS printing system option if you wish to configure your machine to act as a print server
for either a local printer which was not detected, or a network printer connected to your local network.

Any required software will be installed and then the main configuration interface (see figure 14-10) appears.
Click on Add Printer to install the network printer.

• Select the Remote server option if you wish to be able to print on printers served by another CUPS printing
server on the network. Your applications will immediately have access to all public printers served by that
server. You only need to provide the hostname or IP address of that server in the field below (ask your
system administrator).

When this is done, the main configuration interface (see figure 14-10) appears. The Configured on other
machines tab will be filled with the available network printers.

14.5.1.2. A New Printer Has Been Detected

If a printer had already been configured previously, the new one will be installed automatically. Otherwise a
confirmation dialog will appear.

Figure 14-9. A New Printer Is Detected
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Simply confirm the automatic installation of the new printer. The main configuration interface (see figure
14-10) is then displayed. Make sure to check that the printer parameters fit your needs (see Reconfiguring an
Existing Printer, page 132).

14.5.1.3. A Printer Had Been Already Configured at System Installation Time

In this case, the main configuration interface (see figure 14-10) is shown. Make sure to check that the printer
parameters fit your needs (see Reconfiguring an Existing Printer, page 132).

14.5.2. The Printer Management Interface

Figure 14-10. Managing Printers

If your local printer has been automatically added you should now
verify its configuration. Select it in the list, click on Edit and check
the Printer options.

The printer configuration tool (see figure 14-10) has two tabs. The first one for locally connected printers
(Configured on this machine), the other one for printers available on the local network (Configured on other
machines). These are the buttons (at top) which give you access to all available maintenance tasks:

• Add Printer: launches the printer configuration wizard described in The Printer Configuration Wizard, page
127.

• Set as default: sets the selected printer as the default printer when no specific printer is chosen at print time.
A cross appears in the Def. column of that printer.

• Edit: opens the printer configuration dialog described in Reconfiguring an Existing Printer, page 132.

• Delete: removes the selected printer from the available printer pool.

• Refresh: updates the printers list with possible new or removed printers, especially true for networked prin-
ters.

• Configure CUPS: (if a local network exists) by default, your system will be totally open. It will use all of the
network’s available printers and share all of its local printers with the local network. Click on this button if
you do not want to access network printers, or if you want to restrict the access to your local printers. This
dialog will also let you configure access to servers outside the local network.
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The Options→Expert mode menu will add extra features to the
tool. See Expert Mode, page 133.

14.5.3. CUPS General Configuration

We have already mentioned that printing can be performed on printers configured on your own machine (ge-
neral home installations) or on those served by other servers (for centralized corporate printers). The Configure
CUPS button allows you to control such behavior.

Figure 14-11. CUPS Printer Server Configuration

This dialog enables you to switch between the two available printing modes: client or server, through the
Remote CUPS server and no local CUPS daemon button.

14.5.3.1. Client Mode

Figure 14-12. Client Mode Configuration

126



Chapter 14. Hardware Setup

Select the On option to connect to another printer server. You then just need to specify the name or IP address
of that server in the field below.

If you choose this mode, your printing configuration is now finished. Accept the options by clicking the OK
buttons, and you will be able to check the list of available printers in the Configured on other machines tab of
the main interface (see figure 14-10).

14.5.3.2. Server Mode

If you want your machine to access locally connected printers (through parallel or USB ports), or network
printers not already configured on another server, you need to select the Off option. Click OK, and you will
then be able to fine tune your printer server (see figure 14-11).

A number of options are available to further secure and enhance your print server features:

The printers on this machine are available to other computers

By checking this option, you allow other computers to print on printers configured locally. Remember to
restrict access by clicking on Printer sharing on hosts/networks (see below).

Automatically find available printers on remote machines

By activating this feature you will tell your print server to automatically make available all other printers
found on other servers on the local network, as if they were locally connected to your print server. This
way your system’s users will be able to print on any printer the print server “sees”, either local or remote
ones. If the remote printers you intend to use are served by a server not on your local network, you can
still tell the print server to use them with the Additional CUPS servers button (see below).

Printer sharing on hosts/networks

Clicking on this button displays a new window where you can specify which networks the local printers
should be made available to.

Additional CUPS servers

This dialog simply allows you to specify one or more CUPS servers to which we want to be able to connect
and access printers from. Specify the IP address and port of the CUPS server in the dialog which opens.

Japanese text printing mode

This option replaces the original text filter for one more suited to Japanese texts, but with less features.
Use it if you have to print Japanese text-only files.

14.5.4. The Printer Configuration Wizard

Click on Add printer and the configuration wizard will come up. To move from one step to another, click on
OK or Next. Use Cancel to abort the installation.
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14.5.4.1. Detecting a Printer

Figure 14-13. Auto-Detecting Printers

The first screen allows you to enable the auto-detection of locally connected printers, network printers, and
finally printers served by SMB (Windows®) servers. First try to activate auto-detection for the printer types
you are looking for. The next step will show which printer(s) was/were detected. If the one you want to set
up is listed, select it, click on OK, confirm the printer model, and proceed with Printer Test, page 131. If the
detected printer is not the correct one check the Manual configuration box and proceed with the printer model
step (see figure 14-18). If auto-detection fails, remove the check mark from all check boxes, click on Next and
follow the instructions below.
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14.5.4.2. Printer Port, Type, Name and Model

Figure 14-14. The Printer Port

First, you need to determine which port your printer is connected to: either a parallel or a USB port.

Figure 14-15. Multi-Function Device

You will then be asked whether your printer is a multi-function device from HP or Sony. If so, additional
packages will be installed on your system and you will be told how to scan and access photo memory cards
with your device.
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Figure 14-16. Choosing the Printer Model

Next the list of supported printers is displayed. It is a tree view with the manufacturer’s name first and then
the printer models. Select the printer you have or a compatible one (see figure 14-16) if yours is not specifically
listed.

If you want to install the driver supplied by your printer manufacturer, click on the Install a manufacturer-
supplied PPD file button and select the medium containing the PPD file and browse to it. Accept subsequent
dialogs to use your chosen PPD file.

14.5.4.3. Print Options

Figure 14-17. Configuring the Printer’s Options

After that, the options associated with the chosen printer will be shown (see figure 14-17). It is important you
choose the proper settings (such as paper size, media source, etc.) currently installed on the printer. If the
settings you choose are not correct, printing may fail.
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For settings referring to printout quality, bear in mind that higher
quality levels may make the printing operation slower and may con-
sume more ink.

14.5.4.4. Printer Name

Figure 14-18. Choosing a Name for your Printer

You must now provide a name for your printer to easily identify it. Optionally, you can also supply a Printer
description and a physical Location (see figure 14-18).

The printer name must contain only letters, numbers and the un-
derscore“_”character. Also it is better to limit its length to 12 cha-
racters maximum so that Windows® clients don’t have problems
when accessing it through Samba.

If you already have one or more configured printers, you will be
asked whether the printer you are configuring will be the default
printer for applications on your system. If you say No, the previous
default printer will be retained.
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14.5.4.5. Printer Test

Figure 14-19. Testing the Printer

Finally, you will be asked whether or not you want to test the printer. Two test pages are available (see figure
14-19) so you can adjust the parameters according to your needs. It is advisable to print at least one test page
so you can immediately correct the parameters if something goes wrong. The printer should begin to print
almost immediately.

14.5.4.6. It’s Done

Congratulations, you are ready to print! If you are not satisfied with your test page, answer the appropriate
question with No and you will be led to the printer configuration menu (see figure 14-20) in order to correct
the settings. See Reconfiguring an Existing Printer, page 132.

Your printer will now appear in the list of available printers in the main window (see figure 14-10).

14.5.5. Reconfiguring an Existing Printer

Double-clicking on a printer’s name in the list, or clicking on the Edit button, displays a menu where you can
choose actions to take on the selected printer (figure 14-20). Each option gives access to a particular step of
the wizard we described above (see The Printer Configuration Wizard, page 127). One difference will be that the
current settings will be predefined in all fields, and you may update them where required.
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Figure 14-20. Modifying an Existing Printer

There are a few additional options:

1. Disable printer. Use this option to remove that printer from the printers available to the system’s users.
You might need to temporarily disable a printer under maintenance so that users don’t try to use it in the
meantime. When a printer is disabled, that option changes to Enable printer.

2. Learn how to use this printer. Displays information on how to use a particular printer model. In the case
of a multi-function device from HP, information about scanning and photo memory card access is also
displayed.

3. Remove printer. Use this option to delete that printer’s configuration from the system.

Select an action in the dialog and then click on the Do it! button to perform it.

14.5.6. Expert Mode

The expert mode has three additional features:

• Choose a Different Driver to the Default One for a Printer. Different drivers are available for the same
printer. In expert mode, a third level appears in the printer model selection list (see figure 14-16). It allows
you to change each printer’s driver.

• Install Many Kinds of Remote Printers. This feature enables you to print on remote printers using the LPD
protocol, printers on Windows® servers which require authorization, or other arbitrary printer types.

If PrinterDrake is in expert mode, it does not automatically confi-
gure new local printers on start-up. Use the Add printer button to
configure the printer.

If you start the new printer wizard in expert mode, there is an additional step at the beginning.
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Figure 14-21. Configuring a Remote Printer

Different connection types are available:

• Local printer. A printer directly connected to a parallel or USB port on your computer. In most cases, the
printer model will be auto-detected.

• Printer on remote lpd server. A printer already served by another machine on a lpd server.

• Network printer (TCP/socket). A printer directly connected to your local network. The network can be scan-
ned and printer models automatically detected provided the Printer auto-detection box is checked.

• Printer on SMB/Windows 95/98/NT server. Relevant for printers already connected to a computer running
an OS which serves printers with the SMB protocol, including Samba printers (the necessary Samba compo-
nents will be automatically installed in this case). The network can be scanned provided the Printer auto-
detection box is checked.

• Enter a printer device URI. This option allows you to directly enter the printer’s Universal Resource Identifier
(URI) on your network. It can be used for any of the above remote connections, and more. This is useful
when your system administrator provides you directly with the printer’s URI.

Click on the Modify timeout for network printer auto-detection button to change the default timeout (4000 milli-
seconds, or 4 seconds) for detection of networked printers. Please bear in mind that the bigger the timeout, the
better the chances of detecting remote printers. However the auto-detection process will also take more time.

14.6. Installing and Using Scanners

This section will explain how to install a scanner through ScannerDrake, and how to use it with SANE and
XSane (scanner interface software). We will also present a list of other scanner interface software you could
use with GNU/Linux.

Please note that while support for scanners is very good, not
all scanners are supported under GNU/Linux: before buying new
hardware, it is always a good idea to visit Mandrakesoft’s Hard-
ware Database (http://www.mandrakelinux.com/en/hardware.
php3) and the SANE home page (http://www.sane-project.
org/) to check for compatibility issues.
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14.6.1. Configuring your Scanner

14.6.1.1. ScannerDrake

ScannerDrake is the Mandrakelinux scanner detection and configuration tool. This wizard will help you
install your scanner. Make sure your scanner is powered on and launch ScannerDrake by clicking on the Scan-
ners entry of the Mandrakelinux Control Center’s Hardware section. You will first be prompted to install some
necessary software, simply click on Yes.

The program will try to detect the manufacturer and model of your scanner. If it finds one which is ready to
use it will show some information about it in the upper part of the wizard’s main window. If the detection
failed and no scanners were identified, you will be shown this window:

Figure 14-22. Install your Scanner with ScannerDrake

You can try to perform a new search by clicking on Search for new scanners, which is useful if you have just
plugged a scanner in. If the automatic detection fails, click on Add a scanner manually and look for the specific
model you own by first expanding the manufacturer’s section, then browsing through the list of available
models.

Figure 14-23. The Tree-list of All Known Scanner Models

After choosing the appropriate model, you can leave the default Auto-detect available ports option and click on
OK. If you have a parallel port scanner, selecting /dev/parport0 in the pull-down list should be the right
choice.
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Figure 14-24. Specifying the Connection Type

Your scanner should now be installed and you should be ready to use the programs which come with SANE,
XSane or other acquisition software.

Note that HP multi-function devices, such as the OfficeJet and PSC
printers, must be configured through PrinterDrake. Please refer to
Configuring Printers with PrinterDrake, page 123. The scanning
part of non-HP multi-function devices can be set up with Scanner-
Drake as a stand-alone scanner.

To test that everything works correctly, launch xscanimage1 from a terminal and try to acquire a picture from
your scanner. You may first acquire a preview of the scanned image by clicking on the Preview window button,
as shown in figure 14-25.

Figure 14-25. Acquiring Images with xscanimage

Note that xscanimage may also be invoked directly from GIMP by choosing File+Acquire+xscanimage→Device
dialog from the program menu.

ScannerDrake allows for scanner sharing between users connected via a LAN. Installation is very easy: just
click on Scanner sharing and either select The scanners on this machine are available to other computers or Use
scanners on remote computers depending on what you want to do. With these buttons you can define which
machines are allowed to use your scanners and which remote scanners you want to use.

1. The sane-frontends package must be installed.
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Figure 14-26. Sharing Scanners within a LAN

In order to share your scanner on your LAN, the saned package
needs to be installed. If it isn’t, ScannerDrake will ask you if you
want to install it. You also need to set up scanner sharing on the
machines from which you want to access the scanner. Check the
Use scanners on remote computers box, and then click on Add host.
Fill in the information in the Name/IP address of host field for each
of the machines which scanners.

14.6.2. Using Image Acquisition Software

14.6.2.1. XSane

While xscanimage is more than enough for your basic scanning needs, more experienced and/or graphic-
oriented users will want to use a more sophisticated program. XSane2 offers more options and a more infor-
mative display during the image acquisition process.

You can launch XSane through the Multimedia+Graphics→X Sane menu item. You’ll see several windows pop
up on the screen.

2. The xsane package must be installed.
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Figure 14-27. XSane Multiple Windows

If the package xsane-gimp is installed, you will have a GIMP plugin at your disposal. It will allow you to
import your images directly into GIMP for image retouching tasks. To do this, simply choose File+Acquire →
XSane: device dialog to launch XSane. You can now scan your image and have it sent directly to GIMP.

14.6.3. Advanced Configuration

14.6.3.1. Fine-Tuning the Resolution

Most modern scanners boast high resolutions, such as 1200, 1600 or 2400 DPI (Dots Per Inch). But it would be
a mistake to perform all of your scanning at the maximum available resolution. You will notice very little —
if any — quality difference between a 300 and a 600 DPI image scan, but the file size will grow exponentially,
up to many MBs of disk space for a single image file.

The resolution value should be chosen according to the device on which the image will be reproduced. For
images to be viewed on computer monitors, e.g. for web sites, the resolution should be close to typical mo-
nitor resolution values, between 70 and 100 DPI. Higher values will result not only in bigger images, but the
dimensions will also increase, so that an image scanned at 160 DPI instead of 80 will be about twice as large3.

If you intend to print your images, a resolution of 300 DPI should be enough for most home printers. Increase
this value if you have a very high quality printer.

Higher values should be chosen only for specific uses, such as enlarged images on very high quality printers,
or quality scans of black and white originals. You will have to experiment a little until you’re satisfied with
the results.

14.6.3.2. OCR Software

By installing the kdegraphics-kooka and ocrad packages, you’ll be able to use Kooka, a simple graphical
front-end to SANE which is also able to perform OCR tasks. To launch it, choose Multimedia+Graphics→Kooka
from the main menu.

First you will be asked to choose the scanning device and then Kooka’s main window will appear.

3. However, scanning at a higher resolution, and then reducing the resulting image size using graphic manipulation soft-
ware such as GIMP, is one method often used to obtain better results than directly scanning at the desired final resolution.
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Figure 14-28. Kooka’s Main Window

figure 14-28 shows a screen shot of a scanned image. To do so place the image or book you want to scan onto
your scanner and click on Preview Scan at the bottom left of Kooka’s window. For better results, you should
choose the Grayscale Scan mode. Then adjust the resolution (200 DPI should be enough), select the part of the
image to be scanned and click on Final Scan.

To benefit from Kooka’s OCR features, you must configure it. Access the Settings→Configure Kooka menu, click
on OCR, and select the OCR engine you want to use.

Figure 14-29. Kooka’s Configuration Window

Once this is done you can click on this icon (Image→OCR Image) and click on Start OCR. The resulting
text will appear along with a spell correction window.

Kooka is still in beta phase. Although it’s possible to make it work
properly you will need to adjust its parameters until you obtain a
decent rendering. For more information on Kooka please read it’s
handbook (Help→Kooka Handbook).
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14.6.4. Other Scanner Interface Software

Here is a list of other scanner interface software which is known to work under GNU/Linux.

• Unfortunately, OCR (Optical Character Recognition) programs are not as common or sophisticated as their
image acquisition counterparts. However there are at least two programs which are mature enough: Clara
OCR (http://www.claraocr.org/) and GOCR (http://jocr.sourceforge.net/). You’ll find all the neces-
sary packages on the Mandrakelinux CDs.

Clara’s graphical interface is very simple and doesn’t require a specific desktop environment, but it will be
necessary to train the program on the scan of a sample page. The training process can be quite tedious, and
not very intuitive for the new user4, so be sure to read the tutorial file. More experienced users should also
refer to its Advanced User’s Manual.

• GOCR is another project which has reached a usable status, but bear in mind that it is still beta software.
GOCR can read images in many formats, and will produce a simple text file as its output. It’s a command-
line tool, so if you want to use a graphical front-end you will need to install the gocr-gtk package, although
some image capture applications such as XSane offer limited OCR capabilities through it. You can launch it
through the Multimedia+Graphics→Gtk-ocr sub-menu.

• Users of the FLTK (“Fast Light Tool Kit”) graphic user interface could try FlScan (http://freshmeat.net/
projects/flscan/), a FLTK front-end for SANE.

• For EPSON scanners, you could download Image Scan! for Linux (http://www.epkowa.co.jp/english/
linux_e/index.html), a scanner utility provided free of charge to GNU/Linux users by EPSON KOWA Cor-
poration.

• While multi-functional HP devices are configured using PrinterDrake, owners of these devices should have
a look at the HP Linux Inkjet Project (http://hpinkjet.sourceforge.net/). The developers involved in
the project aim at providing GNU/Linux support for most Hewlett-Packard OfficeJet, PSC, LaserJet, and
PhotoSmart printer multi-function peripherals (MFPs).

14.7. Setting up your UPS

The role of a UPS (Uninterruptable Power System) is to provide you with electrical power whatever
happens. Say there’s a power outage in your area, the UPS will enable you to continue working for a certain
amount of time due to its battery (up to 10 minutes usually depending on the model). Its main function,
however, is to allow you to save your data and to cleanly close your machine, minimizing and even avoiding
data corruption and loss.

To launch the DrakUPS utility, open the Mandrakelinux Control Center in the hardware section and click on Set
up a UPS for power monitoring.

The nut-server (“nut” standing for Network UPS Tool) package
needs to be installed.

4. To quote the authors: “Clara OCR is not simple to use. A basic knowledge about how it works is required for using it”.
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Figure 14-30. DrakUPS Set Up

Next you will be asked to whether you wish for DrakUPS to autodetect your UPS or to manually configure it.
First try with auto-detection. If all goes well you should get a congratulation message.

Figure 14-31. Successful Auto-detection

If it doesn’t work try to do it manually.
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Figure 14-32. DrakUPS Manual Configuration

The next step is to choose your UPS model. Select the most appropriate one in the list of manufacturers and
models.

Figure 14-33. Selecting the Manufacturer and Model

Then DrakUPS will display some fields for you to fill. Assign a Name, Driver, and Port5.

5. The Name and Driver fields should automatically be filled. Of course, you can change its name but we recommend you
keep the driver name.
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Figure 14-34. Name, Device and Port Names

If all went well your UPS should now be configured and ready to help avoid bad power outage surprises.
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Chapter 15. Setting up your Network and Accessing the Web

15.1. Network and Internet Connection Management

Before connecting to the Internet, you are encouraged to set up a
firewall on your machine so as to avoid bad surprises such as intru-
sions on your system. You can set up a very simple, yet effective,
firewall using DrakFirewall (please refer to Securing your Internet
Access via DrakFirewall , page 182, for more information).

Your Mandrakelinux system contains a tool which allows you to easily configure your network access, whether
it be to the Internet or to a local network. To launch drakconnect, first open Mandrakelinux Control Center
and select the Network & Internet section. Here, a few tools enable you to configure and maintain network
connections. A view of the main interface is shown in figure 15-1. We describe the Internet connection sharing
tool in Internet Connection Sharing, page 148.

Figure 15-1. DrakConnect Tools

15.1.1. New Connection

This tool allows you to set up a new network connection. drakconnect supports different types of
Internet and network connections. The first step consists in choosing which type of connection
you wish to configure. Always make sure you have all the information provided by your ISP or
network administrator at hand.

15.1.1.1. Modem Connection

Select the Modem connection type and continue to the next step. A list of detected modems is shown. If the
modem you wish to configure isn’t automatically detected, select the Manual choice box and then the commu-
nications port the modem is connected to. The required packages will be installed.

You will then see a list of countries/ISPs;. If yours is listed select it and continue to the next step: some para-
meters (connection name, phone number to dial, and authentication scheme) will be automatically set. Verify
them, add the missing ones and accept them. If yours is not listed, select the Unlisted - edit manually option,
click on Next and fill the parameters with the settings provided by your ISP (see figure 15-2).
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Figure 15-2. Entering Dial-up Connection Parameters

All parameters should be obvious, except for the authentication type. The value in the Authentication pull-
down depends on what your ISP supports: Script-based (an old type of authentication method based on “ex-
pect” and “send” types of chat between your system and your ISP); Terminal based (a terminal window will
pop up when the connection is made and you will have to login interactively); PAP, CHAP, or PAP/CHAP
(authentication information exchange protocols, CHAP is preferred because it is more secure, PAP/CHAP will
automatically choose the supported one).

Then come the IP, DNS and gateway settings. Nowadays, most ISPs provide them automatically when a
connection is made, so selecting the Automatic option on them is usually a safe bet. You will then be asked
whether you wish to allow users to start the connection. The safest choice is No. Otherwise any user will be
able to take the link down, therefore disconnecting every other user.

During the next step you will be asked whether to start the connection at boot time or not: it is probably safer
and cheaper to choose No. Finally you will be asked to test the connection: we recommend you to do so to
make sure all parameters are accurate. You can now control your Internet connection using the kppp remote
access connection dialer through the main menu: Internet+Remote Access→KPPP.

15.1.1.2. LAN Connection

Select the LAN connection type and continue to the next step. Your NICs will be detected automatically; if you
have more than one, you will have to select the one you wish to configure. You can also load a driver for your
NIC manually.

Then, you will have to specify if the network parameters will be automatically set up (Automatic IP
(BOOTP/DHCP)) or not (Manual configuration): fill the next steps with the parameters which your ISP or net-
work administrator gave you.

Check the Network Hotplugging box to have your network brought
up and down automatically when you connect and disconnect the
network cable. This is specially handy for laptop users.

If you configure the network with DHCP you can optionally provide the machine’s hostname. Then you can
supply the Zeroconf hostname: this is the name which will be assigned to the machine when the network link
is not active (meaning the cable was disconnected when the network service was brought up).

Finally, the wizard will ask you to restart your network to activate the changes.

After the configuration is done, you can bring the network connection up or down as described in Monitoring
Connections, page 148. Please bear in mind that LAN connection types are set up to always be started at boot
time.
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An applet will appear in the desktop’s panel indicating that the
connection is up (

) or down (

). Right click on it to access a menu that will also let you
control the connection’s state as well as other parameters.

15.1.2. Internet Access

Figure 15-3. Configuring the Internet Access

This tool allows you to specify Internet access parameters if they need to be modified after your
initial configuration. Please bear in mind that these parameters are system-wide and apply to all
interfaces. If needed, the gateway address may be modified as described in Managing Connections,
page 147.

15.1.3. Managing Connections

Figure 15-4. Manage Network Connections
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This tool permits you to modify network interface-specific parameters. Use the drop-down list at
the top to select the interface you want to configure. The tabs allow you to change parameters and
options according to the network interface type selected for configuration.

15.1.4. Monitoring Connections

Figure 15-5. Real-Time Network Connection Monitoring

This tool shows the network interfaces activity. You can specify some options for the traffic graphic
and statistics: update interval, scale, etc (see figure 15-5). It can also be used to control the status
of the network connection, bringing it up or down using the button at the lower left.

15.1.5. Removing a Connection

This tool simply enables you to remove a network interface. Select the interface to be removed in
the Net Device pull-down list.

You will not be asked for confirmation. Once an interface is selected
for removal, pressing the Next button deletes it at once.

15.1.6. Proxy Settings

This tool allows you to define the hostnames or IP addresses of proxies for the FTP and HTTP
protocols your computer will use. Fill the fields with the required values and click OK.

A proxy is a server which retrieves information from the Internet on your behalf, keeping a local copy of
the web pages which are most frequently requested. They are referred to as “caching proxies”, and optimize
bandwidth usage. In some organizations, you cannot access the Internet directly. You must pass through a
proxy which authenticates you before allowing you to connect to the Internet. This is usually combined with a
firewall which only guarantees the proxy direct access to the Internet. They are referred to as “authentication
proxies”. In corporate or business environments, proxies perform both caching and authentication functions
for performance and security reasons.
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15.2. Internet Connection Sharing

This tool configures your system so that it acts as a gateway to the Internet for other machines
connected to it via a LAN. In order for your machine to do this, you will need an already
configured and working connection to the Internet and a network connection to your LAN.
This implies at least two interfaces, for example, a modem and an Ethernet card.

This wizard will also configure a firewall to block most connections
from the Internet. You are encouraged to check that the firewall
configuration suits you after completing the wizard.

After you complete this wizard, all computers on the LAN will be able to access the Internet. Their configura-
tion will be automated due to the DHCP server which will be installed on your gateway, and the web access
will be optimized due to the use of the Squid transparent proxy cache.

1. Choosing the Internet Interface

You first need to specify the name of the interface connected to the Internet. Make sure you select the
correct one: use the examples in the on-line help as a guide.

2. Choosing The LAN Network Adapter

If you have more than one Ethernet interface, and depending on what you chose as your Internet interface,
the wizard might ask you to select the one connected to your LAN. Make sure you select the correct one.
Note that all traffic to and from this network passing through the gateway will be masqueraded, that is: it
will appear to come from the gateway instead of from the LAN.

3. Configuring the LAN Interface

At this point, if it is the 1st time the system has been configured as a gateway, the wizard will automatically
install and set up all the software needed for the gateway to function properly.

Otherwise, the wizard will first offer to reconfigure the LAN interface so that it will be compatible with
the gateway services. It is recommended that you leave the default options and click on Next. Then, all the
software needed will be installed.

Configuring the Clients

A DHCP server has been installed on the machine. By configuring the clients on the local network to use
DHCP, they will automatically use the Mandrakelinux machine as a gateway to the Internet. This works for
Windows®, GNU/Linux and any other OS which supports DHCP.

For example, on a Mandrakelinux client system, make sure you selected DHCP in the Protocol pull-down list
when configuring the network as shown in figure 15-6.
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Figure 15-6. Configuring a Client to Use DHCP
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16.1. Customizing your Menus with MenuDrake

In order to help you manage the main menu of your preferred graphical interface, Mandrake-
linux provides you with a menu editor which ensures menus from all desktop environments
(such as KDE or GNOME) are coherent.

This tool allows system administrators to control the menus for all users (the system menu) but can also be
utilized by users to personalize their own menus. You can launch MenuDrake from the Mandrakelinux Control
Center or from the System+Configuration+Other→Menudrake menu entry.

Figure 16-1. Launching MenuDrake in System or User Mode

If started by root, MenuDrake can be used in two different modes: either changing menus for all users, or
customizing the menus for user root. You will be able to switch from within the application thereafter, but
for now, click on:

• System menu to make changes to menus available for all system users;

• Root menu to customize the menus for the root user only.

When you launch MenuDrake, it first scans your current menu structure and displays it. The main window (see
figure 16-2) is divided in two parts: the menu itself on the left, and a form relative to the highlighted menu
item on the right.
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Figure 16-2. MenuDrake’s Main Window

You can click on the tree’s [+] signs to view the content of the related sub-menus, and on [-] to hide them.

In your tree you may see entries which do not appear in your actual
menu. These are empty directories which are not displayed but can
be used for future applications which you may wish to install.

16.1.1. Adding a New Menu Entry

This should seldom happen as all Mandrakelinux graphical applications should provide a menu entry. However
if you want to add a menu entry for a package you compiled yourself, or for a console mode program, use this
function. Let’s suppose you want to run the top command in a terminal window to view running processes
and the utilization of system resources through a menu entry in the System→Monitoring menu.

Select the System→Monitoring entry, and click on the tool bar’s Add application button. A dialog will appear
asking you for the title of the menu entry and the command associated with it.

Figure 16-3. Adding a New Menu Entry

Edit the title (you could insert “Table Of Processes”) to be shown in the menu. Then you need to provide the
action the system should execute in the Command field: top. Click on OK and the entry will be added to the
menu tree.

You can also choose an icon for your entry from the list which appears once you click the icon button itself.
The new entry is shown in figure 16-4. Do not forget to check the Open in a terminal box to have the program
run in a terminal window.
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Figure 16-4. A New Menu Entry with MenuDrake

While modifying your menus, you might make a big mess out of
them... Remember that you can reload the menus as you last saved
them by pressing the Ctrl-R keys (or accessing the File→Reload
user config sub-menu). You can also revert to the default menus by
accessing the File→Reload system menu sub-menu.

Finally to activate your modifications, click on the Save button and that’s it. Congratulations! You can now test
your new settings by accessing the main menu.

Depending on the graphical interface you are using, the changes to
your menu may not be shown immediately. In some cases, you may
need to log out and back in again for the changes to take effect.

16.1.2. Advanced Features

16.1.2.1. Different Menu Styles

Depending on the experience the users working with your machine have, you may want to provide them with
different menu styles. Mandrakelinux provides a few template menus which you can eventually customize.
They are available through the main window’s Menu Style button.

Figure 16-5. Choosing a Menu Style

Choose one of the available options:
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• Use system administrator settings. If you started MenuDrake as a simple user, you can choose to set your
personal menu style to use the menus prepared by the system’s administrator.

• All applications. This is the traditional menu shipped with Mandrakelinux and it contains nearly all the
available applications, sorted into functional categories.

• What to do? Specifically designed by our ergonomics team, this menu provides a fast access to most com-
mon applications sorted by usage, such as Play a game, Use the Internet, etc.

• Original menu. These are the plain menus as provided by the KDE or GNOME desktops. This menu probably
lacks some applications.

When you have chosen a menu style, click on OK. You will then be able to see the corresponding menu
structure in the main window, and you can then customize it.

16.1.2.2. About the Environment Menu

The entry we have just added to the menu is now available in the active graphical manager menu. It is also
possible to make modifications to all graphical manager menus by choosing Environment→All environments.

All entries which only apply to the active graphical environment appear in blue in the tree structure on the
left.

16.1.2.3. Moving and Removing Entries

MenuDrake entries support the drag-and-drop feature. Similarly, you may have noticed that whenever you
remove an application from the menu, it appears in the “attic”, that is the Available applications list on the
bottom right corner. If you ever wish to add them again, you simply have to drag them to the desired place in
the menu tree.

16.2. Configuring Start-Up Services

At boot time, the system starts a number of services (programs running in background to per-
form a variety of tasks). This tool gives the administrator control over those services. See the
The Start-Up Files: init sysv chapter of the Reference Manual for more information.
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Figure 16-6. Choosing the Services Available at Boot Time

For each service, this is the list of items found in each column:

• Service name;

• Current Status: either running or stopped;

• Info: click on this button to get a little explanation about that service;

• On Boot: check this box if you wish this service to be automatically brought up at boot time1. Alternatively,
if xinetd is installed and the service is a xinetd service, the label Start when requested will be displayed.
Checking the box will then mean to activate that service in xinetd. You will also have to make sure that the
xinetd service itself is activated.

• Start: immediately starts the service, or restarts it (stop+start) if it is already running;

• Stop: immediately stops the service.

For both the Start and Stop buttons, a tool tip will show you the status of the operation.

16.3. Managing Available Fonts on your System with DrakFont

This tool enables you to review the different font families, styles, and sizes available on your
system. It also allows the system administrator to install new fonts.

The main window (see figure 16-7) shows a visual appearance of the currently selected font combination.

1. Generally in runlevels 3 and 5.
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Figure 16-7. DrakFont’s Main Window

drakfont is made up of a number of windows which are accessible through the buttons located at the bottom-
left corner.

Options

Allows you to specify which applications and devices (such as printers) will support the fonts. Select the
ones you want support for and click on the OK button.

Uninstall

Allows you to remove installed fonts, in order to save space for example. Use this with great care, it could
have side effects on your applications. You should notably not remove fonts you did not install yourself.

Import

Allows you to manually add fonts found outside the Mandrakelinux distribution, on a local Windows®

installation or from the Internet, for example. Supported font types are ttf, pfa, pfb, pcf, pfm, gsf.
Clicking on the Add button will open a standard dialog allowing you to specify the font file to import.
Once you’ve specified all the fonts you want to import, click on the Install fonts button.

To select more than one font, double-click on the first font you wish
to select and it will be added to the Import Fonts window. Then
double-click the other fonts you wish to install and the same action
will occur. When you are done click on the Close button and then
on the Install fonts button. Once the installation operation is done,
make sure the new fonts appear in the Family list.

16.4. Setting your Machine’s Date and Time

This little tool enables you to set your system’s correct internal date and time.
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Figure 16-8. Changing Date and Time

You can set the date on the left and the time on the right:

• To change the year, click on the little arrows on each side of the year; same procedure to change the month.
This updates the month view where you can click on the current day in order to highlight it.

• We recommended that you check the time-zone settings for your geographical location. Click on the Change
Time Zone button and select the correct place in the tree view.

Once you’ve chosen the time zone, a dialog will appear asking you whether your hardware clock is set to
GMT. Answer Yes if only GNU/Linux is installed on your machine, No otherwise.

• To change the time, you can either move the hour, minute and second hands of the analog clock, or change
the numbers below it.

• If you have a permanent Internet connection and want your system to synchronize its internal clock with
time servers on the Internet, put a check mark in the Enable Network Time Protocol option and select a server
in the Server pull-down list.

The NTP (Network Time Protocol) package needs to be installed.
If it isn’t, a dialog will pop up and ask you whether you wish to
install it.

If you select the pool.ntp.org server, NTP will automatically
choose the server nearest to the time zone you selected.

When you’re finished, click on OK to apply your settings or Cancel to close the tool, which will discard your
changes. If you want to return to your previous settings, click on Reset.

16.5. Monitoring System Activity and Status

This tool allows you to look for specific entries in various log files, therefore facilitating the search
for particular incidents or security threats.
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16.5.1. Browsing System Logs

Figure 16-9. Browsing and Searching through System Logs

These are the steps to follow in order to browse or look for a specific event into the system logs:

1. You must choose which specific words to match by filling the Matching (log files contain the words) field
and/or the but not matching (log files do not contain the words) field. At least one of the two fields must
be filled.

2. Then in the Choose file area select the file you want to perform the search on: simply check the correspon-
ding box.

The Mandrakelinux Tools Log is filled by Mandrakelinux-specific
configuration tools, like those you find in the Mandrakelinux Control
Center. Each time these tools modify the system configuration they
write a line in this log file.

3. Optionally, you can restrict the search to a specific day. In that case, check the Show only for the selected
day box and choose the desired day from the calendar.

4. When all is set up, click on the Search button. The results will appear in the Content of the file area at the
bottom.

Clicking on the Save button will open a standard dialog letting you save the search results into a plain text
(*.txt) file.
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16.6. Managing Users and Groups

UserDrake allows system administrators to easily add and remove users from the system, to assign users to a
group, and to manage user groups in the same manner.

In this section we will only focus on user management. Group ma-
nagement is very similar, however.

16.6.1. The Interface

Launching UserDrake will display the main window (figure 16-10) which lists the users currently defined on
the system. You can switch from users to groups by clicking on the Groups tab next to the Users tab.

Figure 16-10. The User List in UserDrake

All changes have immediate effect on your local user database. If the user list is modified outside of UserDrake,
you can refresh UserDrake’s window by clicking on the Refresh button.

If you make changes to an already logged in user, those changes
won’t take effect until he or she logs out, and logs in again.

Available actions are:

Add User

Adds a new user to the system. We will detail this procedure in Adding a New User, page 159.

Add Group

Adds a new user group to the system.

Edit

Allows you to change the parameters of the selected user or group. We will detail editing user parameters
in Adding a New User, page 159. In the case of a group you will be able to assign or remove users from that
group.

Delete

Removes the selected user or group from the system. A confirmation dialog will be shown, and in the
case of a user you will also be able to remove the user’s /home directory and mailbox.
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16.6.2. Adding a New User

We created the non-privileged user Queen Pingusa at installation time, and now we want to create a new user
called Peter Pingus. Then we want to make them both members of the fileshare group, so that they can
share folders with other users on the network (see Allowing Users to Share Folders, page 175).

Click on the Add User button, the dialog box to add a new user will pop up (see figure 16-11). The only required
field is Login although we strongly recommend that you set up a password for this new user: enter it in both
the Password and Confirm Password fields. You can also choose to add a comment in Full Name. Generally, this
is the full name of the user, but you can put whatever you want.

Figure 16-11. Adding a New User in the System

We now have two users in our list. Select one of them with your mouse, and click on the Edit button. The
dialog box shown in figure 16-12 will pop up. It allows you to modify most available user parameters.

Figure 16-12. Adding Users to a Group

The dialog is made of the following tabs:

User Data

Allows you to modify information provided when the user was created.
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Account Info

Enables you to provide an expiration date for that account, after which the user won’t be able to connect
to the system. This is useful for temporary accounts. It’s also possible to temporary lock an account to
prevent a user from logging in. Finally, this tab allows you to change the icon associated with the user.

Password Info

Allows you to provide a password expiration date, after which the user will have to change his password.

Groups

Shows the list of available groups where you can select the groups to which any user should belong.

For our users we just need to look for the fileshare entry and check the box associated to it. Then click on
the OK button to make the changes effective.

16.7. Backing Up and Restoring your Files

Drakbackup allows you to back up data present on your computer, whether it be on hard drive,
another networked computer, a CD/DVD or a tape. Once the files you wish to back up are de-
fined and that you’ve configured the way to access the backup media, you can run the backup
periodically. Then, you can forget about it until you wish to restore some files.

The backup parameters must be defined so that Drakbackup knows what, where and when to perform the
backup. We will guide you step-by-step with a back up-and-restore example using the wizard. Then we will
introduce you to automation of periodic backups.

16.7.1. A Practical Example Using the Wizard

Figure 16-13. Main Drakbackup Window

Start Drakbackup by clicking on the Backups icon in Mandrakelinux Control Center’s System section. Click on the
Wizard Configuration button to start the wizard. After making your choices in each step click on Next.
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16.7.1.1. First Step: What to Backup

Figure 16-14. Selecting What to Backup

Select Backup System to include the /etc directory where all your current system configuration files lie. This
allows you to “transport” your system to a different computer with little effort: only hardware-dependent
configuration will have to be revised.

The“system”backup does not include applications themselves (i.e.
executable files, libraries). A priori this makes sense because it is
likely that you will have access to the system’s installation media
from which applications can be easily installed again on the target
computer.

Select Backup Users to include all the files included in all of your users’ /home directories. Clicking on the Select
user manually button will let you select individual users and give you the following options:

• Do not include the browser cache. Select this to exclude the web browser’s cache from the backup file set.
Recommended due to the very nature of the browser’s cache.

• Use Incremental/Differential Backups. Selecting this will preserve old backups. Choosing Use Incremental Bac-
kups will only save files which have been changed or added since the last backup operation. Choosing Use
Differential Backups will only save files which have been changed or added since the first backup operation
(also known as the “base” backup). This last option takes more space than the first one, but allows you to
restore the system “as it was” at any given point in time for which a differential backup was made.
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16.7.1.2. Second Step: Where to Store the Backup

Figure 16-15. Selecting Where to Store the Backup

Select Across Network to store the backup on a remote computer accessible using either ssh, FTP, rsync or
WebDAV. A machine name or IP address, a user name and password on that machine, a directory on that
machine, and the access method and its options (if applicable) must be specified by clicking on the correspon-
ding Configure button.

Select On Tape Device to store the backup on a tape drive. Click on the corresponding Configure button to set
the tape device and tape parameters such as whether or not to rewind, erase and eject the tape.

Select On CD-R to store the backup on optical media: (re)writable CD or DVD. This is our preferred media for
the example, so click on its Configure button to set the required parameters (see figure 16-16).

Figure 16-16. Setting Optical Media Parameters

If it isn’t done automatically, use the Choose your CD/DVD device combo box to set the CD/DVD device. In
our example, we chose ATAPI:/dev/hdd, which is an IDE recorder. We chose a 700 MB medium size and a
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re-writable medium (the CDRW media option is selected).

Select the Erase your RW media option to erase the data on your re-writable media before each backup is
performed. If you select the Multisession CD option, only the 1st session will erase the media. Session-related
information recording takes some space out (20 to 30 MB) for each session, so the “real data” storage space
will actually be less than the medium’s size.

16.7.1.3. Third Step: Review and Store the Configuration

Figure 16-17. Review Configuration Parameters

The last wizard step shows a summary of the configuration parameters. Use the Previous button to change
any parameter you are not satisfied with. Click on Save to store them. Drakbackup is now ready to perform
backups.
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16.7.1.4. Performing the Backup

Figure 16-18. Backup Progress Dialog

Click on Backup Now and then on Backup Now from configuration file to display a confirmation dialog with
Drakbackup’s parameters: make sure the corresponding media (the CD-RW disk in our example) is ready and
click on Build Backup to start the backup operation.

If the backup set size exceeds the medium’s available capacity,
Drakbackup might just fail. This is a known issue and it’s being
worked on. As a work-around, please try to remove files from the
backup set so its size never exceeds the medium’s available capacity.

A dialog (see figure 16-18) will display the current progress of the operation. Please be patient: the time it
takes to back up depends on many factors such as the size of the backup file set, the speed of the storage
option selected, and so on. Once the operation is finished a report will be shown: look for possible errors on it
and take corrective measures if needed.
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16.7.2. Restoring Backups

Figure 16-19. Choosing the Restore Type to Perform

Make sure the media you want to restore the backup from is accessible and ready. Then click on Drakbackup’s
Restore button. In our example we will restore the whole backup so on the restore dialog (figure 16-19) click
on Restore all backups. A dialog will show you the current restore settings. Click on the Restore button to start
the restoration process.

Existing files in the target restoration directory (same location whe-
re the backup was made from, by default) will be overwritten.

Feel free to investigate the other restore options if you want to restore part of a backup instead of the full file
set.
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16.7.3. Automating Periodic Backups

Figure 16-20. Daemon Options Window

In Drakbackup’s main window, click on Advanced Configuration and then on the When button. The backup
scheduling window will appear (see figure 16-20). Select Use daemon to define the schedule. You will then be
asked to specify the interval (or period) between each backup operation and the storage media. In our example
we set up a customized calendar (custom period selected) to perform a backup every Friday at a quarter to
midnight and store it on CD. You can also specify hourly (i.e.: performed 1 minute after the hour), daily (i.e.:
performed at 4:02AM), weekly (performed at 4:22AM) and monthly (performed at 4:42AM) periods instead of
custom.
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16.7.4. Other Drakbackup Options

Figure 16-21. Miscellaneous Options Window

Click on Advanced Configuration and then on the More Options button. The miscellaneous options window will
appear (see figure 16-21).

Use the Please choose the compression type pull down list to select the compression used for your backups
among tar (no compression), tar.gz (gzip compression) and tar.bz2 (bzip2 compression: better but
slower).

Select the Use .backupignore files option to have Drakbackup exclude certain files from the backup. The
.backupignore file should be present in every directory of the backup file set where files are to be excluded.
Its syntax is very easy: a one-file-per-line list of the names of the files to exclude.

You can use the star (* = “matches any string”) and the ques-
tion mark (? = “matches one and only one character, regard-
less of what that character is”) in the .backupignore file to
exclude sets of files. For example, somename* will match all fi-
les whose names start with somename, and image00?.jpg will
match files named image001.jpg, image009.jpg, image00a.jpg,
image00h.jpg, etc.

Select the Send mail report after each backup to option and fill the e-mail address so Drakbackup knows to whom
to mail the backup operation report. Please bear in mind that the system needs to have a working MTA (Mail
Transport Agent) for this option to be effective.

If you want to send the report to more than one recipient, you will
have to set up a mailing list, containing all those addresses, and fill
the field with the mailing list’s post address.

All methods other than NFS use the hard disk drive to store temporary files. Select the Delete Hard Drive tar
files after backup to other media option to have Drakbackup free that space after performing the backup.
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17.1. Managing your Hard Drive Partitions with DiskDrake

Partitions are initially set up during the installation process. DiskDrake allows you, to some
extent, to resize your partitions, move them, etc. DiskDrake can also deal with RAID devices and
supports LVM but we will not discuss these advanced uses here. Please refer to the Reference
Manual to learn more about what partitions are used for.

DiskDrake is very powerful and can therefore be a dangerous tool.
Misuse of it can very easily lead to data loss on your hard drive.
Because of this potential loss of data, you are strongly advised to
take some protective measures before using DiskDrake:

1. Back up your data. Transfer it to another computer, ZIP
disks, etc.

2. Save your current partition table (the table describing
the partitions held on your hard drive(s)) to a floppy disk
(see DiskDrake’s action buttons, page 170).

17.1.1. The Interface

Figure 17-1. DiskDrake’s Main Window

DiskDrake enables you to configure each physical hard drive on your machine. If you only have one IDE disk,
you will see a single tab called hda below the file-system types. If there is more than one drive, then each drive
will have its own tab and will be named according to the Linux name for that drive. DiskDrake will allow you
to manage the partitioning of each drive.

The window (see figure 17-1) is divided into four zones:
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• Top. The structure of your hard drive. When you launch DiskDrake it will display the current structure of
the drive. DiskDrake will update the display as you make changes.

• Left. A menu relevant to the partition currently selected in the above diagram.

• Right. A description of the selected partition.

• Bottom. Buttons for making general actions. See next section.

We will now review the actions available through the buttons at the bottom of the window, and then describe
a practical use case.

17.1.2. DiskDrake’s action buttons

Clear all

Clicking on this button will clear all partitions on the current hard drive.

More

Displays a three button dialog allowing you to:

Save partition table

Allows you to save the current partition table to a file on a disk (a floppy, for example). This may
prove useful if a problem arises (such as an error made during drive repartitioning).

Restore partition table

Allows you to restore the partition table as previously saved with Save partition table. Restoring a par-
tition table may recover your data as long as you do not reformat partitions, because the formatting
process will overwrite all your data.

Rescue partition table

If you lose your partition table and have no backup, this function scans your hard drive to try and
reconstruct the partition table.

Help

Display this documentation in a browser window.

Undo

Cancels last action. Most modifications done on your partitions are not made permanent until DiskDrake
warns you it will write the partition table. This button therefore allows you to undo all of your modifica-
tions on partitions up to last write.

Toggle to expert mode

This button allows you to access the expert mode functions (which are even more dangerous if you are
not sure what you are doing). Reserved for experts.

Done

Saves your changes and exits DiskDrake.
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17.1.3. Resizing an Old Partition and Creating a New One

In this section, we are going to do a little exercise to demonstrate one of the more useful features of DiskDrake.
Let us imagine that you decide to use your machine as an FTP server and you want to create a separate
/var/ftp partition in order to host the FTP files. Note that doing this step-by-step tutorial will actually
modify the structure of your hard drive.

This is what the current /home partition looks like (see figure 17-2), before any modification. We are going to
shrink this partition in order to create free space for the new file system.

In order to perform the steps in this example, all users of your
system must be logged out, except root.

First of all, you need to unmount the /home partition by clicking on it and then pressing the Unmount button.

Figure 17-2. The /home Partition Before Resizing

The next step, as you may have guessed, is to click on the Resize button. A dialog will appear (see figure 17-3)
which will allow you to choose the new size for the /home partition. Move the slider to reflect the new size,
then click on OK.

Figure 17-3. Choosing a New Size

When this is done, you will notice that the graphic representation of your hard drive has changed. The
/home partition is smaller, and an empty space appears on the right. Click on the empty space and then on
the Create button which appears. A dialog (see figure 17-4) will let you choose the parameters for the new
partition. Set the size, choose the file system you want to use (usually Journalized FS: ext3) and then
enter the mount point for the partition, which in our example will be /var/ftp.
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Figure 17-4. Defining the New Partition

figure 17-5 shows what our projected partition table now looks like.

Figure 17-5. The New Partition Table

The last step is to format (prepare to host files) the newly created partition. To format the partition, click on its
representation in the partitions picture, then on the Format button. Confirm the writing of the partition table
to disk, the formatting of the partition and the update to the /etc/fstab file. You may be asked to reboot the
computer to make changes effective.

Figure 17-6. Confirming the Writing of the Partition Table

17.2. Managing Removable Devices

These tools enables system administrators to easily control most options which affect the beha-
vior of removable devices such as floppy, CD and DVD disks. Note that, by default, all remo-
vable devices are automatically made available so users shouldn’t have to manually mount
media.
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Figure 17-7. Changing a Parameter

For each device the following properties may be changed:

• Mount point. The directory where the device’s files will be accessible from. You can either choose an entry
in the list or type in your own path. If the directory does not exist, it will be automatically created.

• Options. Controls various device options, notably whether it is mounted automatically (supermount) or not.
Note that if the supermount option is selected, the two others (user and noauto) must not be selected.

• Type. Displays a list of file-system types. If you have a specific medium with an uncommon file system on
it, this is where you can tell Linux how to access it.

Select the property you wish to change and click on OK. The corresponding dialog will pop up in which
you can change your settings. Then click on OK again. The system will then ask you if you want to save the
modifications in the /etc/fstab file. By saying yes, you will not have to unmount and re-mount that device:
it will be done automatically

17.3. Importing Remote SMB Directories

This tool allows the system administrator to import remote shared directories based on the
SMB protocol (used mainly by Windows®) on the local machine.

While users can individually access remote shares through their file managers, it may be required in some ca-
ses to import a specific share for it to become immediately available for all users. We’ll go through an example
showing you how to import a template directory from a Windows® machine.
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Figure 17-8. Scanning the Whole Network

Clicking on the Search servers button scans the local network for machines which currently share directories
(including the local one). In our example, many servers are available. We’ll choose skywalker and we’ll make
it available locally for all users.

Clicking on a machine’s name will try to connect to it and browse for available shares. If that machine has
password-protected shares, a dialog will pop up asking you to identify yourself.

Figure 17-9. Authenticating on a Remote Samba Server

Enter the correct Username, Password and Domain. The available shares on that machine will then appear. Click
on the little arrow on the left of the server icon to show available shares.

If the machine you’re connecting to has both public and password-
protected shares, then canceling the password entry dialog will con-
nect you to that machine, but only to its public shares.

Figure 17-10. Choosing the Remote Directory to Import

Once a share is selected, a Mount point button appears. Clicking on it displays a dialog where you can type the
local directory name where remote files will be accessible.

Once this is done, two more buttons appear:

• Mount. Makes the resource available locally. When this is done, users simply have to point their file manager
to the directory selected as the mount point to get the files hosted by the server.

• Options. Allows you to set a user name and password to access that SMB mount point. Other permissions
and advanced settings can also be set through this button.
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Also, the little icon in front of the shared directory becomes

When you’re finished configuring the access points for remote directories, click on Done. A dialog box will
appear asking you whether you wish to save your modifications to the /etc/fstab file (where mount point
information is usually stored), or not. Click on Yes to make the shares configuration persistent between ses-
sions. Click on No to exit without saving your changes.

17.4. Importing Remote NFS Directories

This tool is exactly the same as the one mentioned in Importing Remote SMB Directories, page
173, except that it controls file sharing through the NFS protocol rather than SMB. Therefore it
allows you to locally import shared files from NFS-friendly machines. The interface is the same
as the one described in Importing Remote SMB Directories, and the effects are similar. Only the
corresponding machines are different: UNIX® for NFS and Windows® for SMB.

Another difference is that there is no need to provide a password to access NFS shares. The authentication
mechanism is host-based.

17.5. Allowing Users to Share Folders

This tool enables you to share files with other users of your computer network. File sharing
can be done on heterogeneous systems such as GNU/Linux and Windows®.

The file-sharing configuration is done in two simple steps: determining who can export folders, and then
which protocol to use. A 3rd step is necessary if you select the Custom export option.

Figure 17-11. Controlling Exports

First of all, you must determine who will be able to share folders. Here are the different available options:

• No sharing. Prevents users from sharing data with others.

• Allow all users. All users are allowed to share data with others.

• Custom. By choosing this option, only users within the same fileshare group will be allowed to share
data. If you choose this option, the fileshare group will be created and, as a 3rd step, you will be prompted
to run UserDrake in order to add the allowed users to this group (see Managing Users and Groups, page 158).
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Figure 17-12. Choosing the Export Protocol

Then you must choose which protocol to use for file sharing. Check one or both of the following:

• SMB. If you want your users to share files using Windows® systems.

• NFS. If you want your users to share files using UNIX® systems (such as GNU/Linux).

Once you have checked the appropriate boxes, click on OK. The required packages will be installed, if needed.
If you uncheck a previously checked box, the corresponding service will be stopped.

Once users are allowed to share data, they can select the folders to be shared through their preferred file
manager (see File Sharing, page 79).

17.6. Setting up WebDAV Mount Points

WebDAV (Web-based Distributed Authoring and Versioning) is an extension to the HTTP protocol
which allows you to create, move, copy, and delete resources on a remote web server. In prac-
tice, mounting a remote WebDAV repository on your local machine will allow users to modify
a remote web server’s files as if those files were local to the system.

Browse the WebDAV Resources (http://www.webdav.org/) pages
to learn more about this protocol.

Figure 17-13. Managing WebDAV Mounts Points

The first time you launch this tool the required packages will be installed if needed, and only two buttons
will be available. New, which allows you to define a new mount point, the other one just Quits the application.
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After you have defined mount points, they will appear as new buttons at the top of the buttons list. Clicking
on a mount point button will get you to the mount point menu (see figure 17-14).

When you click on the New button you are asked for the URL of the web server. Enter the complete URL of
the web server, beginning with http:// or https://, then click OK.

Figure 17-14. WebDAV Menu

You must now decide where the web server files will be accessible from. Select the Mount point option and
click OK. There you will be able to choose a local directory or type in your own. If the selected mount point
does not exist, it will be created.

If the server requires authentication, do not forget to fill the username and password fields in the Options dialog.
Then all you need to do is to actually mount the remote repository by selecting Mount and clicking OK.

You will now be able to browse and modify files on the local mount point you have defined and the changes
will be immediately available on the web server.

To make your settings persistent between sessions, do not forget to save modifications to the /etc/fstab file
when you quit the wizard.
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18.1. Securing your Machine through DrakSec

There is a graphical interface to msec (which stands for Mandrakelinux Security Tool) called
draksec which you can access through the Mandrakelinux Control Center. It allows you to change
your system’s security level and to configure every option of msec’s security features.

18.1.1. Setting your Security Level

This tool is only displayed in expert mode. Choose Options→Expert
mode from the menu and then look into the Security section of the
Mandrakelinux Control Center to access it.

Figure 18-1. Choosing the Security Level of your System

Simply choose the security level you want from the Security Level pull-down list: it will be effective as soon as
you click on the OK. Please read the help text regarding security levels very carefully so that you know what
setting a specific security level implies.

If you wish to check which options are activated for each security
level, review the other tabs: Network Options, System Options and
Periodic Checks. Click on the Help button to display information
about the options and their default values. If some of the default
options do not suit your needs, simply redefine them. See Customi-
zing a Security Level , page 180, for details.

Put a check mark on the Security Alerts box to send by mail possible security issues found by msec to the local
user name or to the e-mail address defined in the Security Administrator field.
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It is highly recommended that you do activate the security alerts
option so that the administrator is immediately informed of possible
security issues. Otherwise, the administrator will have to regularly
check the relevant system log files.

18.1.2. Customizing a Security Level

Clicking on each of the Options tabs (and the Periodic Checks one) will lead you to msec’s list of security options.
This allows you to define your own security level based on the security level previously chosen.

Figure 18-2. Modifying Standard Options

For each tab, there are two columns:

1. Options List. All available options are listed.

2. Value. For each option1 you can choose from the corresponding pull-down menu:

• Yes. Activate this option no matter what the default value is.

• No. Deactivate this option no matter what the default value is.

• Default. Keep the default security level behavior.

• Ignore. Use this option if you do not wish that test to be performed.

• ALL, LOCAL, NONE. The meaning of these are option-dependent. Please see the Help text available
through the Help button for more information.

Clicking on OK accepts the current security level with custom options, applies it to the system and exits the
application. Clicking on Cancel discards changes, keeping the old security level and exits the application.

1. The default security level setting is shown in the Help window.
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18.2. Controlling File Permissions with DrakPerm

In Securing your Machine through DrakSec, page 179, you saw how to change your system’s security level and
customize the security checks associated to those levels.

drakperm allows you to customize the permissions which should be associated with each file
and directory in the system: configuration, personal files, applications, etc. If the owners and
permissions listed here don’t match the actual permissions of the system’s files, then msec
(which stands for Mandrakelinux Security Tool) will change them during its hourly checks. Those
modifications can help prevent possible security holes or intrusions.

This tool is only displayed in expert mode. Choose Options→Expert
mode from the menu and then look into the Security section of
Mandrakelinux Control Center to access it.

Figure 18-3. Configuring File-Permission Checks

The list of files and directories which appears will depend on the current system’s security level as set by msec,
along with their expected permissions for that security level. For each entry (Path) there is a corresponding
owner (User), owner group (Group) and Permissions. In the drop-down menu at the top of the list, you can
choose to display only msec rules (System settings), your own user-defined rules (Custom settings) or both as in
the example shown in figure 18-3.

You cannot edit system rules, as stated by the“Do not enter” sign
on the left. However, you can override them by adding custom rules.

If you wish to add your own rules for specific files or modify the default behavior, display the Custom settings
list and click on the Add a rule button.
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Figure 18-4. Adding a File-Permissions Rule

Let’s imagine your current security level is set to 3 (high). This means that only the owners of the home
directories will be able to browse them. If you wish to share the content of Queen’s home directory with
others, you will need to modify the permissions of the /home/queen/ directory.

Filling the new rule dialog as seen in figure 18-4, will allow you to accomplish this.

If you create more rules, you can change their priorities by moving them up and down the rules list: use the
Up and Down buttons on your custom rules to have more control over your system’s permissions.

When you are satisfied with your settings, don’t forget to save your changes by clicking on OK.

18.3. Securing your Internet Access via DrakFirewall

This little tool allows you to set up a basic firewall on your machine. It will filter connection
attempts made from the outside, and block unauthorized ones. It is a good idea to run it just
after installing your machine and before connecting to the Internet, therefore minimizing the
risks of your machine being cracked.
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Figure 18-5. The DrakFirewall Window

Simply uncheck the Everything (no firewall) box, and then check the boxes corresponding to the services you
wish to make available to the outside world. If you wish to authorize a service which is not listed here, click
on the Advanced button to manually enter the port numbers to open.

The Advanced button will open an Other ports field where you can
enter any port to be opened to the outside world. Examples of ports
specifications are presented just above the input field, use them as
a guide. It is possible to specify port ranges by using the : syntax.
Example: 24300:24350/udp

Not checking a service in this list will not prevent you from connecting to it. It will only prevent people from
the Internet to connect to that service on your machine. If you do not plan to host any services on your machine
(common case for a desktop machine) just leave all boxes unchecked.

If, on the other hand, you wish to disable the firewall and leave all services accessible from the outside, check
Everything (no firewall) , but please bear in mind that this is very insecure, and therefore not recommended.

Then clicking on OK will bring you to the next step, which consists in selecting the network interface connected
to the Internet.

Figure 18-6. The Internet Interface
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Refer to the examples to determine your Internet interface’s name. If you are unsure, you can check the system
network configuration (see Managing Connections, page 147). You can finally click OK to install the needed
packages, activate the firewall and enjoy your secure Internet connection.
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19.1. Configuring the Login Mode

This tool allows a user to be automatically logged into the system at boot time, without a
password being required.

Figure 19-1. Choosing the Login Mode

There are a few parameters:

1. Graphical interface: if you wish to have the X Window System (graphical display) started at boot time,
check the Launch the graphical environment when your system starts box. If you leave it unchecked, the text
login will be displayed.

2. Autologin: if you’re the only person using your machine and nobody else has access to it, you may choose
to be automatically logged in at boot time. To do so, select the Yes, I want to autologin with this (user,
desktop) option. Then choose the user who will be logged on automatically in the Default user, as well as
the preferred Default desktop in the pull-down menus.

19.2. Changing your Boot-Up Configuration

This tool allows you to configure the bootloader and the boot menu entries.
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Figure 19-2. Choosing the Boot Mode

19.2.1. Configuring the Bootloader

You can choose between two bootloaders: GRUB and LILO. For the latter you can either choose a text or a
graphical menu. Either one will allow you to boot Mandrakelinux, it’s just a question of taste.

Unless you know what you are doing, you should not change the default Boot device shown, since that is
where the bootloader installs itself. The next field allows you to set the time (in seconds) before the bootloader
starts the default OS. If more than one OS is installed on your machine, it’s a good idea to leave at least 5
seconds so that you can easily select a different menu item, if needed.

Unless you really know what you are doing, it is not recommended
that you change these settings as this may prevent you from booting
your machine the next time you try to power it on.

The dialog finally shows a few options which can be useful depending on your specific hardware.

Enable ACPI

Enable this option to allow better power management support if your hardware is ACPI compatible.
ACPI is often needed for new laptops which no longer support APM.

Force No APIC

The IO-APIC (http://www.wlug.org.nz/APIC) is only really useful for multi-processor systems. It may
cause problems on single processor systems and should be deactivated in that case by checking this box.

Force No Local APIC

The Local APIC can be used by Linux to program interruptions to wake up threads. On multi-processor
machines it can be used to send interrupts to another processor.

These relatively new APIC features are known to cause problems on some computers because of badly desig-
ned chip sets or poor support in Linux kernel drivers. These problems can cause system freezes or incorrect
device detection. So you may need to deactivate them by checking the corresponding box.

19.2.2. Managing Boot Entries

After clicking Next, the list of entries which will be available at boot time is displayed. You can either Add,
Modify or Remove entries.

It is also possible to make an entry the default one by checking the Default check-box in the Modify dialog.
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Be careful with what you modify with this tool: you could prevent
your system from booting!

19.3. Customizing your Boot Theme

The Boot Theme utility enables you to change the default theme displayed at boot time, as well
as a few other options.

Figure 19-3. DrakBoot Theme Window

• Uncheck the Use graphical boot box if you prefer to view a text interface at boot time.

• Uncheck the Display theme under console if you want a clean, “traditional” console. This relates to the consoles
accessible through the Ctrl-Alt-Fn keys.

The boot theme setting will have no effect if your system is not set to boot using the graphical mode. Please
refer to Changing your Boot-Up Configuration, page 185, for more information on setting the boot mode.

Please note that by default, only one theme is available. You can
install the bootsplash-themes package which you will find in
contribs. Other themes are also available on the web.
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Chapter 20. Mandrakeonline Services

Mandrakesoft has a convenient update service which warns users about bug or security fixes specifically avai-
lable for their machines. This service can also be configured to automatically install package updates so you
don’t even have to run it manually.

This system is composed of three items:

Initial Configuration Wizard (see Initial Configuration, page 189)

A wizard allowing you to register a new machine in order to benefit from the Mandrakeonline services.

Web Management Interface (see The Web Management Interface, page 191)

A web interface which allows you to manage the list of the hosts you maintain. It also allows you to
activate hosts so that they are taken into account for updates.

An Applet (see Mandrakeonline Applet, page 193)

A desktop applet which informs you about the status of your updates, and allows you to launch update
installations when needed.

To get further information about the Mandrakeonline service, take a look at the FAQ (https://www.
mandrakeonline.net/page.php?page=info).

20.1. Initial Configuration

The first time you boot up your system after installation, the Mandrakeonline wizard will show up (figure 20-1).
It allows you to create a new account or to register an existing one. To manually launch the wizard from your
user account, click on the Mandrakeonline applet icon on the panel and choose Configure.

Figure 20-1. Creating a new Mandrakeonline Account
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Figure 20-2. Existing or New Mandrakeonline Account?

If you do not have a Mandrakeonline account, select the I want to subscribe option and fill the fields in the form.
If you already have one, just go on to next step.

You will be then presented with the Mandrakelinux privacy policy. Read it thoroughly and continue to the next
step.

Figure 20-3. Authentication on Mandrakeonline

Now enter the login information for your account, and provide a name to identify the machine you are cu-
rrently working on. This is useful if you manage several computers with Mandrakeonline.
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Figure 20-4. Setup Automatic Updates: Login

Finally, you are asked to choose your country so that automatic updates occur from the nearest possible server.
If your country is not listed, make sure you select the nearest one. If you don’t want automatic updates to occur,
simply click the Cancel button, or click on Next in order to benefit from automatic updates.

Figure 20-5. Setup Automatic Updates: Country

Clicking on Finish the wizard is finished. To complete your Mandrakeonline setup, you must now activate this
machine in your account.

20.2. The Web Management Interface

Now that the machine information is added to your Mandrakeonline account, you must activate the services
associated to it. To do that, first identify yourself with your login information at the Mandrakeonline web
administration interface (https://www.mandrakeonline.net/). You can open it by right clicking on the Man-
drakeonline applet on the panel, and choosing the Online WebSite entry.
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20.2.1. Subscribing New Machines

Figure 20-6. Mandrakeonline hosts list

We note here that the host we just added (mailserver) is not activated. To do that, press the This host is not
activated on Mandrakeonline! button.

A form with various subscription options show, and once you have completed the subscription process, the
host is activated. You will now benefit from all available update services for this machine.

20.2.2. Hosts Management

Once a host is activated it is possible to get to its management interface by clicking on the details icon.

Figure 20-7. Up To Date Mandrakeonline Host

The available actions differ slightly according to whether the machine packages are up to date or not, but
basically these are the actions one can perform:

Control email alerts

Simply click on the yes or no link to change the status of mail sending. Those alerts are particularly useful
if you choose not to benefit from automatic updates: if activated, an e-mail will be sent to you when there
are updates available.

Control automatic scheduled updates

Simply click on the yes or no link to activate or stop automatic updates. If yes is displayed, updates avai-
lable for your machine will be automatically installed by the applet (see Mandrakeonline Applet, page 193)
which regularly connects to the Internet to check for such updates.

Check current and outdated packages

By clicking on the See link in front of the Installed RPMs or Errata(s) label.
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20.2.3. Scheduling Updates

If you have chosen to perform package updates manually, you can also do it from the applet (see Mandrakeon-
line Applet, page 193). From the web interface, you can check which updates are available for your machine,
and choose which to install.

Figure 20-8. Outdated Mandrakeonline Host

You must now select the packages to be updated. You can do this blindly by clicking on the Schedule all
packages to be updated button, or selecting them one by one, by clicking on the See link by the Errata(s) option.

Figure 20-9. Select Packages to be Updated

Here you can click on the advisory number (MDKSA-2004:033 in the example) to get full details about this
update. Check the box for each package you want to be updated on your machine. When this is done, click on
the Schedule Packages button.

When updates have been selected, they will be automatically installed next time the applet connects to the
Mandrakeonline server, which occurs several times a day.

20.3. Mandrakeonline Applet

The applet which resides on your desktop panel informs you about update availability and allows you to
perform basic system maintenance tasks.

The applet icon can be in one of many states, depending on the machine status:

The system is up to date. All is fine.

A standard program update is available for your installed packages.

A bugfix update is available for your installed packages.

A security update is available for your installed packages. It is highly recommended that you
install security updates.

The applet is currently contacting the server, be patient.
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This host is currently not activated. Activate it using the web interface (see Subscribing New
Machines, page 191).

The applet cannot connect to the server. Check your Internet connection.

The system is currently not configured or a configuration error was found. Launch the
configuration wizard (see Initial Configuration, page 189) to use Mandrakeonline.

Clicking on the applet icon opens a dialog with action buttons, followed by the current machine status.

Figure 20-10. Mandrakeonline Applet

Install updates

Manually launch the updates installer by opening Rpmdrake (see Mandrakelinux Update, page 110).

Configure

Launch the wizard (see Initial Configuration, page 189). This can be useful to resend your machine confi-
guration to the server, for example if you have upgraded your hardware.

Check updates

Manually connects to the server to check if updates are available. This is normally done periodically by
the applet, but if you have no permanent connection to the Internet, it may be useful to manually check
for updates when you are online.
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This chapter will guide you through some troubleshooting basics, that is: what to do when everything goes
wrong or, better yet, what to do to be prepared if something goes wrong and then how to fix it.

21.1. Introduction

Making backup copies of your data, fixing little problems, recompiling the kernel, installing software, and
tweaking configuration files are not uncommon scenarios in every day GNU/Linux life: even if you don’t do it
all the time, some day you may want or need to. Those tasks can be managed without any hassle if you use a
little common sense and follow some practices and guidelines we will introduce in this chapter.

Many of the examples and tools presented in this chapter deal with
the command line. Usually, restoration of a damaged system to a
working state can only be done this way. We assume that you feel
comfortable enough using this powerful tool.

So, on to the basic things you need to have ready...

21.2. A Boot Disk

The very first thing you will need when your system cannot boot from the hard disk will be a boot disk. It will
allow you to boot your system up and, in a matter of minutes, enable you to undo what rendered your system
unusable.

You can also use the Rescue Mode of Mandrakelinux’s installation
CD-ROM to boot your machine and perform some maintenance
tasks, but a boot disk might prove to be useful anyway (for example,
if your machine doesn’t support booting from the CD-ROM drive).

21.2.1. Creating a Boot Floppy from the Console

Open a terminal and type the following, as root:

# mkbootdisk --device /dev/fd0 ‘uname -r‘

and strike the Enter key, then follow the instructions given on screen.

One parameter needed by mkbootdisk is the --device [device] option, which tells mkbootdisk which
device you want to write the boot disk to. In our example, we chose /dev/fd0 which is the first floppy drive in
the system. In 99.9% of cases that should work. If it doesn’t, just choose the right device for your floppy drive.

The other parameter needed is the [kernel-version] option, which tells mkbootdisk which kernel you
want to put on the floppy. In our example, we use ‘uname -r‘ which gives as a result the name of the
current running kernel. Thus, the example given will create a boot disk in the first floppy drive with the
current running kernel on it.

Please note that this will create a boot disk based on your current running kernel with all the modules that
kernel uses.

21.2.2. Testing the Boot Disk

Always test your boot floppy to make sure it actually works. There are few things more embarrassing than
finding that the floppy won’t boot because of media errors. If the floppy boots OK then... You are done!
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21.3. Backup

21.3.1. Why Backup?

Backing up your system is the only means of being able to repair it if it suffers severe damage, if you acci-
dentally delete some important system files, or if someone breaks into your system and intentionally deletes
some files. You should also back up your personal data (compressed audio, images, office documents, e-mails,
address book, etc.) to be safe.

You should make your backups using an appropriate medium and keep them in a safe place. Such a place
should be outside the place you usually work in, if possible. You can even have two backups, one on-site, and
one outside. Generally speaking, you should make sure that you will be able to restore those backups if you
want all this to be really useful.

21.3.2. Preparing your System

You probably have everything you need already installed in your system. You should also keep a boot disk
near at hand (you created one, didn’t you?). Actually, you can make backups using only tar and, optionally,
a compression tool such as gzip or bzip2. See an example in Backup Example Using tar, page 197.

As an alternative, you can use specialized backup programs, such as Taper, Time Navigator, Arkeia, or Mandra-
kelinux’s own Drakbackup (please refer to Backing Up and Restoring your Files, page 161).

21.3.3. What to Backup?

Well, this might be the single most difficult question every system administrator asks himself when the time
to backup comes. The answer depends on issues such as: are you only backing up your personal data, your
configuration files, or your whole system? How much time or space is it going to take? Will you be restoring
your backup on the same machine/OS version, or on a different one?

Since this is a troubleshooting chapter, we will try to focus on making a backup that will allow us to quickly
restore our system to the state it was before that terrible thing which rendered it unusable happened. Of
course, you will need to make a backup of your personal data if you don’t want to lose it.

As a rule of thumb, you will need to back up the following directories: /etc, /home, /root and /var. If you
do a complete backup of these directories, you will have saved not only your system configuration, but your
data as well. Please bear in mind that a backup can take a long time to complete, but it’s the safest bet.

A more sophisticated scheme would be to backup only those files which have changed, skipping the ones
which haven’t. This will take more planning time, but will lead to quicker backups (and quicker restores, too).
They will also be “easier” to port from one machine/OS version to another.

To summarize, back up all the configuration files of the programs you use and all of the configuration files
you have changed. Also back up all your personal (and your system’s users) data files. You won’t regret it.

21.3.4. Where to Back Up?

The other big question to answer. This depends on how much you want to back up, how fast you want to
make your backups, how easy it is to access the backup media, and a large list of etceteras.

Generally speaking, you need media that is at least as large as the amount of information you want to back
up, and fast enough so the whole process won’t take forever to complete.

Available backup media options vary in capacity, reliability, and speed. You can combine backup media ac-
cording to your backup strategy, for example: tapes and CD-R/DVD+RW, hard disk and tapes, hard disk
and CD-R/DVD+RW, etc., but bear in mind that your backup software may or may not support all of these
options.
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21.3.5. When to Back Up?

There are many policies for backup schedules. We will introduce you to a few. Remember that these are not
mandatory, nor the best ones, nor the only ones. These are just guidelines you may want to follow in rolling
out your own backup schedule.

The many backup strategies out there depend on the media you use, on how often your data changes, and on
how critical that data is to you or your organization. For example, one strategy states that you should make
a full backup each weekend, and an incremental (changed data only) backup every day. Then make a full
backup every month and store that one in at least two places. This strategy might prove useful for a company,
but not for a personal computer. For your personal backups you can think of something like this: make a
weekly backup of your files on your disk drive and each month transfer those backups to CD-R/DVD+RW or
tape.

21.3.6. Backup Example Using tar

Next, we will introduce you to a little backup script which uses tar and bzip2 for making a compressed
backup of the list of directories you provide. Please read the script’s comments for tips on its usage.

You need read permission on the files, and read and execute per-
missions on the directories you are going to back up. Otherwise the
backup operation will fail.

#!/bin/bash

# Create a compressed backup of all the directories specified and put the
# resulting file in a directory of your choice.

BACKUP_DIRS="$HOME /etc /var"
BACKUP_FILENAME=‘date ’+%b%d%Y’‘
BACKUP_DEST_DIR="/backups"

# Uncomment the following line for GZipped backups, comment for
# BZipped backups

#tar cvzf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.gz $BACKUP_DIRS

# We do a BZipped backup here...
# Comment the following line for GZipped backups, uncomment for
# BZipped backups

tar cvjf $BACKUP_DEST_DIR/$BACKUP_FILENAME.tar.bz2 $BACKUP_DIRS

Use BACKUP_DIRS to specify the directories you want to include in the backup and BACKUP_DEST_DIR to
specify the destination directory where the backup is going to be stored. Make the script executable: open a
terminal and run chmod 700 backup.sh.

Of course, you can always move the resulting tar.bz2 or tar.gz file to any media you want later. You can
even backup directly to the media you want by mounting it and changing the variable BACKUP_DEST_DIR of
the script accordingly. Feel free to enhance this script and make it as flexible as you want.

To restore the backups made this way, please look at Restore Example Using tar, page 197.

21.4. Restore

The restoration of a backup depends on which program, media, and schedule you used to make it. We won’t
cover all the restore cases, but only mention that in order to recover your settings and data files, make sure
that you restore the files and/or directories to the same places they were in when you made the backup.

197



Chapter 21. Troubleshooting

21.4.1. Restore Example Using tar

Now, we will introduce a little script to restore the backup we made with tar using the script introduced
earlier in Backup Example Using tar, page 197.

You need write permissions on the files and directories you are going
to restore. Otherwise the restore operation will fail.

#!/bin/bash

# Extract a compressed backup of all the directories specified
# putting the backed up files into their original places.

BACKUP_SOURCE_DIR="/backups"
RESTORE_FILENAME=$1

# Uncomment the following line if you are restoring GZipped
# backups

#tar xvzf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

# Restore a BZipped backup here...

tar xvjf $BACKUP_SOURCE_DIR/$RESTORE_FILENAME

As you can see, this script is simple enough. All we have to do is to pass it the file name of the backup we
want to restore as a parameter (just the file name, not the full path), and it restores the backed up files into their
original locations. Make sure the script is executable: open a terminal and run chmod 700 restore.sh.

21.4.2. Making a Recovery CD-ROM

There is a way to be prepared in case of “total disaster”, and that is by making a full backup of your system.
Programs such as mkCDrec can be very useful to get you up and running in a matter of minutes. You can find
it, together with its documentation on the mkCDrec web site (http://mkcdrec.ota.be).

mkCDrec allows you to do multiple-CD-ROM volumes, disk cloning (copying the full contents of a disk or
partition to another with similar characteristics — at least the same size), and many more.

In order to restore a system with mkCDrec you only have to boot with the first CD-ROM of the multiple-CD-
ROM volume and then follow the on-screen instructions.

21.5. Problems Arising at Boot Time

It could happen that your system hangs during boot up. If so, don’t panic, just keep reading.

The next sections are not introduced in any particular order.

21.5.1. System Hanging during Boot

If your system hangs during Rebuilding RPM database or Finding module dependencies, just
press Ctrl-C. This will allow the system to skip this step and continue to boot. Once booted, execute rpm
--rebuilddb as root if the system hang was at the Rebuilding RPM database phase. If the system
hang was at the Finding module dependencies phase you have most likely been through a kernel up-
grade, but have not done it correctly. Check if the files in /boot and the /lib/modules directory match the
current kernel version (i.e., have the current version number attached). If they don’t match, please read Com-
piling and Installing New Kernels from Reference Manual to find out how to fix it.
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If the boot process hangs at RAMDISK: Compressed image found at block 0 you have messed up the
initrd image. Either try to boot another lilo.conf entry or boot an emergency system and remove or change
the initrd= section in /etc/lilo.conf

21.5.2. File-System Check on Boot Fails

The information below applies to ext2 and ext3 file systems only. If
you have a different file system, please check its documentation.

If, for any reason, you didn’t shut your box down properly, the system will run a routine file-system check
during the next boot. Sometimes it may fail to do this on its own and will ask for the root password and drop
you to a console. Execute e2fsck -py [device] where [device] is the name of the partition on which
the automatic check has failed. The -p switch tells e2fsck to make all the necessary repairs without asking,
-y assumes you answer yes to all questions. When the check and repair phase is over, press Ctrl-D to leave
the emergency console. The system will reboot.

If you get this error regularly, there may be bad blocks on your disk. Execute e2fsck -c [device] to find
out. This command will automatically mark any bad blocks and thus prevent the file system from storing data
in these blocks. e2fsck checks the file system automatically only if it hasn’t been unmounted properly during
the previous system shutdown; or if the maximal mount count has been reached. To force a check, use the
-f option.

The verification for bad blocks on a disk should only be done on
unmounted file systems, and can take a long time to complete.

21.5.3. X Doesn’t Start

If you boot into X by default and have managed to break your X configuration somehow, and cannot enter X
anymore, you can log into a console and use XFdrake to re-configure X. You can also boot into a different run
level, fix X’s configuration with XFdrake and reboot into X.

21.5.3.1. Booting Into a Different Run Level

The default run level GNU/Linux boots to is defined in the /etc/inittab file. Look for an entry like
id:5:initdefault:. To boot into run level 3 (the console), you have to define that run level on the boot
prompt. Under LILO, press the Esc key once and type linux init 3. Under GRUB, press the E key twice,
add init 3, press the Enter key and then the B key to boot.

For a more detailed description about run levels, please refer to the The Start-Up Files: init sysv chapter of
Mandrakelinux’s Reference Manual.

21.5.3.2. Configuring X from the Console

To re-configure X using XFdrake from the console simply type XFdrake, as root.

Using XFdrake is no different to the graphical environment except that you won’t have nice icons and may
not be able to use the mouse pointer. To move down you have to press the right or down arrow keys on your
keyboard; to move up press the left or up keys on your keyboard. You can also use the Tab key to move
between the different options/buttons. The text on the currently selected button/option will be highlighted
with a different color. Press the Enter key to activate it.

Please refer to Controlling the Graphical Configuration, page 119 for instructions on its usage.
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21.6. Bootloader Issues

21.6.1. Bootloader Reinstall

Sometimes you will make a mistake and wipe your disk’s MBR (Master Boot Record), or some misbehaving
program does it, or you dual boot with Windows® and catch a virus that does it. So, you think you won’t be
able to boot your system anymore, right? Wrong! There are many ways to recover the boot record.

To recover your bootloader you will need a boot disk. Without a boot disk of some kind you might be com-
pletely lost1.

Reboot your computer using the boot disk. What you do next varies according whether you use LILO or GRUB.
No matter which bootloader you use, all the commands you must execute will need to be run as root.

21.6.1.1. With LILO

If you use LILO, you only need to issue the following at the command prompt: /sbin/lilo. This will re-
install LILO on your disk’s boot sector and will fix the problem.

21.6.1.2. With GRUB

If you use GRUB things are a little bit different to that of LILO.

The following example will assume that you are trying to install
GRUB in the MBR of your first IDE drive, and that the file stage1 is
in the /boot/grub/ directory.

First, invoke GRUB’s shell by issuing the grub command. Once there, issue the following command: root
(hd0,0). This will tell GRUB that the files it needs are in the first partition (0) of your first hard disk (hd0).
Then issue the following command: setup (hd0). This will install GRUB in the MBR of your first hard disk.
That’s it!

You can also try to use grub-install /dev/hda to install GRUB on your first hard drive’s MBR, but the
method described above is the preferred one.

21.6.1.3. Some Considerations for Dual-Booting Systems

Windows 9x, NT, 2000 and XP upgrades. If you are running a dual-boot system, be very careful to always
have a GNU/Linux boot disk prepared. When (re)installing Windows® (all versions), as Windows® rewrites the
MBR without any warning at all, and if you don’t have a boot disk, you won’t be able to boot GNU/Linux after
you perform the Windows® upgrade.

21.6.2. Backing Up and Restoring the MBR

To make a backup copy of your hard disk’s MBR, insert a blank floppy in your floppy disk drive and issue the
following:

# dd if=/dev/hda of=/dev/fd0/mbr.bin bs=512 count=1

If you want to restore a backed up copy of your hard disk’s MBR, insert the floppy containing it into your
floppy disk drive and issue the following:

# dd if=/dev/fd0/mbr.bin of=/dev/hda bs=512

1. Unless you made a backup of your MBR.
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The above examples assume that the MBR of your first IDE hard
disk (/dev/hda) is backed up to a file named mbr.bin on your first
floppy diskette drive (/dev/fd0) and should be run as the root
user.

21.7. File System Issues

21.7.1. Repairing a Damaged Super-Block

The information below only applies to ext2 and ext3 file systems.
If you have a different file system, please check its documentation.

The super-block is the first block of each ext2FS/ext3FS partition. It contains important data about the file
system, such as its size, free space, etc. (it is similar to the method used by FAT partitions). A partition with
a damaged super-block cannot be mounted. Fortunately, ext2FS/ext3FS keeps several super-block backup
copies scattered over the partition.

Boot your system with a boot disk. The backup copies’ location depends on the block size of the file system.
For file systems with 1 KB block sizes it is at the beginning of each 8 KB (8192 bytes) block. For file systems
with 2 KB sizes it is at the beginning of each 16 KB (16384 bytes) block, and so on. You can use the mke2fs
-n [your_disk_device_name] command to find out at which byte positions the super-block copies are.
Assuming a 1 KB block size, the first backup copy is in byte number 8193. To restore the super-block from this
copy, execute e2fsck -b 8193 /dev/hda4; change hda4 accordingly to reflect the name of your damaged
partition. If that block also happens to be damaged, try the next one at byte number 16385, and so on until you
find a suitable one. Reboot your system to activate the changes.

21.7.2. Recovering Deleted Files

We will discuss some ways of recovering deleted files and directories. Please bear in mind that recovery tools
are not magical, and they will only work depending on how recently you deleted the file(s) you are trying to
recover.

You might be wondering how to recover files you accidentally deleted. There are some utilities designed for
GNU/Linux’s ext2 file system which allow you to recover deleted files and directories. However they won’t
recover the files you deleted a few months ago because of disk usage, space marked as “free” will have been
overwritten. So the best way to protect against accidental or not so accidental deletions is by making backups.

Please bear in mind that there are not (as yet) tools to recover files
deleted on reiserfs file systems. Keep in touch with the ReiserFS
home page (http://www.namesys.com) for the latest news about
it.

One recovery tool is Recover. It’s an interactive tool. If you have a Mandrakelinux –– PowerPack Edition,
you already have it on the contribs CD-ROM. Otherwise, you can find it on the Rpmfind web site (http:
//www.rpmfind.net). Go there and download the RPM. Once you have the RPM, install it. Then run it with
recover and answer the questions it asks you. The questions will help you to set a time span to look for
deleted files and directories to minimize the time it takes to do the search2.

Once the tool finishes its search, it will ask you where you want to save the recovered files and directories.
Pick a directory of your choice, and you will have all the files and directories recovered into it. Note that you
won’t be able to recover the file names, just their contents, but you can inspect them or try to rename them
with different names until you get the right one. This is better than nothing.

2. You can search for all deleted files too by appending the -a option, but it will take longer...
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There are also mini-HOWTOs related to “undeletion” for ext2,
look at Ext2fs-Undeletion (http://www.tldp.org/HOWTO/
mini/Ext2fs-Undeletion.html) and undeletion of who-
le directory structures (http://www.tldp.org/HOWTO/mini/
Ext2fs-Undeletion-Dir-Struct/index.html).

21.8. Recovering from a System Freeze

When stuck in a “freeze”, your computer doesn’t respond to commands anymore and input devices such as
keyboard and mouse seem to be blocked. This is a worst-case scenario and could mean that you have a very
severe error in either your configuration, your software or your hardware. We will show you how to deal with
this annoying situation.

In the case of a system freeze, your top priority should be trying to shutdown your system properly. We
assume you are running under X. So try these steps consecutively:

1. Try to kill the X server by pressing the Ctrl-Alt-Backspace keys.

2. Try to switch to another console by pressing the Ctrl-Alt-Fn keys (where n is the console number, from 1
to 6). If you succeed, login as root and issue the command: kill -15 $(pidof X) or the command
kill -9 $(pidof X), if the first command shows no effect. Check with top to see if X is still running.

3. If you are part of a local network, try to use ssh to connect into your machine from another box. It is
advisable to ssh into the remote machine as an unprivileged user and then use the su command to
become root.

4. If the system doesn’t respond to any of these steps, you have to go through the SysRq (System Request)
sequence. The SysRq sequence involves pressing and holding three keys at once: the left Alt key, the SysRq
key (labeled Print Screen on older keyboards) and a letter key.

a. Alt-SysRq-R puts the keyboard in “raw” mode. Now try pressing Alt-Ctrl-Backspace again to kill X.
If that doesn’t work, carry on.

b. Alt-SysRq-S attempts to write all unsaved data to disk (“sync” the disk).

c. Alt-SysRq-E sends a termination signal to all processes, except for init.

d. Alt-SysRq-I sends a kill signal to all processes, except for init.

e. Alt-SysRq-U attempts to re-mount all mounted file systems read-only. This removes the “dirty flag”
and will prevent a file system check upon reboot.

f. Alt-SysRq-B reboots the system. You might just as well press the “reset” button on your machine.

Remember that this is a sequence, i.e. you have to press one com-
bination after the other in the right order: Raw, Sync, tErm, kIll,
Umount, reBoot3. Read the kernel documentation for more infor-
mation on this feature.

5. If none of the above helps, cross your fingers and press the “reset” switch on your machine. If you are
lucky, GNU/Linux will just run a disk check upon reboot.

By all means, try to find out what causes these lockups because they can do severe damage to the file sys-
tem. You might also want to consider using one of the journaling file systems included in Mandrakelinux: ext3,
reiserfs, etc. which handle such failures more gracefully. However, replacing ext2FS with reiserfs requi-
res reformatting your partitions. You can use tune2fs -j /dev/hdaN to convert the file system in the Nth

partition of the first IDE disk from ext2FS to ext3FS.
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21.9. Killing Misbehaving Apps

Well, this one is not so hard after all. You have many ways to do it. You can do it by finding the PID of the
program which stopped responding, and then using the kill command to terminate it, or you can use the
xkill tool or other graphical tools such as the ones that show the process tree.

21.9.1. From the Console

The first thing to do to terminate a misbehaving program is to find its PID, or process ID. To do so, execute the
following from a console: ps aux | grep mozilla, supposing that Mozilla is the misbehaving program.
You will get something like the following:

peter 3505 7.7 23.1 24816 15076 pts/2 Z 21:29 0:02 /usr/lib/mozilla

This tells us, amongst other things, that Mozilla was started by user peter and that its PID is 3505.

Now that we have the PID of the misbehaving program, we can execute the kill command to terminate it.
So we execute the following: kill -9 3505, and that’s it! Mozilla will be killed. Note that this is only to be
used when the program doesn’t respond to your input anymore. Do not use it as a standard means of exiting
from applications.

Actually, what we have done was send the KILL signal to the process number 3505. The kill command
accepts other signals besides KILL, so you can have greater control over your processes. For more info, see
kill(1).

21.9.2. Using Graphical Monitoring Tools

You can also use the graphical process’ status tools (like KPM, KSySGuard, and GTOP to name a few) which
allow you to point to the process name and with one click send that process a signal or just kill that process.

If you are using KDE, you can press the Ctrl-Alt-Esc keys: the
pointer will change to a skull with crossed bones and you can simply
click on the window of the misbehaving application to kill it.

21.10. Miscellaneous

Some considerations on newer hardware such as legacy-free systems, nVidia® and ATI 3D® graphics accelera-
tor cards, and other things that do not fit in the preceding sections...

Legacy-Free Systems. Hardware manufacturers have recently introduced what they call “legacy-free sys-
tems”, mainly on laptops4, but there are also legacy-free desktop computers. This basically means that the
BIOS has been considerably reduced to allow you only to choose which media to boot from. Mandrakelinux
will be able to configure everything properly.

nVidia and ATI 3D Graphics Cards. Computers with nVidia or ATI graphics cards need a patched kernel to
be able to use OpenGL hardware 3D acceleration on OpenGL-compatible applications. If you own a Mandra-
kelinux –– PowerPack Edition, the kernel should have been installed by DrakX. If this is not your case, please
obtain and install the corresponding packages. You can visit nVidia’s web site (http://www.nvidia.com) and
ATI’s web site (http://www.ati.com) and download the appropriate drivers, or you can download the RPM
packages from Mandrakeclub (http://www.mandrakeclub.com). Then run Mandrakelinux Control Center and
re-configure X from there.

My Computer is “slow”. If you notice your computer is really slow, or significantly slower than with other
GNU/Linux versions, you might overcome this “problem” by disabling ACPI support. To do so, add the follo-
wing to your /etc/lilo.conf file:

4. Refer to the great Linux on Laptops (http://www.linux-laptop.net) web site for more information on your laptop
make/model.
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append="acpi=off"

If the file already has an append= line, only add acpi=off at its end. Running lilo -v as root and reboo-
ting your computer will make the changes effective.

21.11. Mandrakelinux’s Specific Troubleshooting Tools

Each administration tool (the ones started from Mandrakelinux Control Center) is a potential trouble fixing tool.
You can use all these tools to revert configuration changes, to add or remove software, to update your system
with the latest fixes from Mandrakesoft, etc.

If you think you have found a bug in any of our tools, please feel free to submit a bug report using Drakbug,
our automated bug report tool.

21.12. General Guidelines for Solving a Problem under Mandrakelinux

Here are the different means available to you in your problem-solving quest. Try the first option and only
then, if that does not work, try the second, and so on.

21.12.1. Search the Internet

The various Internet sites previously mentioned are excellent starting points. They deal with general and
very specific aspects of your potential problems. Finally, try a general search engine such as Google™ or, as
mentioned above, the Linux-specific Google™ search engine. And do not hesitate to use the Advanced search
(http://www.google.com/advanced_search) option with very detailed questions, such as the error message
you are receiving.

21.12.2. Mailing Lists and Newsgroups Archives

The previous searches may lead you to general answers which hide the results of your specific question
amongst many other answers. To refine your search, you can try the following.

First, try to find a list which seems specifically geared to your problem, then perform a search in its archive
pages.

Example
You’ve noticed some strange behavior while trying to use GRUB with a minix partition.

One of the results of a search using the “grub mailing list” keywords in Google™ is a link to the GRUB mailing list
archive (http://mail.gnu.org/archive/html/bug-grub/). It even offers a search engine, which when searched for
“Minix” leads you directly to a patch.

Note that not all archives have an embedded search engine. Howe-
ver, using Google� as an example, you can easily use the advanced
field domain to limit your search to the specific site hosting the
archive. This strategy may also be used to exclude sites which keep
returning garbage.

For a newsgroups search, Google Groups� (http://groups.google.com/) maintains an archive of an amazingly
large number of newsgroup channels.
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21.12.3. Directly Contacting the Person in Charge

Use this option as a very last resort and in really extreme situations — unless you want to offer your collabo-
ration! Software developers generally receive mountains of e-mails, so your anguished question on the use of
the cd command will most likely... be ignored!

The addresses will be found either on the home page of a project’s site or in the software documentation.

A last word: do not underestimate your neighbors’ skills or those of your local LUG (Linux Users Group).
And please, do not throw your computer through the window. If your problem isn’t fixed today, it may be
tomorrow...

21.12.4. Mandrakesoft Business Services

Finally, when facing a really challenging situation, corporate users (especially) might consider hiring one of
Mandrakesoft’s consultants to address their specific needs.

This is one of the strong suits of open-source products: we have the source, we have the power! Therefore,
almost any problem, no matter how complex, specific or high level, may be solved right in the heart of the
software.

You might also want to customize your Linux environment to meet very precise goals. For example, you could
use Mandrakelinux as a custom routing application on special devices. Know that Mandrakesoft consulting ser-
vices (http://www.mandrakesoft.com/products/business) can help you.

21.13. Final Thoughts

As you have seen there are many more ways to recover from an emergency than by re-installing the whole
system again5. Sure, you need a little expertise in applying some of the techniques described in this chapter,
but with a little practice you will gain such expertise. However, we hope that you will never need to really
master these techniques ... although it does not hurt to know them. We hope that the instructions and examples
given will be useful when you are in need. Good luck recovering from an emergency!

5. The usual way to fix things in some other operating systems...
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Appendix A. The GNU General Public License

The following text is the GPL license that applies to most programs found in Mandrakelinux distributions.

Version 2, June 1991 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330,
Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not
allowed.

A.1. Preamble

The licenses for most software are designed to take away your freedom to share and change it. By contrast, the
GNU General Public License is intended to guarantee your freedom to share and change free software — to
make sure the software is free for all its users. This General Public License applies to most of the Free Software
Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software
Foundation software is covered by the GNU Library General Public License instead.) You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are
designed to make sure that you have the freedom to distribute copies of free software (and charge for this
service if you wish), that you receive source code or can get it if you want it, that you can change the software
or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you
to surrender the rights. These restrictions translate to certain responsibilities for you if you distribute copies
of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients
all the rights that you have. You must make sure that they, too, receive or can get the source code. And you
must show them these terms so they know their rights.

We protect your rights with two steps:

1. copyright the software, and

2. offer you this license which gives you legal permission to copy, distribute and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there
is no warranty for this free software. If the software is modified by someone else and passed on, we want its
recipients to know that what they have is not the original, so that any problems introduced by others will not
reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redis-
tributors of a free program will individually obtain patent licenses, in effect making the program proprietary.
To prevent this, we have made it clear that any patent must be licensed for everyone’s free use or not licensed
at all.

The precise terms and conditions for copying, distribution and modification follow.

A.2. Terms and conditions for copying, distribution and modification

• 0. This License applies to any program or other work which contains a notice placed by the copyright holder
saying it may be distributed under the terms of this General Public License. The “Program”, below, refers to
any such program or work, and a “work based on the Program” means either the Program or any derivative
work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or
with modifications and/or translated into another language. (Hereinafter, translation is included without
limitation in the term “modification”.) Each licensee is addressed as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside
its scope. The act of running the Program is not restricted, and the output from the Program is covered only
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if its contents constitute a work based on the Program (independent of having been made by running the
Program). Whether that is true depends on what the Program does.

• 1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any me-
dium, provided that you conspicuously and appropriately publish on each copy an appropriate copyright
notice and disclaimer of warranty; keep intact all the notices that refer to this License and to the absence of
any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty
protection in exchange for a fee.

• 2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute such modifications or work under the terms of Section 1 above,
provided that you also meet all of these conditions:

1. You must cause the modified files to carry prominent notices stating that you changed the files and the
date of any change.

2. You must cause any work that you distribute or publish, that in whole or in part contains or is derived
from the Program or any part thereof, to be licensed as a whole at no charge to all third parties under
the terms of this License.

3. If the modified program normally reads commands interactively when run, you must cause it, when
started running for such interactive use in the most ordinary way, to print or display an announcement
including an appropriate copyright notice and a notice that there is no warranty (or else, saying that you
provide a warranty) and that users may redistribute the program under these conditions, and telling
the user how to view a copy of this License. (Exception: if the Program itself is interactive but does not
normally print such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not de-
rived from the Program, and can be reasonably considered independent and separate works in themselves,
then this License, and its terms, do not apply to those sections when you distribute them as separate works.
But when you distribute the same sections as part of a whole which is a work based on the Program, the
distribution of the whole must be on the terms of this License, whose permissions for other licensees extend
to the entire whole, and thus to each and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you;
rather, the intent is to exercise the right to control the distribution of derivative or collective works based on
the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work
based on the Program) on a volume of a storage or distribution medium does not bring the other work
under the scope of this License.

• 3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or
executable form under the terms of Sections 1 and 2 above provided that you also do one of the following:

1. Accompany it with the complete corresponding machine-readable source code, which must be distribu-
ted under the terms of Sections 1 and 2 above on a medium customarily used for software interchange;
or,

2. Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no
more than your cost of physically performing source distribution, a complete machine-readable copy of
the corresponding source code, to be distributed under the terms of Sections 1 and 2 above on a medium
customarily used for software interchange; or,

3. Accompany it with the information you received as to the offer to distribute corresponding source code.
(This alternative is allowed only for noncommercial distribution and only if you received the program
in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an
executable work, complete source code means all the source code for all modules it contains, plus any asso-
ciated interface definition files, plus the scripts used to control compilation and installation of the executable.
However, as a special exception, the source code distributed need not include anything that is normally dis-
tributed (in either source or binary form) with the major components (compiler, kernel, and so on) of the
operating system on which the executable runs, unless that component itself accompanies the executable.
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If distribution of executable or object code is made by offering access to copy from a designated place, then
offering equivalent access to copy the source code from the same place counts as distribution of the source
code, even though third parties are not compelled to copy the source along with the object code.

• 4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this
License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is void, and will au-
tomatically terminate your rights under this License. However, parties who have received copies, or rights,
from you under this License will not have their licenses terminated so long as such parties remain in full
compliance.

• 5. You are not required to accept this License, since you have not signed it. However, nothing else grants you
permission to modify or distribute the Program or its derivative works. These actions are prohibited by law
if you do not accept this License. Therefore, by modifying or distributing the Program (or any work based
on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for
copying, distributing or modifying the Program or works based on it.

• 6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically
receives a license from the original licensor to copy, distribute or modify the Program subject to these terms
and conditions. You may not impose any further restrictions on the recipients’ exercise of the rights granted
herein. You are not responsible for enforcing compliance by third parties to this License.

• 7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not
limited to patent issues), conditions are imposed on you (whether by court order, agreement or otherwise)
that contradict the conditions of this License, they do not excuse you from the conditions of this License.
If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other
pertinent obligations, then as a consequence you may not distribute the Program at all. For example, if a
patent license would not permit royalty-free redistribution of the Program by all those who receive copies
directly or indirectly through you, then the only way you could satisfy both it and this License would be to
refrain entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance
of the section is intended to apply and the section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people have
made generous contributions to the wide range of software distributed through that system in reliance on
consistent application of that system; it is up to the author/donor to decide if he or she is willing to distribute
software through any other system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this
License.

• 8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this License may add
an explicit geographical distribution limitation excluding those countries, so that distribution is permitted
only in or among countries not thus excluded. In such case, this License incorporates the limitation as if
written in the body of this License.

• 9. The Free Software Foundation may publish revised and/or new versions of the General Public License
from time to time. Such new versions will be similar in spirit to the present version, but may differ in detail
to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this Li-
cense which applies to it and "any later version", you have the option of following the terms and conditions
either of that version or of any later version published by the Free Software Foundation. If the Program
does not specify a version number of this License, you may choose any version ever published by the Free
Software Foundation.

• 10. If you wish to incorporate parts of the Program into other free programs whose distribution condi-
tions are different, write to the author to ask for permission. For software which is copyrighted by the Free
Software Foundation, write to the Free Software Foundation; we sometimes make exceptions for this. Our
decision will be guided by the two goals of preserving the free status of all derivatives of our free software
and of promoting the sharing and reuse of software generally.
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NO WARRANTY

• 11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE
PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STA-
TED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM
“AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTI-
CULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NE-
CESSARY SERVICING, REPAIR OR CORRECTION.

• 12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL
ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR REDISTRIBUTE
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GE-
NERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA
BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILU-
RE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR
OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS
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